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DURING AN OCTOBER ‘05 trip to Germany, I specif-
ically asked Hector Ruiz, AMD president and CEO,
whether there was any possibility of AMD putting
up a semiconductor plant in India. He gave me a
look that implied “No way!” To my question he
politely replied, “I don’t think this is possible for
now, given the infrastructure and technology trans-
fer constraints.”

But just last month he made a personal visit to
India and proudly announced an agreement to
license AMD’s proven process technology for SemI-
ndia’s planned wafer fabrication and assembly-test-
mark-pack (ATMP) operations. AMD and SemIndia
will now jointly develop and market semiconductor
solutions for India. Now that’s an about-turn from
his earlier stance.

Incidentally, immediately after Ruiz left, Intel’s
chairman Craig Barrett made a surprise visit and
announced a multi-year investment plan for India
totalling more than $1 billion, stating they plan to
grow their local operations, boost venture capital
investments, and work closely with the Govern-
ment, industry, and educators.

Then came Bill Gates on his fourth visit to India
and he upped the ante—making big-ticket
announcements of investing $1.7 billion in the
country over the next four years, and hiring 3,000
people in the same time-frame—taking Microsoft’s
Indian manpower count to 7,000.

Earlier, Cisco, the world’s leading networking
firm, had announced a $1.1 billion investment plan
in India, while Vodafone decided to spend $1.5 billion
for a 10 per cent stake in Bharti Tele-Ventures Ltd.

This impressive investment line-up clearly indi-
cates the confidence global players now have in
India, both as a major market for IT products and as
a location for high-tech manufacturing. We have
moved on from being the software sweatshop of 
the world.

India is no longer just another potential growth
market for technology companies. Rather, India has
scaled up to be one of the most important countries
to be focussed on and build a consumer base. We
will soon witness launch of the latest gadgets and
tech products simultaneous with their global
launch. R&D efforts of major IT companies will also
be tuned and customised to Indian consumer needs
for products they wish to sell in India. Not to forget,
it will also lead to a major spurt in recruitment in

the Indian IT sector. No this time not for any back
office operations but to work on developing newer
and innovative technologies that will spawn better
products for the global market.   

India represents a major market for desktop and
laptop computers as well as Internet-enabled
devices. Industry observers expect the market to see
strong growth in the near future, given the impetus
provided by the Government towards increasing PC
and Internet penetration. Also, India’s Internet user
base has registered a massive 54 per cent growth,
with 38.5 million users as of 2005-06 from just 
25 million in 2004-05.

It is these growth indicators that have compelled
the corporate honchos of the world’s leading PC and
processor manufacturing companies to come per-
sonally to India and shell out billions of dollars.

Who’s next?

deepak_ajwani@thinkdigit.com

The Dollar Downpour

Editorial

“We will soon witness launch of the
latest gadgets and tech products

simultaneous with their global launch”

Deepak Ajwani Associate Editor
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FPS Creator 1

Create your game instantly with this
intuitive 3D editor. Drag and drop walls,
lights, doors, enemies, ammo, weapons
and more with pixel-perfect precision,
and watch as they intelligently link
together. Then with one click of the
mouse, play your game!

DEVELOPER TOOLS
n Exchanger XML Editor
n Microsoft .NET Framework runtime

files 2.0
n Oracle 10g Express Edition
n Borland C++ builder 2006
n Borland Delphi 2006 
n Power Render

GAMES
Need For Speed Most Wanted
PC Demo

Be Wanted. Wake up to the smell of burnt
asphalt as the thrill of illicit street racing
permeates the air. From the makers of
the hit Need for Speed Underground
series, Need for Speed: Most Wanted
challenges players to become the most
notorious and elusive street racer.

Quake 4 Demo
This demo offers enough
multiplayer action to keep
you competing online for
days, with two versions of
the popular map “The
Fragging Yard.” The single
player also starts from
where the full version takes off.

Kubuntu 5.10
Kubuntu is a user-
friendly operating
system based on KDE,
the K Desktop
Environment.

n F.E.A.R. Update
Patch

n Quake 4 Update Patch 1.0.4
n Hammer And Sickle
n Peter Jackson's King Kong
n The Chronicles of Narnia: The Lion,

The Witch and The Wardrobe

LINUX
n Kubuntu 5.10
n amaroK 1.3.7
n mCube Music Manager 20051205
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MULTIMEDIA
n DigiBook v.11
n GX::Transcoder 2.24.2936 Beta 2a
n AVOne Video Converter 2.52
n FMV Pro 5.99
n VideoCharge 3.3.9
n WinDVR 3

INTERNET

n Gamer’s Own Instant Messenger 0.1.7
n Server2Go 0.9.8
n TryFast Messenger 4.6.1672
n Capturix VideoSpy 2.12.1760
n CoffeeCup HTML Editor for

Windows 2006
n ConceptDraw WebWave 5.3.0
n Post2Blog 1.10 beta 7
n ZoneAlarm Internet Security Suite

SYSTEM
System Mechanic 6.0p
The only system optimisation and
security software you'll ever need—six
award-winning products contained in
one complete solution. Fix stubborn
errors, accelerate performance,
maintain peak PC health, protect
against viruses, hackers, spyware,
adware, and more using the System
Mechanic 6 Professional robust arsenal
of powerful tools.

VMware Workstation 5.5
VMware Workstation is a powerful
desktop virtualisation software for
software developers/testers and
enterprise IT professionals. It runs
multiple operating systems
simultaneously on a single PC. 

n Ashampoo WinOptimizer Platinum
Suite3 3.00

n VisualCron 2.7.6
n Unofficial Windows 98 SE Service Pack

2.1a
n Acronis Disk Director Suite 10.0
n Backup2005 Pro 4.4.6.155
n Diskeeper Professional Edition

10.0.593t
n PCMark05 Basic 1.1.0

FAST TRACK IN PDF
By popular demand, archives of the
past 12 months are back!

n Fast Track To Digital Photography
n Fast Track To Anti-virus
n Fast Track To Wi-Fi
n Fast Track To Upgrade Your PC
n Fast Track To MS Office
n Fast Track To The Internet
n Fast Track To Your Web Presence
n Fast Track To Digital Entertainment
n Fast Track To Essential Windows Tools

Ultra Hal Text-to-Speech
Reader 1.0
The Ultra Hal Text-to-Speech Reader
application reads your documents out
loud in one of its many high-quality
voices. This can be a great tool for
proofreading, because hearing your
text spoken out helps you spot the
mistakes you’ve made.

NetSupport DNA 2.5
NetSupport DNA (Dynamic Network
Administration) facilitates central
management of your enterprise PCs in
a secure, co-ordinated and efficient
manner.

PRODUCTIVITY TOOLS 
n Windows Server System Reference

Architecture (WSSRA) 2.0
n Audiomatic 1.01
n Florencesoft DiffEngineX 1.24
n MySQL Migration Toolkit 2.3
n NetSupport Manager Remote

Control 9.10
n SameShow PPT to SWF

Converter 1.6.0

MOBILE APPS
Sony Ericsson Themes
Creator 1.92
The “Themes Creator” is now official,
and supports all Sony Ericsson phones
that support themes.

Oxygen Phone Manager II
Oxygen Phone Manager II lets your PC
and Nokia mobile phone communicate
with each other using infrared,
Bluetooth, DLR-3 cable, DAU-9P
compatible cable in FBUS mode, and
DKU-5 (Pop-Port) cable.

n Nokia PC Suite 6.7 Release 21
n Siemens Mobile Phone Manager

3.04.40.48.4
n iPodSync 2.26
n Oxygen Phone Manager II 2.8 build 3.3
n VisSie 2.5.6a

SMALL GAMES
Starport Galactic Empires 
The highly acclaimed, independently
developed MMORPG, Starport, is now
available and still 100% free to play. Be
the captain of a space-ship in this fully
graphical, real-time action game, set in a
multi-player world.

Christmas Quest 1.0
Christmas Quest is part trivia contest
and part treasure hunt. Navigate the
planet in search of your holiday
assignments.

VIDEOS
F.E.A.R. Machinima Episodes
The newest series from Rooster Teeth
Productions (the creators of the famous
Red Vs. Blue series), P.A.N.I.C.S. (People
Acting Normal In Crazy-ass Situations)
has arrived!!!

PoP: The Two Thrones
POPT2T takes place in the homeland of
the Prince—Babylon. For the first time.

Path Of Neo
The Matrix: Path of Neo is the follow-up
to 2003’s hit action video game based
on The Matrix film trilogy.
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Solar 1.0
Solar is an advanced, secure software
protection and licensing system that
allows you to protect your program

from unauthorised users, while
providing you with a reliable yet
easy-to-implement licensing system.

Actual Drawing
Actual Drawing is a visual publishing tool
that helps create Web pages without you

having to know HTML, allowing you to
drag and drop page content. The
program has its own image-manipulation
tools, so you don’t need to use a third-
party image editor.

Synopsis—Visual
Programming Tool 1.1.10
Synopsis is a visual programming tool
that dramatically accelerates software
development. By dragging and dropping
icons and connecting them with graphical
links, it is possible to assemble complex
programs literally in seconds.

Galacticards 1.002
In Galacticards,
five players
start out with a
home world,
some defensive
ground units,
and a hand of
five cards with which they begin their
struggle to become the largest species
in space.

DEVELOPER TOOLS
n MSN Messenger Activity SDK 1.0
n PHP Designer 2005
n Stani’s Python Editor 0.8.0b
n Treeview—JavaScript Tree Menu 4.3
n Visual C# 2005 Express
n Visual Web Developer 2005 Express
n FlashDigger Plus
n OZEXE 3.10
n SlavaSoft QuickCrypt Library 2.5
n Tristana Writer

LINUX
n Banshee 0.10
n Dirac 0.5.4
n GStreamer 0.10.0
n MadJACK 0.1
n Mkdvd 2.43
n mkvtoolnix 1.6.5
n mplayerplug-in 3.17
n OST-Box 0.1.0
n Shoutcast 1.9.5
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Contents Interactive

REAKTOR 5 5.00

REAKTOR 5 fuses all audio applications
into a single, extremely versatile and
powerful tool. Musicians, producers and
sound designers are all catered to by
the very broad range of instruments
and sounds already included.

MULTIMEDIA
n ALLPlayer 2.2.7
n Circle Virtual CD v1.02
n Cliprex DVD Player Professional
n DIMIN Image Viewer n5 5.2.1.111
n ForceVision 3.3 Final
n Fusion Media Player 1.7.2
n nDVD 1.0.2146.18505
n Screenshot Captor 2.06.02
n StickyView 1.1.4
n Visual CD 2.0
n Vrecord 0.57
n AKRAM Audio Converter 2.17
n BatchPhoto 1.0
n djDecks 0.70b
n eJukebox 3.991
n Firegraphic XP 8.0.810
n Movie DVD Maker 1.3.8
n MP3Producer 2.47
n Music Stop 1.0
n PicaJet FX 2.5 (440)
n REAKTOR 5 5.00
n River Past Cam Do 2.81
n ThumbNailer 8.0.8.4

INTERNET
n Deepnet Explorer 1.5.2 beta 2
n EbookMaker 1.21
n Free Browser 1.5.38
n Fresh Download 7.42
n Mozilla Firefox 1.5 Final
n Pando 0.8.1.0 beta
n Portable Firefox 1.5 RC3
n SPAMfighter Standard 4.0.6
n Internet Download Accelerator 4.4.1.935
n Internet Download Manager 5.0 beta 3
n QuadSkucker/Web 3.0
n The Bat! Voyager 3.63.07 BETA
n WebCamSplitter 1.2.6
n Willing Webcam 3.2

SYSTEM
n AutoHotkey 1.0.40.10
n LookInMyPC 1.0
n Monitor Calibration Wizard 1.0
n Partition Logic 0.6
n Sqirlz Morph 1.2d
n TreeSize Free V1.77
n VICE 1.18

ESSENTIALS
n Adobe Acrobat Reader 7.5
n Avast Home Edition 4.6
n IrfanView 3.97
n Kazaa Lite Mega Codec Pack 1.40
n Kerio Personal Firewall 4.2.2
n Norton AntiVirus Definitions Update 
n Spybot Search & Destroy 1.4
n WinRAR 3.51

Sydock XForms 2.5.4.6

Sydock Document Processor FREE lite
version gives organisations and working
groups the ability to collect and
distribute information using the
flexible and varied possibilities of XML-
based forms.

iMediaCONVERT 3.3.16
iMediaCONVERT
converts PowerPoint
presentations
(including sounds) to
Flash, and instantly
delivers Internet,
Intranet, CD-ROM or
LMS-compatible
results, suitable for online distribution
or interactive e-learning platforms.

MOBILE APPS
n iDirectionz 1
n Symantec Mobile Threats Removal

Tool 1.0.3
n iPodRip Win 2.8
n Monopoly for Palm OS 1.2.3
n Party-Pod Pro 6

Canto Pod 2

This program quickly puts song lyrics
on your iPod at no cost. After you
connect your iPod and open the
application, be sure to check the
Settings panel to make sure the proper
drive is selected. While you can enter a
search term to find a particular track,
it’s easier to simply have the program
display all tunes on your iPod. From
there, you can simply check boxes for
songs you’d like lyrics for.

Pocket Tunes
3.1.1
Regardless of whether
your mobile device
shipped with a dedicated
music jukebox, Pocket
Tunes still makes a
strong case for itself as
an alternative solution.
After you’ve imported
MP3, WMA, or OGG files to your Palm’s
expansion card, the program
will immediately recognise them once
you start it up.

Harry Potter and the Goblet
of Fire Demo: Nanosaur
Extreme 2.03
In Harry Potter and the Goblet of Fire,
Harry is mysteriously selected as the
fourth competitor
in the dangerous
Triwizard
Tournament. Each
contestant in this
international
competition must
confront a fire-
breathing dragon,
rescue friends from the icy depths
of the Black Lake, and navigate the
twisting mysteries of a vast,
dangerous maze.

GAMES
n Archer Battle 1.0
n Backgammon Lite 5.1
n Bastille Solitaire 1.0
n Bingo Liner 3.0
n Free Cribbage Card Game 6.40
n Free Hearts Card Game 6.40
n Free Spades Card Game 6.40
n jose 1.4.0
n Poker Mania 3.2.1
n Silke Halma 1.0.4
n Black Jack for Windows 1.0.2.1
n Frenesia 1.1
n Lotto007 XP 2005 6.4

VIDEOS
Age Of Conan Trailer

A trailer of the Age Of Conan game that
will take you to the mythical worlds of
fantasy.

NFS Most Wanted Video

NFS Most Wanted is a game where you
run from the cops, often destroying
everything in sight with your souped up
sports car. Here’s a video that shows
you what you can expect to see when
you play the demo that’s on our DVD.

CD

DIGIT JANUARY 2006For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject.
If the subject is not mentioned, your mail might not reach the right person.
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By Demand
You get to choose what goes in Digit
Interactive. This month, you chose:

Need For Speed: Most Wanted Demo
Quake 4 Demo

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

How concerned are you
about spyware/adware?

Totally Paranoid

Just obsessed enough

Only if it starts to bug me

Live and let live, I say

WHAT ware?

Log on to www.thinkdigit.com
and vote

January 2006

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

What would you like to read about more in
Digit? 

infographic Vijay Padaya

Careers In
Technology

31%

Linux
19%

Total votes 8,335

taste technology at www.thinkdigit.com

Apple Mac
11.8%

Software
Reviews
11.8%

Consumer
Electronics

18.8%
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Rahul Bose
Actor and Director

Rahul Bose gave up an
illustrious advertising

career only to emerge as a
prolific actor, director and
script writer. After a

successful debut as
Agastya Sen in

English August, he
went on to write
and direct the
critically
acclaimed film

Everybody Says I’m
Fine, and endeared

himself to audiences
through his role in Mr and
Mrs Iyer. Rahul discusses his
tech quotient with Digit:

What role does technology
play in your life? 
Technology has helped me
enhance my creativity. Whether
it is acting, theatre, or writing
scripts for that matter,
technology gives you a distinct
advantage. For instance, I use
Final Draft—software to write
film scripts. 

What gadgets do you own? 
I own a Motorola V3 phone, an
iPod Nano, and an Apple Mac at
home—nah, that’s not because I
am partial to Apple or anything,
but I guess I’ve really gotten
used to the Mac. 

What do you mostly do online?
I surf the Net, e-mail and blog.
The one site I frequently blog
on is Intentblog.com. It’s a
platform for people to develop
a dialogue about new
paradigms in creativity,
communication, and fulfillment. 

Any instance where
technology really helped?
When I was in the tsunami-hit
Andamans, it was the Internet
that helped me stay connected
with the rest of the world.

Legal P2P In A Set-Top Box
MuViBOXX!, a new entertainment company, introduced the
world’s first legal P2P media centre in a set-top box. The box
will feature biometric DRM, and allow consumers to download
movie and music content from a proprietary global file-
sharing network. The box has a 500 GB hard disk.

Successor To Centrino Due this month
Intel said it would officially release its next mobile platform,
Napa, in January. Napa is equipped with the powerful Yonah
dual-core processor. Intel claims Napa will boost average
performance 68 per cent beyond the Sonoma platform,
while extending battery life beyond the 5-hour mark.

Will the $100 laptop
change the world?
Will it at least

positively impact some
students in developing
countries? Opinion is
divided. Even as Taiwan’s
Quanta, the world’s largest
manufacturer of notebooks,
signed on to the project,
Intel’s chairman dismissed
it as a mere “gadget”.

The pedigree of the $100
laptop is impeccable. It’s
been designed by industry
specialists at MIT in co-
operation with the One
Laptop Per Child (OLPC)
association, and was first
conceived by MIT Media
Labs founder Nicholas
Negroponte. The
project itself is
very
ambitious,
aiming, as it
does, to empower
every child with a
laptop. Even the UN has
expressed support for the
idea that cheap laptops will
be an effective way to
spread computers across
the world.

The response from the
media, governments and
the industry has been
fantastic. Orders for
millions of units have been
received from governments
in Brazil, Egypt, Thailand
and Nigeria. Negroponte
unveiled the design of the
device in November last
year, and plans are
underway for the first units
to be shipped early in
January ‘06.

Given this background,
what are we to make of
Craig Barrett's remarks?
Intel’s chairman openly
criticised the concept. At a
press conference in Sri
Lanka, he insisted there
will not be a market for
the devices.

Barrett argued that a
computer’s features are
more important than price.
He claims that the laptop is
an ineffectual gadget that

will
suffer

from low
demand and

limited success despite
huge international interest
in the project. Citing
hardware limitations,
Barrett said that the $100
laptop will not adequately
meet the needs of its target
consumers and that Intel’s
contributions to IT in
developing countries are far
more tangible and relevant:

“Mr Negroponte has
called it a $100 laptop—I
think a more realistic title
should be ‘the $100 gadget.’
The problem is that gadgets
have not been successful. It
turns out what people are
looking for is something

that has the full
functionality of a PC,
reprogrammable to run all
the applications of a grown
up PC... not dependent on
servers in the sky to deliver
content and capability to
them, not dependent on
hand cranks for power.”

So what does the
“gadget” feature? The CPU
is 500 MHz; the
colour/monochrome dual-
mode screen is 7.5 inches
diagonally; there’s 128 MB
of RAM, 512 MB of Flash
memory, and there’s
802.11b wireless support.
Two speakers and four USB
ports are provided. There’s
no hard disk, optical or
floppy drives. On the
software front, the laptop

runs Red Hat Linux, and
incorporates a Web browser,
a word processor, an e-mail
program, and a
programming system that
includes the Squeak
programming language.

The most obvious
explanation for Barrett’s
remarks is the fact that in
August, Intel opened four
platform design centres in
Brazil, China, Egypt and
India, to design computers
for local markets. So are we
to entirely dismiss Barrett?
Perhaps, perhaps not.
History has shown that
attempts to bring
computers to the poor are
likely to fail. There have
been several attempts,
without success, to bring
low-cost PCs to Brazil. Then
there’s the Simputer,

Enter
WILL THE $100 LAPTOP TAKE OFF?

Mere Gadget Or Affordable
Laptop?



designed in India, of which
we’ve been hearing about
for a long time—but of
which nothing seems to
materialise. AMD has not
sold many of its cheap
Internet devices—the
Personal Internet
Communicators—for the
developing world.

But still, history has also
taught us that some bad
ideas meet with wild
success, and that some
great ideas fall flat. 

The $100 laptop could
turn out to be a good idea
that works. After all, it’s
targeted at children and
students—and looking at
the features on offer, who
needs more? Even if the
project can place a laptop
in the hands of every
twentieth child, it would
have succeeded.

AWASH IN CONTROVERSY

Is Wikipedia
Credible?

It was only a matter of
time before an

encyclopaedia based on
the wiki concept became
the subject of a
controversy. It was a
relatively minor incident
that sparked it off, but the
questions are now really
being asked. Wikipedia, for
those who came in late, is
an online encyclopaedia
that anyone—including
you—can edit. And it
currently has more than a
million entries.

The incident we’re
talking about was an

anonymously-written
biography entry that linked
former USA Today editor
John Seigenthaler Sr with
the assassinations of
President John F Kennedy
and Senator Robert F
Kennedy. The writer, Brian
Chase, later issued an
apology for his prank.
Seigenthaler, in a USA Today
editorial, criticised
Wikipedia and called the
fake biography “Internet
character assassination.”

In an interview with
BusinessWeek Online,
Jimmy Wales, Wikipedia
founder and president of
the Wikimedia Foundation,
which runs Wikipedia, said
they were revamping the
process of entry creation so
credibility could be
maintained. Asked how
users should view
Wikipedia, he said, “It
should be thought of as
work in progress. It’s our

intention to be Britannica
or better quality, and our
policies and everything are
designed with that goal in
mind. We don’t reach that

quality yet.” Most
tellingly, when asked
if he thought
students and
researchers should
cite Wikipedia,

Wales issued a frank
“No.” But he went on

to say he didn’t think
people should cite

Britannica either.
When it comes to

Wikipedia vs. Britannica,
opinion on the Internet
varies wildly. Some,
including CNN, say
Wikipedia is as
accurate on science as
the venerated
Britannica. Others
have cast doubt on

Wikipedia’s credibility
even before this recent

Sarosh Aziz Chougle, Ratnagiri
Mona Dhumal, Pune

Microsoft Xbox
360
The current
darling of gamers,
Xbox 360 is the
most powerful

game console in the market.
Microsoft has re-built the 360
to provide an experience that
leaves the competition gaping
like a goldfish.

Sony Playstation 2
With the
Playstation 3
still a few
months away,
Top Dog Sony has been
ingloriously knocked over by
the Xbox 360 for now. Sony
devotees must either shift
loyalties to Microsoft or
gnash their teeth in jealousy.

“Coz it looks like one!”“Since it's so tiny?”  
Preksha Sharma, Jaipur

“It couldn't be called a cat”

Akanksha Srivastavi, Delhi
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Security Watch

Opera Upgrade
Recommended

The Problem
Users of Opera 8.1 may be at
risk of attack. Security firm
Secunia has uncovered a
security weakness in that
version. Researchers at Secunia
said they found that a design
error in the way Opera
processes mouse clicks in new
browser windows. This,
combined with the
predictability of the position of
the ‘File Download’ dialog box,
could be exploited to trick
users into clicking the ‘Open’
button of a file download
prompt, even if they intended
to click ‘Save’ or ‘Cancel’. 

The exploit has only been
verified to work in Opera
version 8.01, though earlier
versions may be vulnerable too.

The Damages
Naturally, you wouldn’t want to
click ‘Open’ for a file you intend
to save and then virus-check.
And if you’re prompted to save
or open a file from an untrusted
source, you’re more likely to
click ‘Cancel’!
Hackers could use the weakness
to trick users into downloading
and running unwanted
programs. The flaw cannot be
taken lightly—running a mali-
cious program could damage
your computer!

The Solution
The flaw was eliminated in
Opera version 8.02, but why
not upgrade to the latest
version—8.51? The update is
available at www.opera.com/
download.

“It's a nice name for the device” “It moves around like one” 
Priya Talreja, Mumbai

“Why is the mouse called a mouse?” One Silly Question

Illustrations Harsho Mohan Chattoraj
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Et Cetera

DDeerraarraaddiioo..ccoomm  
A hot spot for music buffs,
DeraRadio.com is an on-demand
Internet radio station. The site’s
database includes Western, Arabic and
Hindi music, and the latest numbers. All
you need is Real Player. There are also
online dedications, request shows and
the popular Derachat. 

NNiivvaalliinnkk..ccoomm  
A Web-based hotel reservations firm,
Nivalink.com has put together more
than 1,000 holiday options within India
with details on each such as location,
accommodation, transport, latest tariff,
facilities, meals and so on, with actual
photos. The site has profiled over 100
weekend retreats, beach getaways, hill
stations, health resorts, and star
cruises among others. It’s definitely
worth checking out!

NNaassssccoomm..oorrgg
The National Association of Software
and Service Companies (NASSCOM) is
the premier trade body and the
chamber of commerce of the IT
software and services industry. Read
success stories of key software and
services companies here, and buy
Nasscom publications, research reports,
and register for industry events. 

www.nivalink.com 

www.nasscom.org

www.deraradio.com 

incident. So what is the
real story?

Science journal Nature
chose 50 science articles
from both encyclopaedias,
and gave peer reviewers a
blind test to find mistakes.
Britannica turned up 123
errors, and Wikipedia 162.
To quantify that, the
quality of information
from Wikipedia was 25 per
cent worse.

Whatever such figures
may say, the questions
remain. On the one hand,
anyone with knowledge of
a certain topic can
contribute to Wikipedia,
and who would want to
mess with an entry if he
didn’t know too much
about the topic? On the
other hand, what about
opinionated people, who
put up entries posing as
facts but which merely
reflect an opinion? Then
there’s the question of
policing: with hundreds of
entries coming in every
day, who’s to check them
all? What about quality of
writing, and consistency?
How can Wikipedia
possibly be cited, when one
knows that the material
could be merely something

someone at the other end
of the world casually
wrote? And yet, one still
needs to ask, what can
possibly be wrong about a
project that aims to bring
together, onto one
platform, the collective
knowledge that we as a
species possess?

We would like to hear
from you on this issue—do
write in!

WILL THE IDEA LAST?

Sprint
Brings
Movies To
The Mobile

Sprint’s movie content
provider MSpot said on

12 December that the
global voice, data and
Internet service provider
had soft-launched its
MSpot Movies service in
November 2005, featuring
10 full-length films
customers can stream to
their Vision phones
serially in five-minute
increments.

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

THE UAE

Despite being the most progressive of
the Arab nations (think Dubai!), the UAE
blocks nearly all pornography, gambling,
and illegal drugs sites. The state also
blocks access to all Israeli sites and even
English-language dating sites.

UNITED KINGDOM

The UK’s largest robotics laboratory is set to
open—in a bid to rival institutions in the US and
Japan. The new facility in Bristol hopes to
develop intelligent robots designed to work with
people and be able to carry out tasks
independently.

SOUTH KOREA

Some estimates peg the number of online
gamers in Korea at 70 to 80 per cent of the
population! The South Korean government
therefore keeps a close watch on online
gaming, announcing in December ’05 a “set
of measures” to “crack down on increasing
hacking attacks on online game items.”

JAPAN
Japanese universities have
decided to include student ID
cards on students’ phones. From
April,new students at Kanagawa
Institute of Technology will
carry an ID on their phone that
lets them register for classes,
open locked doors and such.

UNITED STATES

Christmas wish-lists of kids today
aren’t neatly-typed letters to Santa
anymore. For example, 11-year-old
Katie Johnsen in DC got tech-savvy
and turned her list into a Power-
Point presentation with a red and
green background, a picture of
Santa, and links to the sites where
her items could be bought!

MEXICO

“North American country”
seems a misnomer for
Mexico. According to a
recent survey, only 16.5
per cent of the population
has a PC, and only 9 per
cent has any Internet
connection at all. Compare
this with the 50 per cent
broadband penetration in
the United States, just
across the border!
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Last Month’s Winner!
Mangesh Patki
Aundh, Pune

“Double-Click!”

E-mail your caption with the
subject ‘Beat That’, and your
postal address, to
beatthat@thinkdigit.com
and win Unix for
Programmers and Users 
by Graham Glass and 
King Ables
Published by Pearson
Education, Delhi

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 15th of this month.

Digit Caption

‘Once More!!’
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The movies on offer
aren’t the latest, though:
the most recent of the 10
currently available
available is Short Circuit, a
1986 flick. Why? MSpot CEO
Daren Tsui said film rights
are notoriously difficult to
procure, and since Sprint’s
movie service is a first-of-its-
kind, it has to be content
with old movies in order to
get it off the ground.

MSpot, however, now
has deals negotiated for the
rights to 380 films, and as
the service gains attention
and subscribers, Tsui

expects the movie studios
will have more interest in
putting newer content on
the network.

That, of course, depends
on how well the service
does. A little after news of
Sprint’s movie service
appeared, ZDNet released a
list of seven reasons why
movies on the cell phone
won’t work: first, that many
films have wide vistas, fast
action, split screens and
multiple colours, which do
not work well on a small
viewer. Second, the obvious
point of how long one can

be expected to
squint at a little
screen. Then
there’s the
issue of
whether the

shifting between
movies and calls

will be seamless,
and of battery life.

Imagine watching
part of a movie,
then recharging
your handset and
picking up where
you left off! ZDNet
also talks about
the noise factor—
imagine a scream

from a horror

movie emanating from your
cell phone’s speakers in a
public place!

“This is a controversial
service,” Tsui said. “Some
people don’t believe in it
because of the small screen
size, but look at the market.
Services like MobiTV, Sprint
TV and Verizon Wireless’
Vcast have been doing
great. There is a consumer
appetite for video on the
mobile phone. You can’t
dispute that.”

HE’S GOT A JOB

Asimo As
Receptionist

Honda recently
announced that its

Asimo, the world’s first
walking humanoid robot, is
set to make its office debut
in 2006 as a receptionist.
The latest version Asimo

will be starting its new job
in April at a Honda office
in Wako, north of Tokyo.
The prototype can guide
guests to a room, push a
cart with a load of up to 10
kilograms, and serve coffee
on a tray!

“The level of Asimo’s
capability was just good
enough to entertain people
on the stage in the past,
but the new Asimo can
work at places closer to us,”
says Satoshi Shigemi, the
Honda official in charge of
the robot’s development.
“Honda is aiming to create
a humanoid robot that can
help people and live
together with people.”

During its unveiling,
the new Asimo, which
stands more than four feet
tall and weighs 54 kg, ran
at top speed on a stage, and
then carried four cups on a
tray to a coffee table.
Honda plans to produce
more models and lease
them to organisations for
an estimated rental fee of

¥20 million 
(Rs 75 lakh)
per year.

Asimo,
of course,
isn’t the
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only robot out there that
can do something as
advanced as being a
receptionist. There are
many practical robots
already on duty in Japan.
An example is Ligurio, a
prototype security robot
that can move at 7 kmph
on its wheels, and can
identify an intruder 50
metres away even at night.
It can grab explosives or
containers of lethal

chemicals and remove
them to safe places.

What makes Asimo’s
“job” as a receptionist a
landmark development of
sorts is that this indicates
we’re getting closer to
seeing robots as personal
companions. As we
mentioned in I, Robot—Your
Friend, Digit September
2005, it’s been predicted
that robots will walk the
streets by 2010. We

mentioned in the article
that it sounded “rather
impossible.” But if, in 2006,
we are already seeing
robots as receptionists,
who’s now to say that’s a
far-fetched prediction?

25 MILLION TO 38.5

Internet
Penetration
Increases

You’d have expected
Internet penetration in

India to have increased,
but we have the figures. It
remains relatively very low,
but has soared 54 per cent
over the course of 2005 to
38.5 million, and will jump
to 100 million in two years,
according to a IMAI
(Internet and Mobile
Association of India) study.
In comparison, China
already has 100 million
Internet users, according
to government statistics.

With increased Internet
penetration comes more e-
commerce; as of now, the
e-commerce market is
estimated at Rs 1,180 crore.
It’s estimated to grow to Rs
2,300 crores in 2006-07.

Dayanidhi Maran,
Union Minister for IT and
telecommunications said
about these growth
figures, “We have
ambitious goals regarding
Internet access and are
providing all support to
attain them. The
Government is making
concerted efforts with a
clear emphasis on the
importance of affordable
broadband… Our aim is to
achieve critical mass across
the country with a special

impetus in rural and
remote areas.”

According to Preeti
Desai, president of the
IMAI,“E-mail and chat have
become a ‘ubiquitous’ part
of online Indians’ daily
routine, and online
banking, bill payment,
stock trading, job searches,
and matrimonial searches
have seen ‘tremendous’
rise in usage.”

Unfortunately, the fact
remains that it’s mostly
urban India that’s online.
In fact, urban India taken
as a separate entity has one
of the highest Internet
penetration rates in the
world, while the overall
rate for India stands at just
about two per cent. Urban
India is hankering for
broadband, while rural
India is still to be educated
about the possibilities the
Internet opens up.

How long this stark,
uncomfortable contrast
will last is anybody’s guess.

USE A THIEF TO CATCH
A THIEF

“Honeypot”
Could Help
Counter
Viruses

The problem of computer
viruses won’t go away

anytime soon. But a new
mathematical study by
Eran Shir at Israel’s Tel
Aviv University shows
that you can tackle the
virus problem using a
cure that itself spreads in a
viral fashion, and, as a
result “immunises” the
entire Internet.

GENDER 

BENDERS

Sameer’s reservations vanished the moment he sat down at
the computer. He right clicked the screen, headed to
‘Properties’ and scanned in the ‘Display Properties’ box that
popped up. As the search seemed futile, Sameer quickly
exited. Next, he right clicked the Taskbar at the bottom of the
monitor and clicked Toolbars > New Toolbar > My Computer.
Howeverer, the Taskbar had been locked and it took him a few
more seconds to unlock it and place it on the desktop.

Sameer Koli vs Ashwini Kadam   

Make ‘My Computer’ items appear
as a bar on the Desktop

Although she claimed to be not very familiar with computers,
Ashwini was game enough to take up the task. Just like Sameer,
she began by right-clicking the screen. However, she spent
more time scanning each item in the menu. After several
unsuccessful attempts, Ashwini moved to the Taskbar. She
right-clicked it, opened the menu and selected the icons to
create the bar. Ashwini could not unlock it and managed to do
so only after it was indicated to her. Still, not bad at all. 

While Virtualisation—partitioning your computer
into two or more 'virtual machines' to run

multiple software simultaneously—is not really a
new concept, Intel has brought it back in the news
by announcing its support for virtualisation at the
chip level. Virtualised machines can handle the load
of many under-utilised machines, saving the cost of
buying a whole new set of hardware.

Thus far, virtualisation was done only through
software such as VMware, but now with hardware
support for Virtual Machine Monitors, Intel will take
the performance of such software to new heights.
Virtualisation has been used in servers for a while
now and Intel hopes to bring it to desktop PCs as
well, with two new virtualisation-enabled Pentium 4
processors ready for shipping.

Virtualisation

1 min 
36 sec

3 min
5 sec
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Shir’s paper only
discusses his mathematical
model; there has been no
effective implementation
as yet. Shir, however, plans
to release a simple
example program soon.

“Our focus is to
immunise the whole
network, not to clean
individual computers or
fix what is already
broken,” Shir said on the
Web edition of Nature. In a
paper titled “Distributive
immunisation of networks
against viruses using the
‘honey-pot’ architecture,”
Shir and colleagues have
made a proposal “to
propagate the immunisa-
tion agent as an epidemic.”

The current problem is
that if a cure is sent over
the same network as that
on which the virus is
spreading, there is bound
to be a lag. The virus will
affect nodes (computers)
before the cure gets to
them. Shir and colleagues
therefore propose the
development of dedicated
“honeypot”—or attractor—
computers, distributed all
over the Net. The
honeypots would attract a
virus (to which the
honeypot would appear as
a regular computer),
analyse it automatically,
and distribute a
countermeasure.

The honeypots would
be linked to each other via
a dedicated, secure
network. This way, once
one honeypot has attracted
and analysed a virus, all
the others would
immediately know about
the infection—the
existence of the “honeypot
network” would enable the
countermeasure system to
be faster than the virus.
That’s where the real trick
lies. Each honeypot would
act as a hub sending out
healing countermeasure
code. This countermeasure
would spread across all of
the network—in theory,
possibly even all of the
Internet: simulations have
shown that the larger the
network is, the more
efficient this scheme
would be.

WHAT’S THAT SONG?

Google
Eases Music
Search

Google is tailoring its
search engine to better

address music search. A
search for an artist will now
bring up song titles, album
art, links to lyrics and
reviews, and advertisements
for places where the music
can be purchased.
Items that can be
purchased will
have links to
merchants for
online
ordering or
downloading.
The online
sources include
Apple,
RealNetworks
and eMusic, and
retailers selling
CDs including
Amazon, Wal-
Mart and others.
For the CD
retailers, Google
receives data
feeds of the
inventory and
only returns a link
to a store if the item is
available.

Search results will
include links to
supplemental Google Web
pages with more
information about the
music, including names of
tracks on a CD and other
CDs a band or artist has
released. Google also will
provide snippets of reviews
from sites on the Web, as
well as links to those sites.

The company has, of
course, constantly been
improving its search
service to match user
needs. Marissa Mayer,
the company’s vice
president for search
products and user
experience, admitted “one
of the things Google wasn't
good at” and that consu-
mers wanted was music.

There’s more to the
move than just better
search results: Google’s

current focus on music
comes at a time when
more companies are
selling and distributing
music online. Mike
McGuire, research director
for Gartner Inc., said
Google would be a natural
place for consumers
to look when they’re
trying to think of songs or
shop for music. “It gets
people to move from CDs
to online.”

Google’s improvement
of its music search
capabilities is part of the

always-on war
with its rivals.

Yahoo! launched its Yahoo!
Music service earlier this
year, and tied it with its
blogs and other
communication tools. And
with the proliferation of
online music content,
more companies are
enhancing their search
capabilities: Apple’s
iTunes, for example, allows
users to search its database
by artist or title, or within
various genres. Online
libraries such as Rhapsody
and Napster also offer
searches of their databases.
And services such as 411-
Song sell song
identification: you can
hold a cell phone up to a
speaker playing a tune,
and you get the name of
the song you played! 

Compiled by Jyotsna Rege, Nimish
Chandiramani, Ram Mohan Rao

and Renuka Rane 
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What is ZigBee?
ZigBee is a set of standards for
low-power, low data-rate
networks that operate over
small distances. ZigBee
networks work even in
congested radio environments.
Up to 255 devices can be
connected in a network, a
maximum of 30 m away from
each other.

How does ZigBee work?
ZigBee is a wireless network of
devices that communicate with
each other. Modest amounts of
data are shot over small
distances. ZigBee devices can
be arranged in a Star network,
where devices report to a
ZigBee Controller; a Mesh
network, where all devices are
at the same level and ‘co-
operate’ with each other; or a
Clustered Tree network, which
combines the best of both.

Why ZigBee?
ZigBee is targeted towards
Wireless Personal Area
Networks (WPANs), so a ZigBee
network is cheaper and simpler
to implement than a Bluetooth
or Wi-Fi network. A typical
ZigBee node will require two to
10 per cent of the software a
Bluetooth node would require.
Extending a ZigBee network is
easy—you don’t need to re-wire
any of the devices to add
another ZigBee node.

Where would I see a ZigBee
network?
ZigBee can be used in homes
and offices to remote control
every device possible. In
factories, they can be used to
automate manufacturing tasks
and asset management besides
monitoring heat and energy
usage to optimise energy
consumption.

Who thought it up?
The ZigBee Alliance, a
consortium of companies,
published the ZigBee standard.
They monitor and control
products that seek to employ
the standard.

When was ZigBee started?
Although in development since
1999,the ZigBee standard was
ratified by the ZigBeeAlliance
in December 2004. In June
2005, the ZigBee specification
was thrown open to the public.
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Touched By Tech 
Advancements in
technology have
made life much
easier for all of
us, but how
much do we
realise it?

cover his mistakes, and finally one copy would be
ready. What if he’d needed to type something in
triplicate? If he lived in the age of the photocopier,
he’d have been able to go to a shop and make a
few copies; if he didn’t, he’d have had to type out
the same letter all over again. All you need to do
is change the “Number of copies” option in the
print dialog box to “3”! 

This, however, is something you already
know, so why is Digit reminding you? Well, we
want to look at what inventions and
technological developments
have truly enriched our
lives, and what
upcoming

Robert Sovereign-Smith

wenty years, or perhaps even just a decade
ago, life was a lot tougher! Depending on
when you were born, you may or may not

appreciate that fact. And the fact is, it’s technol-
ogy—not politics or the economy or anything
else—that’s made most of the difference.

Let’s say you have to type a letter, or a résumé;
you start the computer, open MS Word, type it out,
format it with colours and fonts and then press
[Ctrl] + [P]. Simple, isn’t it? Now, consider how your

father would have done the same task
when he was your age: he’d pick up a

huge, heavy typewriter (if he had
one), find paper, load it in,

hammer away at the keys—care-
fully, as he didn’t have a Back-

space or a Delete button,
and use whiteout to

T

Illustration Chaitanya Surpur
Photograph Jiten Gandhi
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technologies could revolutionise the comfort
levels we already enjoy.

The technologies we speak of in what follows
are arranged in order of the impact they’ve had
on our lives.

The PC
The PC began way back in 1973 with the ALTO,
developed by Xerox. This wasn’t released to the
public, as they didn’t think there was a market
for this sort of product—famous last words! 

The first publicly available PC was the Altair
80800, developed by Ed Roberts. Fast-forward to
the present day, and thanks to all the battles and
wars raging between manufacturers of various PC

components, a PC is today cheaper than ever
before. There are hundreds of billions of dollars
being spent and earned on PCs, and jobs that did
not exist just a decade ago are now some of the
highest-paying ones. 

The PC has become our primary interface with
technology. Almost everything technology-related
we do needs a PC in one way or another, whether
it’s gaming, programming, accounts, printing,
surfing or e-mail. There’s no doubt that the PC
wins hands down as the technology that vastly
changed our lives!

The Internet
If the PC changed our lives, the Internet enhanced
the way your PC could be put to use, and, in a very
real sense, made the world a truly tiny place.

What started out as a bulletin board style of
exchanging information has now taken over our
lives in ways we do not imagine. Take simple e-

mail for instance: at a time when official and
personal communication had to be done over the
telephone or via snail mail, e-mail gave us all the
ease of sending a message, letter, business quota-
tion and more, to someone across the world in a
matter of seconds. 

The beauty of e-mail was that, just like post or
snail mail, a message could be delivered to a
person even if he wasn’t in at work on that day —
a phone call, instead, meant that both people had
to be present at their respective phone instru-
ments to “talk”.

However, e-mail is not the only thing the Inter-
net has given us; you can use it to find informa-
tion, people, services, adult content, images and
so much more. Thanks to the Internet, you can
now chat in real time, via text and even voice and
video, with someone at the other end of the
world—and all this at minimal cost!

Innumerable Web-based companies started
that have no ‘brick-and-mortar’ presence in the
form of an office or anything ‘concrete’, but still
earn millions of dollars a year through services.
There are also Web sites that help you or your
company get work contracts such as www.renta-
coder.com and www.elance.com. Then there are
the evils of file sharing and P2P, which have been
a boon to most users and a bane to the movie and
music industry.

Thanks to the Internet, we’ve created a
completely virtual world, in which we have
communities that contain everything that you see
in regular society—friends from across the world,
criminals (hackers), people looking to cheat you,
shady deals, dating sites, matrimonial sites, in
other words, a huge resource for learning that’s
bigger than any library in the world. 

It’s not an exaggeration to say that the Inter-
net has enabled us to go beyond our bodies; we’ve
gotten very close indeed to “social virtual reality”
—as anyone who “lives” on the Internet will
affirm. And that’s just scratching the surface of
the Internet. The Internet really is the best exam-
ple of a technology that has changed our lives!

Mobile Computing
Just a few years ago, we were starting to get used
to doing everything on a computer. Laptops were
for rich folks, and mobile phones were not power-
ful enough to handle everyday computing needs.
Then entered the new breed of devices that
changed that situation forever. Though they used
age-old wireless data transfer ideas, mobile

The Xerox ALTO
was perhaps
the first
development 
in the PC
business.
However, Xerox
misjudged the
need for a PC
and never sold
it. One of
Xerox’s biggest
mistakes

People often confuse
the “Internet” with
the World Wide Web
(WWW). The truth is
that though no one
person invented the
Internet, the WWW
was the brainchild of
just one man—Sir
Timothy Berners-Lee.
Thanks to Berners-
Lee (left), all of us
can surf the WWW
and find the
information we need

Imagine every child using a tablet PC at school; it’s not
impossible or even improbable, this is a photo from an
actual school in Japan! All thanks to Mobile Computing
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devices were much better equipped, with bigger
colour displays and faster processors that could
handle more tasks.

With the entry of 2G services such as GPRS
and WAP in India, being connected on the go
also became a reality. Users were now able to
access Internet content from just about
anywhere in a mobile provider’s service area.
This has changed life for many of us, even if it
means staying signed in to IM services such as
Yahoo! Messenger, or being able to access e-mail
from anywhere, at any time.

These services let you enjoy full-blown Inter-
net access by connecting your phone to your
laptop. Short-range wireless services such as Blue-
tooth or Wi-Fi also meant that communication
between two users, or connecting to the Internet
at, say, a coffee shop or an airport, was easier than
ever before.

Though not as path-breaking as the PC or the
Internet, mobile computing set us free from the
shackles of wires and fixed terminals, and has
forever changed the way we compute on the move.

Digital Entertainment
A little over a decade ago, VCRs, movie theatres
and VCD players were our only source of enter-
tainment. Sure, there was the TV, but what if you
wanted to watch what you wanted to watch?
Along came digital audio and video to forever

change the face of personal entertainment. The
spotlight gradually shifted from the TV to the PC
monitor, and today, even if we have a DVD player,
we tend to pop a DVD movie into our DVD-ROM
drive to watch it on the PC.

The most notable of the digital formats was
perhaps MP3. This audio format, although not a
lossless compression technique, was single-hand-
edly responsible for bringing digital audio to the
PC. It was developed and standardised in 1991 by
a team working for the ISO/IEC MPEG audio
committee, and we first started seeing .mp3 files
sometime in 1995. With the popularisation of
MP3 on the Internet, mainly due to the smaller
file sizes and decent audio quality, piracy of audio
CDs took off. Songs could be downloaded for the
first time, even on lower bandwidth connections,
and Napster ruled the Net. 

A major contributing factor to the popularity
of the MP3 file format was the fact that encoders
and rippers were easily available, and could also
run on lower-powered PCs. So just about anybody
with a computer could pop in an audio CD and
rip it to MP3, and also use P2P clients to share the
songs with people across the world.

Though there are considerably better encod-
ing formats such as AAC and Ogg Vorbis, and even
lossless formats such as FLAC and Monkey’s
Audio, it will take considerable time for any other
encoder to dethrone the MP3. Because of its popu-
larity, most DVD and VCD players have incorpo-
rated MP3 support. 

Almost every computer-literate has heard of
the format, and many software media players
bundle at least one MP3 song with their
installers. If that weren’t enough, a whole slew
of portable music gadgets sprung up, and
though they support most popular compressed
audio formats, they have kept the title of
“portable MP3 players”.

In terms of video, it was perhaps DivX that
popularised digital video on PCs. Though DivX
was really a hit at one point, it does not enjoy a
similar stranglehold on video compression as
MP3 does on audio. It’s controversial, but DivX
perhaps helped boost the online pornography
industry by allowing movies to be compressed
and distributed via P2P and also Web sites.

Microsoft’s Media Center OS is catching up, proving that
the PC is really becoming the entertainment solution in
many homes

JANUARY 2006 DIGIT
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More than video, games have taken over as a
source for entertainment at home. As details in
games became better, so did their demand for
high-end hardware. As of now, it’s not just PC
users who enjoy games, but also mobile users and
console gamers. 

Gamers are known to spend hours and hours
on a single game. It’s not only high-end games
that get us addicted, it’s also their lower-end
arcade counterparts. Even Solitaire, also known
as the game for bored secretaries, can be
extremely addictive.

As a whole, digital audio, video and games
have converted the simple PC into a complete
entertainment centre. And thanks to this, an
entire leisure and lifestyle industry has been
established, and both manufacturers and buyers
are thankful.

The Future
Here’s where all this gets more interesting. We all
know most of what we’ve spoken about thus far,
but no-one can be truly certain of the technolo-
gies that will change our lives in the near future.
We’re willing to stick our necks out and try and
play soothsayer.

Wireless Networking
Although wireless technologies have been
around for some time, none have been able to
create enough impact to have revolutionised our
lives. Yes, we can go to airports and hotels and
use our laptops to stay connected, but what
happens when you leave those buildings? 

In India, true broadband penetration is still
a dream—most of us who have always-on “broad-
band” connections are struggling with speeds
that are barely twice or thrice as fast as dial-up.
Contrast this with, say, the US or Europe, where
broadband means speeds in excess of 512 Kbps. 

This is not to say that speeds of 1 Mbps and
more are not available in India; it’s just that an
unlimited access, 1 Mbps plan costs way more
than the average worker’s salary, and limited
MB-based plans, too, are very expensive. Again,
compared to the US, where even people living
on welfare can afford broadband, India falls far
short of expectations. And if those of us living in
metros are complaining, imagine the plight of
those living in villages and smaller towns. 

WiMax, or the wireless technology that
succeeds it, could bring hope to remote areas of
India—with wireless networks that can cover 10
km using one antenna. 

While we cannot deny that it’s too expensive
to lay fibre optics all over India or set up a nation-
wide WiMax service, but the passage of time and
technology prices are inversely proportional—so
chances are prices will fall. The future of broad-
band penetration could possibly be a mix of fibre
optics and wireless solutions.

Alternative Displays
Displays that are flexible, or displays that are
projected, will reduce the size of gadgets and
their prices as well. Holographic displays could
finally give us true 3D viewing pleasure, and
although it may sound like something out of
Star Wars, holographic displays are already
becoming a reality. 

The reason new display types will change
our lives is that for almost a century now, all

gadgets that featured the visual element have
been 2D. When holographic projection displays
finally do become mainstream and affordable,
we can be sure that movies, games and images
will never have looked so good. 

Imagine clicking a picture of your friend,
then going home, uploading it to your PC and
projecting it. You will actually be able to walk
around the image, and look at angles you never
saw before. Now picture the Internet; have you
ever imagined what a 3D Web site would look
like? Actually it’s hard to imagine anything,
because 2D has been burnt into our brains. Hope-
fully, we will not need to try imagining for long.

Digital Passion l Lead Feature

Above: The Philips Polymer Vision Readius is an example of just how
alternate display technology (paper displays, in this case) can
completely re-design the way a device is designed

Below: A concept design by NEC of a device that will use projected
displays to do away with both keypads as well as the screen

Wireless technologies have moved us away from our PCs
and freed us from the shackles of confinement when 
computing! Courtesy wireless technologies, we can surf
the Net even on a train journey (above)
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Improved Batteries
In order to be completely free and move around as
we please, we need to build better batteries.
Decades ago, solar-power seemed to offer the
promise of cheap and easily rechargeable batter-
ies, but they just weren’t efficient enough, and
not to forget, useless at night. Currently, fuel cells
are the most promising: they’re cheap, use easily
replenishable fuels, and already offer as much as
10 times more battery life and power than stan-
dard lithium-ion batteries.

Consider that we already have the capability
of making laptops that are as powerful as the best
desktops, and that mass usage of such devices is
only stopped by the fact that we don’t have decent
batteries to support them. Future battery tech-
nologies will play a major role in making better
and reliable mobile gadgets.

Software
Software, too, will have a huge role to play in
our technological future. The idea of adaptive
software is surfacing, and AI researchers are
coming up with new ideas every day. If all goes
well, you will soon be running  your PC on soft-
ware that can “think.” 

Wouldn’t it be nice to wake up in the morn-
ing and find that your home’s “central server”
has already drawn your bath, chosen your
favourite genre of news and made you the
perfect cup of tea? Perhaps we will soon be able
to do away with the keyboard and mouse and be
able to converse with our PCs.

Research is underway to use a camera to
follow eye movement and expressions, which will
allow you to control a mouse cursor just by look-
ing at it and mentally moving it to the desired
place on the screen. Courtesy advanced algo-
rithms, some robots can now learn, all by them-
selves, how to perform in the real world: they can
evolve from scratch, growing up like a child. 

Even weather forecasting systems will finally
become reliable, crunching gargantuan
amounts of data to predict precisely how many
inches it will rain in a given hour. Number
crunchers will also completely map the human
genome, and there’s no limit to what researchers
can do given that mapping. Similarly, there’s no

telling what will happen when software is able
to predict exactly how much a certain stock will
be worth on a certain day!

Medical Technologies
In order to improve our lives, we need to first do
away with suffering and premature death. Digit
has talked about cyborgs earlier, and  advance-
ments in cybernetics offer a lot of  hope. Most of
us would readily trade in all material comforts
to be able to live 10 or 20 years longer, and cyber-
netics makes this a very real possibility. 

Imagine a person suffering from lung
cancer; the standard procedure is to undergo
chemotherapy, which often does more harm
than good. If cybernetics is perfected, all the
patient would need to do is undergo lung
transplant surgery and get fitted with
synthetic lungs. Arteries, veins and even
muscles could just be rebuilt using plastics.

There’s also the developments in  areas such
as telesurgery, where the surgeon sits at a work-
station with mechanical arms, and has a 3D view
of the surgical site. Telesurgery could be
performed on patients at the other end of the
world. Then there’s cryonics—the science (or
science fiction) of keeping a person alive in a

Several years ago, even X-Rays were considered to be
high-tech. Today, there are telesurgeries conducted with
the help of robots, so, a doctor’s physical presence
might not be required in the near future



30 DIGIT JANUARY 2006

Digital Passion l Lead Feature

frozen state until something comes along that
will be able to cure him. In this, the 21st century,
cryonics may really reach perfection. The list of
ideas that technology has in store for the direct
betterment of human life is endless!

Nanotechnology
You hear news about nanotech all the time—a
new kind of fibre that will prevent socks from
smelling, or a full-fledged guitar that can only be
viewed through a microscope. Make no mistake
about this: such news is only the beginning, and
nanotech is certainly not dedicated to the manu-
facturing of interesting but useless products. It’s
the direct manipulation of things on the atomic
or molecular level, and who can say what’s not
possible with that? Nanotechnology, all by itself,
can be called the technology of the 21st century.

Synthetic bones. Metal rubber. Nanocrystals
that make metals harder. Stain-resistant cloth.
Automotive lubricants. High-power rocket propel-
lants. OLED screens. There’s no area of life that
nanotech does not find a place in!

Information Retrieval
The 21st century, is the century of information,
and, naturally, information overload. We’re
repeating ourselves when we say there’s too
much information around, but it cannot be over-
stated. Mature technologies that will help us sift
through all this data are the need of the hour. 

The last five years have seen truly dramatic
improvements in search technology, and artifi-

cial intelligence is one
of several methods
that will make search
better and faster. 

Data mining—find-
ing useful patterns in
masses of data—is
rapidly maturing, and
companies such as
airlines, for example,
will soon be able to
make precise observa-
tions about the huge
piles of customer data
they have. The goal,
ultimately, is to be able
to quickly get meaning-
ful answers to ques-

tions for which we already have the data. 
If you need to know what car best suits your

needs, your computer— or whatever it will be
called—should be able to give you one answer with
complete confidence. You should just need to key
in your criteria. Going by current trends and the
amount of research being done on information
retrieval, such a scenario is not far off.

Exciting Times
What you’ve seen in this article is just a taste of
the things to come. One could write tomes on the
amount of research being conducted in each field
of technology—and we’d need a two-thousand
page issue of Digit to cover that! Some of the tech-
nologies we’ve mentioned have already been
looked at in previous issues of Digit, and the ones
that haven’t, we’ll cover in upcoming issues. 

So far, technology certainly has changed our
lives for the better, and will continue to make life
easier in the near future. There’s no doubt that
this generation is living to see some of the most
exciting times, and is witnessing more advance-
ments than any other. Look forward to future
issues of Digit to read up on the enhancements to
these technologies—as well as the emergence of
newer ones that will impact our daily lives in
some way or the other.

robert_smith@thinkdigit.com

With nanotechnology, you can literally manipulate 
matter at atomic levels. The guitar above is just 10
microns long (about the size of a cell), with strings that
are just 100 atoms wide!

Will any search or information retrieval tool ever
dethrone Google? It doesn’t matter though, because
regardless of which company does it, searching with the
help of AI is still an exciting concept
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Nimish Chandiramani

We speak in awe of the Artificially
Intelligent being. People have come
and gone thinking that they would

see the ultimate Computer in their lifetime—
one that’s indistinguishable from a human
being. In the past and even today, many
researchers have tried to build such a computer. 

Alan M Turing, in 1950, proposed the “imita-
tion game” to test the intelligence of a machine.
The Turing Test for Artificial Intelligence basi-
cally states that if you were chatting with a
human and a machine and couldn’t tell the
difference, then the machine is intelligent; it has
“reached AI.”

To achieve the technological Nirvana of an
intelligent computer, AI researchers use two
approaches. The first approach—the top-down
approach—is the creation of an all-knowing

machine. Machines are great at storing knowl-
edge, but they are awful at little things like

basic common sense, so rather than
programming the machine with all the

knowledge in the world, program the computer
with all the common sense in the world, and let
it loose upon civilisation. This is what Douglas
Lenat, CEO of Cycorp, is using for his robot Cyc
(pronounced “psych”). There are problems with
this approach, though. 

First, there is the horrifyingly large size of
the world’s collective common sense. Second,
most people would not be able to tell the differ-
ence between such a machine and a human,
and it would pass the Turing Test. However,
there will always be the odd person who would
figure out it was a machine he was talking to,
and it would then be easy for him to poke holes
in the software.

It’s nice to know a lot, but realistically,
you can’t know everything. To be
regarded as human, software cannot
take shortcuts that we aren’t
privy to—it will have to go
through life just as we
do. This is the
reasoning Rodney
Brooks of MIT
uses for his

Illustration Shrikrishna Pakar

Future software will go beyond the intelligence of the wizards who will
create them
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robot Cog. Rather than attemp to teach it every-
thing, Brooks will let Cog find its own way in
the world and learn on its own. This way, Cog
would be able to respond to unexpected
happenings in a more human-like manner—
stumbling at first, but slowly learning from its
mistakes. 

It is difficult to say which approach will
finally create the first truly intelligent machine,
but the second approach might just win. The
software of the future would be able to modify
itself to behave the way users want it to. What’s
more, it would do this and still survive the big
bad world it lives in.

It’s Scary Out There
Life was easy for programmers when their end
users were just computer professionals. There
were less of them, and this meant fewer letters
asking for new enhancements. Today, though,
the number of users is staggering—including
not just professionals but the layperson as well. 

Add to this the complexity of today’s
systems: a company that used to have its
employees connected to a single mainframe
server, today, has a hornet’s nest of desktop
PCs and servers throughout its network. 

And the cherry on the cake is the
resources that need consideration—hardware
resources, system load, network bandwidth,
security and many more. Software needs to be
able to trade off some of these resources in
order to meet its goals.

Thus far, software has lived in a Utopia where
every situation is planned for and every type of
scenario is anticipated. The bitter truth is that
programmers can’t write applications that will
tackle situations they can’t foresee, and can’t
anticipate the new and creative ways in which
users can cause software to misbehave. 

In the real world, then, we need software
that can react to and plan for sudden changes in
its environment. Software that can alter itself to
meet users’ demands better, and can do so even
in the face of chaos like failing hardware. The
real world needs Adaptive Software.

Er... What Software?
In 1997, DARPA (Defense Advanced Research
Project Agency)—an agency of the United States
Department of Defense—defined Self-Adaptive
Software as software that “evaluates its own
behaviour and changes its behaviour when the
evaluation indicates that it is not accomplishing
what it is intended to do, or that better func-
tionality or performance is possible”.

In nature’s model of Life, the Universe and
Everything, creatures have responded to changes
in their environment by evolving to suit it; the
intention is the same in the case of adaptive soft-
ware—it alters itself according to its environ-
ment. The “environment” for a software
application is complex, just like nature. There is
hardware to live in, the ‘society’ of the operat-
ing system, and other software and humans to
interact with. But how does software know what
to do to adapt to this environment?

Put simply, Adaptive or Self-Adaptive Soft-
ware “knows itself.” This means that in addition

to knowing what it has to do, the software also
knows its own structure—how it does what it
does—and the many different ways to achieve its
purpose. This way, if it isn’t doing its job well,
the software will automatically alter itself to do
it better.

What Would You Do?
Let’s take a look at how we interact with our envi-
ronments, and how adaptive software follow the
same behaviour in their own environments. 

What if you were on your way to the cinema
hall and your car broke down? Simple, really.
Get out, take a cab, and move to your destina-
tion. Today’s software is the equivalent of
someone who’d sit in the car and cry about
being unable to proceed—decidedly unpleasant
company. Adaptive software, however, will be
able to keep going despite such hardware fail-
ures. Like us, it would try to find a different
method before giving up altogether. This is
called  System Level Adaptivity.

Suppose, now, that you are back home, still
wondering how to go to that movie theatre. In
Mumbai, you could take the train, which would
be fast, but crowded and smelly. You could also
take the bus, but that’s just uncomfortable. Taxis
are too expensive, and you have the sudden
premonition that your car is going to break
down. 

Now that you’ve spent so much time mulling
over what to do, you realise it’s really late and
that you should be getting on. The best way,
then, is the train. In quite a similar manner,
adaptive software looks at the status of the
system and decides the best approach out of
many possible approaches. This is called Algo-
rithm Level Adaptivity.

Now picture yourself budgeting for that
shiny new PC you’re going to build. What you
could do is find out the exact price of everything
right down to the xx99.95 plus taxes. Accurate
down to the last paisa, no doubt, but it would
take you ages to figure out what you need. 

What you could do instead is quickly just
find out the approximate prices of everything
and be on your way. You’ve traded in accuracy
for time. Adaptive software will be able to decide
how to make its calculations depending on how
much accuracy is really needed for a purpose. If
it isn’t a big concern, it would use a less accurate
method to save time and system resources. This
is called Application Level Adaptivity. 

The best adaptive software will be adaptable
at all these three levels.

So How Do They Work?
It’s all very well to talk about what adaptive
software is capable of, but we now need more
than just science fiction. We need to know just
how this “revolution” proposes to deliver what
it promises.

We expect software to behave like humans; the
first step, then, is to have them thinking like
humans. One of the ways in which adaptive soft-
ware works is much like how we work. Instead of
just running into a task, it plans its approach,
executes it and then evaluates it. If the evaluation
shows any negative results, it re-plans the
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The real world
needs Adaptive
Software—which
can alter itself to
meet users’
demands better,
and can do so
even in the face
of chaos like
failing hardware 
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approach and repeats. 
Such software could also work like a factory,

with inputs and outputs, and a monitor that
manages the factory. In case the output is not
the best, the input can be tweaked to make it so.

Send In The Agents
Today’s software works by reacting to users. To
get an application to work just the way you want
it, you need to give it specific instructions. The
average human, however, is quite averse to such
activity. When we give instructions to other
humans, we hardly spell out a detailed plan of
action to follow. Instead, we tell them what
would make us happiest, and then leave them to
their devices. And while they set out to get us
what we want, they do so independently.

The key to adaptive software is the agent—a
piece of software designed to help you meet
your goals. Just like human agents, all they need
is an idea of your preferences rather than your
concrete goal. They will then act autonomously
on your behalf and interact with other agents
for an output that best suits your preferences. In
addition, they keep an eye out for what’s going
on in their environment, and can take the initia-
tive to correct the consequences of, say, a
network failure.

One thing that might concern us, then, is
how to prevent this agent from running wild and
wreaking havoc—we need to know that the agent
is doing what we want, and not just what it
thinks we want. The answer sounds quite
simple—teach it! Once we’ve told the agent our
preferences, we need to let it have a few practice

runs to see how it’s doing, and tell it where it’s
going wrong. To do this, we apply a technique
called Reinforcement Learning.

Teach Me, Master
Reinforcement Learning (RL) relies on the
concept of rewards to tell agents whether they
have hit upon an optimal solution or not. The
goal of the agent, like all of us, is to maximise
the rewards of performing a task.

To understand RL, let us build ourselves a
city, and throw in an automated bus system.
Passengers would approach a bus-stand, press a
button, and soon a bus would be on its way to
pick them up. 

Let us look at just one of these buses. This bus
now has to pick up various passengers across the
city and drop them to their destinations. Only
once the bus is empty can it turn back and go
the other way. What is the best way to go about
it? Nobody really knows yet. What we need to do
is establish a policy that will define the best way
for the bus to fulfil all its duties. 

To define our policy, we now need to decide
why the “best” way would be the best. For this
case, let’s say that our criteria are fuel efficiency
(because we are all environmentally) and ensur-
ing that a maximum number of passengers
reach their destinations without spending too
much time waiting for the bus. Now let’s set up
a reward system. Let’s say that the bus gets -5 for
running empty (wasting valuable fuel), -1 for
each bus-stop with a waiting passenger, and +5
for each passenger who reaches his destination.

Now, writing software to prepare for each
scenario possible above is a mammoth
task for programmers. And even after
that, if the environment changes—the
aging bus might get slower—the
programmers need to be called in
again. And after that, if we were to set
up another futuristic city with this
same system, we’d have to turn to the
programmers again.
RL is the answer to this problem
because it trains the system to do its
job rather than have it pre-
programmed. This means that if any
part of the environment changes, the
system will be re-trained all on its own
without programmer intervention. 

But before we send our software
agent to train itself, we need to equip
it with some vital information. Firstly,
it needs to know the reward function—
how rewards are calculated—so that it
can decide which course of action
would get it the maximum reward. 

Still, merely knowing the immedi-
ate rewards of an action is not enough.
The agent also needs to know the long-
term rewards of a series of actions.
Consider this: suppose there are
passengers at bus-stops A, B and C and
each of them wants to go to bus-stop D. 

The agent might just calculate
that there are high rewards in taking
A to D. But then, it would have to
return for B. The logical choice, we can

The key to
adaptive
software is the
agent—a piece 
of software
designed to 
help you meet
your goals 

B

D

C

A

?

The bus’s delimma: which way is the most rewarding?
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see, is to pick up all three and then head to D.
The long term consequences of the agent’s
actions are captured in the utility function. So the
best solution for the agent will involve high
immediate and long term rewards. In this way,
Reinforcement Learning starts with an initial
guess at the utility function, and evolves as it
explores the system.

And finally, when our agent has explored
the system enough and trained itself for the
best utility function, it can be deployed into
the real network.

What we’ve described here is a single control-
ling agent for our system. In a lot of applications,
though, we would need to have many agents
interacting with each other. The RL algorithm in
such cases would need to be modified to incor-
porate complex theories such as the Game
Theory and the Economic Market Theory.

All is not hunky-dory with RL, though. Like
any human agent will tell you, you can’t always
get what you want. This holds good with the soft-
ware agent as well. Everything cannot be opti-
mised at once, so the software agent will make
a few trade-offs, and you will need to tell the soft-
ware agent how much importance you attach to
resources and to results.  You also never know
what is going to happen—software may not be
quick enough to respond to sudden changes in
environment, and performance would suffer for
a while. 

Is It... Human?
Another way for agents to learn is the Genetic
Algorithm, that’s designed to achieve the same
goals as Reinforcement Learning, but uses a
different approach. Instead of learning the util-
ity function to satisfy the best policy as time
goes on, the Genetic Algorithm learns the best
policy itself. 

The reason Genetic Algorithms are called so
is because of their close resemblance to biologi-
cal evolution. The Genetic Algorithm creates a
pool of possible policies and evaluates each one
to see the rewards. By combining successful poli-
cies, a new pool of policies is created. This is akin
to biological reproduction and the process of
natural selection—by combining the best of the
gene pool, a newer, stronger gene pool is created,
and the rest just die. This process continues until
the best possible policy is obtained—the software

To implement
adaptive code,
we need a
Dynamic
Language—
one that allows
software to be
changed even 
at runtime

version of “Survival of the Fittest.”
Deciding between an RL or Genetic Algo-

rithm approach is difficult. Reinforcement
Learning would work better in bigger, more
complex systems, but Genetic Algorithms would
be the preferred choice for a small system with
limited scope - the fewer policies it has to sift
through, the more efficient it becomes.

Decisions, Decisions
Thus far, we’ve talked about agents making deci-
sions—but how do they “decide”? They are, after
all, computer programs, and all they know is
zero or one—true or false. 

The answer is a Probabilistic Network, which
executes an action based on the information
presented to it by the surrounding environ-
ment. Decisions are made based on the proba-
bility of a favourable outcome from an action,
given all that is happening in the surroundings.
The term “Network” is misleading—probabilis-
tic networks are a way of depicting probability
problems, rather than being actual, physical
networks.

We now need to talk about the Bayesian or
Belief network, which makes decisions based on
Bayes’ Theorem, developed by the Rev Thomas
Bayes. The gist of this theorem is that the
strength of our belief in a hypothesis, given some
additional evidence, depends on the probability
of the hypothesis alone, as well as the probabil-
ity of the evidence assuming the hypothesis
itself is true. 

By starting on an initial hypothesis, the soft-
ware goes on to calculate all the possible
Bayesian networks that would maximise the
probability of the hypothesis being true, finally
coming up with a structure that would give the
maximum reward. 

So we now have an agent using Bayesian
networks to predict the utility function that
will maximise its rewards. After it has made its
initial prediction, it selects the best method to
achieve this function and sets about executing
this method. The agent will now monitor the
rewards of this system and keeps modifying its
idea of the utility function to reap greater
rewards.

The Tools Of The Trade
To implement adaptive code, we need a
Dynamic Language—one that allows software
to be changed even at runtime. Languages like
C demand that the programmer have a clear
idea of the structure that the program is going
to take. Having a design idea for adaptive soft-
ware  before getting down to building it, is a
horrifying, if not completely impossible task. 

What we need to do is write these programs
in such a way that its structure can be modi-
fied as and when necessary. The two preferred
languages that support this are Apple’s Dylan
and the Common Lisp Object System (CLOS).

Unlike regular programming, AI program-
ming doesn’t use the “if-this-then-that”
approach. What it relies on is the encoding of
information about the “world” it runs in.
When an event occurs in the system, the
program uses the information it has about the

The Viable Systems Model specifies
a generalised model for agent-

based systems. It breaks down self-
adaptive software into six major
systems:
System One (S1) - Operations: The
dirty workers—one or more S1s
perform the basic operations of 
the application.
System Two (S2) - Co-ordination:
The foremen—S2s co-ordinate the
activities of the S1s. 
System Three - Control: The

management guys—resource planning
and strategic planning.
System Three* - Audit: The
inspector—monitoring the progress of
the S1s and seeing whether all is going
according to plan.
System Four (S4) - Intelligence: The
navigator—surveys the environment
and plans the way ahead.
System Five (S5) - Policy: The Big
Boss—defines the purpose of the
entire system, based on the ‘world
view’ provided by S4.

The Viable Systems Model
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world to draw its own conclusions about what
happens. 

Lisp and Dylan have always been favourites
for AI programmers because they allow the
programmer to add more and more information
about the world at runtime, basically, teaching
the program new things. 

What Is It Good For?
The goal of developing adaptive software is to
make software more like living beings. Just like
in living society, software agents will observe,
learn from and co-operate with its environment
as well as other agents. The possibilities for such
software are endless. 

The aim, of course, is to finally reach that
Holy Grail of computing—a HAL 9000—a
computer that could converse with humans as
if it were a human itself. It could learn about you
and speak to you only about things that you like
talking about. 

A HAL 9000 built without adaptability would
behave the same whether it was interacting with
a 40-year-old nuclear physicist or a two-year-old
child. An adaptive HAL 9000, however, would
discover that the interaction with two-year-old
wasn’t really working out so well, and would
soon alter its approach to get the best results,
eventually reaching the level of baby-talk.

Software will also be more resilient. Server
software, running on multi-processor systems,
would quickly adapt itself if one of those proces-
sors failed (providing, of course, that the hard-
ware is built that way), keeping the server alive. 

Software could be developed that would moni-
tor your PC’s performance, and give up some of its
resource-hungry tasks to ensure that it is always
responsive to your actions. Adaptive software
would also have enough “self-awareness” to detect
a malfunctioning algorithm within itself and be
able to still run, albeit a little crippled.

Robots today are built for specific tasks—
programming them to take on new responsibil-
ities is cumbersome. But with adaptive software,
robots can take on new roles easily. Adaptive soft-
ware can also be used in robot teams, say, a
robotic football team where each team member
can take on a new role depending on its position
on the field.

Gaming AI is at an incredible level today.
Your opponents will choose fantastic strategies
to get your goose, and you need to push your abil-
ities to the limit to figure out how to beat them.
But once you have figured out their shortcom-
ings, the game becomes a snap. 

Now imagine this, a game that realises that
its old strategies aren’t going to work anymore.
It’s being defeated, and there are no rewards to
being defeated, so it sets about figuring how to
beat you. It observes you, gets to know you and
learns your favourite moves and weaknesses. It
then uses this knowledge to hit upon the best
way to turn you to dust. No corner would be safe;
you would have to give up your standard moves
and trade them in for new ways to approach the
game every time. The agents in the game would
be as dangerous as real human players, perhaps
even more so. 

When Will This Happen?
We are already seeing little instances of adap-
tive software in our lives. Microsoft’s Office
Assistant is one of the earliest examples of soft-
ware that tries to anticipate user needs. Today,
Google’s AdSense program has some semblance
of adaptivity—it shows you advertisements it
thinks you are most likely to click. Adaptability
becomes more difficult to implement as the
purpose gets more complex, but the Agents are
already among us. You never know where one
might pop up. 

We should see the first examples of truly
adaptive software appearing in places where the
efficiency and survival of the system are fore-
most—server applications that can adapt to the
changing load of the system, and are immune to
minor hardware failures.

After this, we should see adaptive software
extending itself to more complex (read: more
fun) applications such as gaming. Game devel-
opers are always trying to make more challeng-
ing games; soon every computer-generated
opponent will be an agent.

Perhaps, most importantly, adaptive soft-
ware will take us along the road to true AI. A
system can exhibit intelligent behaviour even if
it’s dumb—but true intelligence can only
emerge if a program goes beyond what the
programmer foresaw. 

Intelligent software explores its surround-
ings, learns from them and thus evolves beyond
what it was originally intended for. In other
words, it should behave like a living being. Adap-
tive software aims precisely at that. Think about
it: today’s programs entirely reflect the intelli-
gence of the programmer, who has to baby-sit the
program for its lifetime. Tomorrow’s program-
mers will be able to let their creations loose—to
let them go forth, prosper and multiply!

nimish_chandiramani@thinkdigit.com

True intelligence
can only emerge
if a program
goes beyond
what the
programmer
foresaw
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Take a Crack 
and Win 
Professional SLQ Server 
2000 DTS
By Mark Chaffin, Brian Knight and
Todd Robinson, published by Shroff
Publishers & Distributors P. Ltd.

Rules and Regulations
Readers are requested to send

in their answers by the 15th of the
month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate in
this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage to
your system that may be caused
while you are trying to solve the
problem.

A. Creating An
Administrative
Installation Point
We’ll first need to create an
Administrative Installation
Point so we can slipstream
the updates into the Office
2003 CD (you cannot just do
a direct copy from CD to
hard disk and hope that it
will work—it won’t!). This
only has to be done once,
and updates can still be
slipstreamed to an existing
Administrative Installation
Point at a later date.

Insert your Office 2003
CD and run the following
command (assuming E: is
your CD drive letter): 

E:\Setup.exe /a
This starts the Office

2003 setup, where you can
define an Administrative
Installation Point for your
Office 2003 files. From here,
you can fill in the
Organization Name and your
Product Key (this is also the
last time you’ll ever need to
insert your Office 2003
Product key!). 

Set the Install Location
to C:\Office2003\ (create
the folder beforehand if you
haven’t done so already).

After clicking ‘Next’,
accept the EULA, and
installation will start. Since
we executed Setup with the
“/a” switch, it will only copy
files to the Install Location
you specified to create an
Administrative Installation
Point, not install Office on
the system.

Once you’re finished,
click ‘OK’. Your Office
2003 files should all be in
the folder specified during
setup.   

B. The Slipstreaming
Process
Explore your Service Pack 2
CD. If it contains (mainly)
six files—namely,
mainsp2ff.msp, ohotfix.exe,
ohotfix.ini, ohotfixr.dll,
owc11sp2ff.msp, and
owc102003sp2ff.msp—then
simply copy and paste all
the files to ‘C:\SP2’.

If you have a Service
Pack 2 CD with only one
file, or if you want to use
Service Pack 2 from the
December 2005 Digit
DVD, then you’ll need to
extract the files: copy
and paste ‘office2003SP2-
KB887616-FullFile-
ENU.exe’ from the
CD/DVD to ‘C:\SP2’. Then,
run the following on the
above file at a command
prompt in the SP2 folder:

Office2003SP2-
KB887616-FullFile-ENU.exe
/Q /C /T:C:\SP2

This will extract the
Office 2003 SP2 files to
‘C:\SP2’.

There is another very
simple method to extract
this file if you have
WinRAR: right-click the
Office 2003 SP2 file and
select “extract files,” then
select the destination path
as ‘C:\SP2’.

We’ve extracted the SP2

file to ‘C:\SP2’. We now
integrate this extracted file
with Office 2003. Run both
these commands in a
command prompt: 

msiexec /p C:\SP2\
MAINSP2ff.msp /a C:\
Office2003\PRO11.msi
SHORTFILENAMES=TRUE
/qb

msiexec /p C:\SP2\
OWC11SP2ff.msp /a C:\
Office2003\OWC11.MSI
SHORTFILENAMES=TRUE /qb

(If you have ‘STD11.msi’
instead of ‘PRO11.msi’ in
the Office2003 folder, edit
the msiexec syntax
accordingly.)

When this is done, the
Service Pack has been
slipstreamed into your
Office 2003 Administrative
Installation Point. You can
now delete the ‘C:\SP2’
folder. When that’s done,
you have a fully up-to-date
Office 2003 distribution. At
this stage, you can choose
to burn the contents of
‘C:\Office2003’ to a CD-R. 

Save and restore share
names and permissions on a 
Windows 2000/XP/2003
computer

THIS MONTH’S CHALLENGE

Slipstream Service Pack 2 Into An Original Office 2003 CDLAST MONTH’S CHALLENGE

Win!

Piyush Pathak
Bharuch, Gujarat

LAST MONTH’S WINNER

Reinstalling Windows
2000/XP/2003? Suggest a
way to back up and restore
all the share names and
permissions from the old
Windows installation to the
new one.
Write in with the subject
‘Take a crack’, and your
postal address, to
takeacrack@thinkdigit.com
with your solution

DIGIT JANUARY 2006



The world’s smallest
multi-media PDA
phone packed with
the latest digital
innovations—the O2
Xda Atom has it all

The hot new Xda Atom from O2, a
Singapore-based cellular handset maker,

has many ‘firsts’ to its credit. At 58 x 102 x
18.5 mm, it’s the world’s smallest PDA-phone.
It is also the first PDA-phone to feature an
integrated 2 mega pixel camera, an
integrated FM Tuner and a media centre
application. Moreover, it is the first PDA
phone from the O2 stable to run Windows
Mobile 5.0.  

The Xda Atom combines work and
entertainment capabilities in a stunning
piano black casing. Powered by an Intel
PXA27x processor at 416 MHz, the Xda Atom
boasts of a 262K colour 2.7-inch QVGA TFT-
LCD screen, 128 MB ROM, 64 MB RAM, auto
configuration and self-diagnostic capabilities.
Whew! The memory can be expanded by

using the available miniSD slot. With Xda
Atom, one can view PowerPoint files, create
tables and charts using Word and Excel. 

Connectivity options on the Xda Atom
include triband EDGE GPRS, Wi-Fi and
Bluetooth—enough to keep users globally
connected regardless of their current location.
Priced at Rs 38,888, the Xda Atom will attract
professionals and enthusiasts alike. With the
Atom in your hand,who needs a computer? 

Imaging Sivalal S

O2 Xda Atom

Digital Passion | Geek Dreams
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Ram Mohan Rao

Who needs 5 Mbps? Of course you do,
so you can (illegally!) download a
movie in 20 minutes. But who needs

54 Mbps? You’d need to buy a new hard disk
every day if you kept downloading at that
speed! But streaming video, teleconferencing
and even HDTV become possible at 54 Mbps,
which is the theoretical speed offered by
VDSL—Very-high-bit-rate DSL. VDSL is the
hybrid (fibre-cum-twisted pair copper wire)
evolution of DSL (Digital Subscriber Line). OK,
it’s sort of cheating to call it DSL, but then,
much of the last mile is over telephone lines.

If you’ve lost us, refer Turbocharging The Tele-
phone, Digit July 2004. There, we talked about
DSL and how it works. Back then, DSL wasn’t

really available in India except for a few select
cities; now, corporations such as BSNL, MTNL,
and Airtel offer ADSL (Asynchronous DSL) in
several cities. The services are very expensive
for those of us who like to download a lot of
stuff (and that’s most of us!), but it’s there.
Plans from the companies mentioned above are
pretty competetive for casual surfers. 

In any case, our purpose here is to talk
about what VDSL is and whether it’s possible in
India. But before that, a recap about how DSL—
specifically ADSL—works.

ADSL
ADSL provides a bandwidth that differs from
area to area, and between implementations; a
typical figure would be 1.5 Mbps to 8 Mbps
over a single copper pair, at distances up to
18,000 feet, and at a wire thickness of 0.5 mm.

You probably know that with ADSL, you
can use your phone at the same time that you
surf the Net. You’re able to do this because the
ADSL system divides the frequency spectrum
into three parts—one for phone service, one for
upstream data and one for downstream data.

How does ADSL work? What is VDSL? When, and how, will true broadband
reach your home? We take a brief look

Illustration Shrikrishna Patkar

Pole Position
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Phone service is at the lower end of the spec-
trum; data is at the higher end. To implement
this frequency splitting, you need to
install a splitter along with the DSL modem.
Voice can typically be transmitted within the
4 KHz range.

The actual splitting of the frequency range
is done using one of two methods—Frequency
Division Multiplexing (FDM) or Echo Cancellation.
FDM uses separate frequency bands for the
transmitting and receiving channels. In Echo
Cancellation, transmission and reception
happens on the same frequencies—that is, the
bands overlap.

The advantage of FDM is that it is cheaper
to implement in the sense that the hardware
needs to do less work to separate the transmit-
ted and received signals; the advantage of Echo
Cancellation is that it transmits at a relatively
lower end of the spectrum, meaning less signal
attenuation with distance. See figure Frequency
Splitting In FDM And Echo Cancellation.

Actually, it’s not quite as simple as that.
There’s modulation involved as well (refer
this month’s Fast Track for more on modula-
tion). Modulation is required because of
several factors, including the noise associated
with transmitting data over the kinds of
frequencies we’re talking about. In ADSL, the
signal from your home is modulated (most
usually) using a technique called discrete multi-
tone (DMT), which is also what has been
approved by the standards authorities
for VDSL.

DMT splits up the spectrum on which the
downstream signal travels into 247 channels,
each of these 4 KHz wide (and the downstream
spectrum into 32 channels). The biggest advan-
tage of splitting up the band into so many
channels is the continuous quality check that
is possible.

Each of the hundreds of channels is moni-
tored, and if and when it is seen that quality is
impaired on a particular channel, the data on
that channel can be shifted onto another one.
This happens continuously—the system is
constantly re-assigning data to channels. What
results is the “best” channels at any particular
moment being chosen.

After all the data is switched onto the right
place, your phone line transmits everything

Frequency Splitting In FDM And Echo Cancellation

In FDM (left), the frequency band is split into ranges for telephone serv-
ice, upstream data, and downstream data, at the frequencies indicated
above. In Echo Cancellation (right), the frequency bands for upstream
and downstream data overlap
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together to your service provider’s Central
Office (CO). At the CO, a DSL Access Multiplexer
(DSLAM) aggregates all the ADSL lines coming
in to it from all over the neighbourhood.
Because of the frequency separation, the DSLAM
can figure out what’s voice and what’s data.
Voice is redirected to the PSTN (Public Switched
Telephone Network), and Internet data is
switched to the backbone connected to the ISP.

Now, the problem remains of the signal
dropping as distance from the CO increases.
See figure Data Rates And Distances for how
much this drop is, with ADSL compared against
VDSL. It’s clear that ADSL can carry data reli-
ably over much longer distances.

VDSL
Now here’s the 54 Mbps we were talking about!
VDSL offers such fibre-like speeds over copper
wiring, but like we mentioned, some of the
path from the home to the central office (full
form: central telephone switching office) is
indeed fibre.

VDSL isn’t new. It’s been around for a while,
but is being rolled out mostly in Japan and
Korea. We know it hurts, but all we can do right
now is sit and watch providers in these coun-
tries battle it out to deliver the fastest speeds to
their customers!

As indicators, in Korea, we’re looking at 50
Mbps downstream and 11 Mbps upstream being
offered. In Japan, it’s more like 70 Mbps down-
stream and 30 Mbps upstream—courtesy
VDSL 2 (See Jargon Buster). In Japan, NTT charges
a premium of just about $2 (Rs 90) per month
over the cost of ADSL service!

So why doesn’t everyone just move on to
VDSL? The answer lies in what we’ve been talk-
ing about all along: fibre. (For example,
markets in the United States have not been too
responsive to VDSL.) To understand this, we
need to understand what the last-mile problem
is all about.

Fibre For The Last Mile
ISPs (In India, VSNL, Bharti and Reliance
Infocomm) are connected to the Internet back-

bone. Telephone service providers (TSPs, such
as MTNL) are connected to the ISP, and your
home is connected to the TSP’s exchange. In
some cases, you might directly be connected
to the ISP’s central office (CO). If you’re not
connected directly to the ISP’s CO, it’s copper
followed by fibre that carries data to the ISP.

It’s the distance between the CO (or tele-
phone exchange) and your home that is called
the last mile, and here’s where all the issues
arise. “The last mile” typically means a couple
of kilometres, but could be longer.

ADSL2+ (See Jargon Buster), within a mile (1.6
kilometres) of the CO, can deliver about 25
Mbps. That should be enough, one might say,
but faster is better, and there’s no questioning
that. VDSL can reach 100 Mbps within 1,000
feet of the CO, but as the distance from the CO
increases to more than a mile, the speed begins
to compare with ADSL2+’s 25 Mbps.

Here’s where fibre comes in. VDSL deploy-
ments use some length of fibre from the CO.
How much, depends on the particular deploy-
ment. There’s Fibre To The Neighbourhood
(FTTN), Fibre To The Curb (FTTC), and Fibre To
The Basement (FTTB). Of course, there’s also
Fibre To The Home (FTTH), which means fibre
all the way with no telephone lines involved.

All these terms are somewhat self-explana-
tory, but to elaborate, FTTB is fibre all the way
to the basement of a tall building, from where
copper takes over to the individual offices in
the building. FTTC means fibre would reach
your street. And FTTN—the most practical possi-
bility being talked about these days—involves
the setting up of optical network units (ONUs)
in a neighbourhood to which, on one side, fibre
connects to the CO, and on the other side,
copper connects to the home or office. The
ONU’s job is to convert the electronic signals
from the copper to light signals, which are
transmitted over the fibre.
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DSL, of course, isn’t the only
choice if you’re looking at

broadband in India—at present,
cable is the most visible alternative.
Whereas the infrastructure needed
for DSL—namely, telephone wiring—
already exists, each new cable
Internet installation requires cables
to be laid.

How do they compare? They’re
pretty neck-and-neck in terms of
how good they are and what they
can deliver. Both are capable of very
high bandwidths; it’s up to the
service provider how much he wants
to give you at an affordable price!
About last-mile connectivity, for
cable, it depends on how the
equipment in your neighbourhood is
wired up; for DSL, it depends on the
quality of copper you’re connected
to. With cable, as the number of
users on the network increase, your

speeds will go down; this is
currently not the case with ADSL in
India, where you’re “guaranteed”
dedicated bandwidths. Our guess,
however, is that as ADSL
penetration increases, the issue of
sharing bandwidth will arise with
ADSL as well, and you might not get
dedicated bandwidth.

The situation, according to
Sandeep Kolwadkar, deputy general
manager (BD) at BSNL, is different for
urban and rural areas: technicians in
rural areas aren’t proficient at setting
up good cable networks, and that
hampers speeds; in the case of DSL, it
is poor copper quality that hampers
speeds. Kolwadkar affirms that in
urban areas, though, DSL does not
suffer from the “poor copper”
syndrome, and that connections are
stable. That means we’ve only got to
wait for prices to drop!

Cable vs DSL

Data Rates And Distances

This graph is an indicative plot of connection speed ver-
sus distance from the service provider’s CO. Because of
the frequencies they use, the situation is quite different
for ADSL and VDSL

Distance in kilofeet of 0.5 mm wire

VDSL

ADSL

3

10

20

30

40

50

M
bp

s

6 9 12 15 18



50 DIGIT JANUARY 2006

Digital Passion l In Sight

The need (or the use) of fibre is what makes
VDSL noteworthy as a technology. On the one
hand, FTTN deployment may be difficult in
some countries or areas; on the other hand, it’s
the fibre that enables VDSL to provide break-
neck speeds over home telephone lines. And
along the same lines, when it comes to ADSL2+
vs VDSL, it’s a question of how far from the CO
the deployment will be—ADSL is suitable for
long-reach broadband, and VDSL will be viable
if fibre itself is viable. 

The Situation In India
VDSL in India? Far-fetched? We don’t even have
good ADSL yet! Anyway, we were wondering
what the scene is like and what it will be, so
we asked someone in the know—
Jagbir Singh, group CTO, Infotel, Bharti Tele-
Ventures Ltd.

First off, Mr Singh says DSL is the “global
trend” and that it will remain the dominant
technology for a long time. He also says things
are “moving towards DSL, with around 44
million landline connections in the country
and both the incumbent operators becoming
aggressive.” 44 million isn’t too large a figure
when you compare it with the penetration in
the United States or even China. Still, it’s there,
whereas cable is virtually non-existent in
rural India.

Broadband is definitely getting cheaper,
with, for example, Airtel offering a wide range
of affordable plans. However, Mr Singh says,
“What we need today are policies that would
replicate the mobile telephony growth success
in the Internet arena. Unbundling of the local
loop, peering for all at NIXI (National Internet
eXchange of India), and Open Sky policy for
DTH providers are a couple of steps that would
allow better and cost-effective reach for any
service provider to its target market segments.”

Some explanation is warranted here.

“Unbundling of the local loop” refers to privati-
sation of the last mile; currently, the govern-
ment has a stronghold on what happens to the
phone line between your home and the tele-
phone exchange. We’re not sure how long this
will take. 

The “Open Sky policy” refers to allowing
DTH (Direct To Home) operators to have satellite
uplinks from wherever they please; contrast
that with the situation now, where they are only
allowed to uplink from certain areas. Again,
here, we don’t know when the government will
take positive steps in this direction.

“Peering over the NIXI” is when two ISPs
agree to exchange traffic over the NIXI for free.
An Internet Exchange, such as the NIXI, is a
facility that allows ISPs to “meet” and exchange
traffic. The purpose of establishing the NIXI was
that Internet traffic that originates in India and
has a destination in India should stay within
the country; the advantage, of course, would be
cost savings because of a reduction in reliance
on international bandwidth. It would also
increase speeds for obvious reasons—Indian
traffic would not unnecessarily be routed all
the way to, say, the UK.

We then asked about where the future of
broadband in India lies—DSL, fibre, wireless,
cable, what? Mr Singh is of the opinion that
given the kind of content available and the
needs of the Indian market as Bharti sees it,
broadband connectivity on copper is “here to
stay.” Cable, according to Mr Singh, is still a
long way from becoming a viable proposition—
this, ostensibly because of the relative lack of
an existing infrastructure.

Then, of course, we wondered about VDSL.
We asked if Fibre To The Neighbourhood was
feasible anytime soon. What Mr Singh said was
a total surprise: he went beyond VDSL, and said
that it was Fibre To The Home (FTTH) that holds
the most potential as the technology for broad-
band services! Imagine an India with fibre
running all the way to homes!

Of course, “rolling out FTTH quickly and in
a cost-effective manner to cover rural as well as
urban areas is a challenge,” according to Mr
Singh. “Deploying this technology means
permissions from every residential block; there
are administrative costs involved, and it takes
time to carry fibre to every household.

“At present, ADSL delivers the best value
proposition, both for service providers as well
as customers.”

So is it ADSL for now and FTTH for later?
That’s the way it would seem.

Some, however, are of the opinion that
VDSL is the way to go for India. At the Conver-
gence India 2005 International Exhibition and
Conference, Moti Shulak, senior director,
marketing, Infineon Technologies, spoke
about the latest advancements in VDSL tech-
nology, and how they “fit perfectly to India's
booming market.”

In any case, we can conclude that the broad-
band situation is not as dismal as it might
seem right now! Pricing, however, might make
you gloomy again!

ram_mohan@thinkdigit.com

ADSL2+ is a standard approved by the
ITU (International Telecommunications
Union) in January of 2003. It doubles
the maximum frequency for
downstream data transmission from 1.1
MHz to 2.2 MHz. If you’re within 2 km of
the CO, downstream data rates can be
up to 24 Mbps. There’s also an optional
mode that doubles upstream
bandwidth.
VDSL 2 was ratified by the ITU in May
2005. The standard delivers up to 100
Mbps both upstream and downstream,
and works over copper up to 12,000
feet. VDSL 2 uses about 30 MHz of
spectrum, versus 12 MHz in VDSL.
HDTV is short for “high-definition
television.” It’s digital TV wherein a
wide-screen picture is transmitted with
many times more detail than current
analogue television. HDTV requires five
times the bandwidth of current-
generation TV signals.

Modulation is the term for making one
signal ride on top of another. The first
signal we’re talking about is the one
that is of importance; the second signal
is called the carrier. The carrier signal
can travel better through the medium
than the first signal alone. For example,
in radio, we have Frequency Modulation
(FM); the carrier signal is of the
frequencies you hear about—105 MHz
and so on. The actual data signal is used
to modify this signal to a small extent,
and it is recovered by the receiving
equipment.
A channel is a frequency band in which
a specific signal is transmitted. So when
one refers to DMT splitting the
spectrum into 247 channels, it’s 247
separate frequency bands, and a signal
on one band or channel will be
independent of, and will not interfere
with, a signal on a different band or
channel.

Jargon Buster



Digital Passion l First Hand

The Cool Guy
One such computer hack we came across is Sanjay
Rao from Mysore. This third-year engineering
student from Shree Jayachamarajendra college of
Engineering, Mysore, has taken to developing
better cooling methods for his PC with a vengeance.
The passion started with a trip to a computer shop
that assembled customised computers. 

Sanjay says he spoke to the shop owner about
the prospect of designing newer cooling systems.

“I partnered with a friend in this venture. I
did the designing, while he went about
collecting all the information and equip-
ment. Most of our earlier designs were
rejected because they were either too
big or weren’t efficient enough.” But
those rejections did not deter Sanjay,
or Sunny as he prefers to be called.

“I wanted to make my own water
block;I spent almost five months on

research, but couldn’t get satisfactory
results,” he says. Then, with the help of

a friend, Sanjay got a DangerDen TDX

How many of us
care about
cooling? Meet
someone who
cares enough to
risk running a
liquid through
his PC cabinet

Mithun Kidambi

ost of us aren’t too bothered about the
type of cooling equipment installed in our
computers. As long as the fan doesn’t

drone too much and create a ruckus, we’re fine
with it. Also, overclocking one’s computer and
playing around with the latest and fastest graph-
ics cards is a very geek thing to do. There are many
among us who are happy seeing the screws on the
PC cabinet tightly fixed: who’d want to meddle
around with the motherboard and increase its
working temperatures, bringing it close to
levels that could result in a processor burn-
out? Well, that’s what separates the über-
geeks from normal people: the urge to
push the limits of their personal
computers, to take its hardware to
the next level and eke out some extra
megahertz! 

M

Im
aging Pradip Ingale

Photograph Sadeep Patil

Let Your
Computer Chill
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A64 imported from www.frozencpu.com. The
thing cost him $60 (Rs 2,700), including the ship-
ping charges. With a water block in place, Sunny
was all geared to rig up his own cooling system.

What’s In A Block?
A water block, the water cooling equivalent of a
heat sink, is used on several computer compo-
nents including the CPU, graphics card, and the
chipset on the motherboard. A typical water
block consists of two parts. The first is the base,
which makes contact with the device being
cooled. This is usually made of a highly-conduc-
tive metal, such as aluminium or copper, so that
heat is dissipated fast. The second part—the top—
ensures that the water (or the liquid used for cool-
ing) is contained safely inside the block.

If you want to jazz up your PC, you can use a
loop made of a transparent material such as
Perspex, or UV-reactive tubes that glow under UV
(ultraviolet) light.

The base and top are sealed together to form
a block with a channel inside. Each end of the
channel has connectors for the inlet and outlet. In
most cases, the channel is a spiral or zig-zag in
pattern, like in a refrigerator or air-conditioner.

Some channels also have heat sink-styled fins
so as to enlarge the surface area available for heat
dissipation. Care must be taken, however, so the
design of the channel does not impede the flow of
the liquid inside it. Most people who opt for water
cooling prefer to have the channels made of a
transparent material so that the flow of the liquid
inside is visible. Guess it adds to the rush of things!

The Geek Setup
Sanjay’s cooling system consisted of the water
block and a pump that pumped liquid at a speed
of 700 litres per hour. A stroke of genius was in
picking up a radiator from a Mitsubishi Lancer.
“The radiator was one foot high and 20 cm wide.
The dimensions were just right for my design,”
claims Sanjay. “I also needed a few tubes to create
the channels, some coolant, and water. My hunt
for the channels was the most exciting part. I was
looking for a UV-reactive tube, and these weren’t
available in India. A little bit of reading up made
me realise that these tubes were indeed available
here, only they were used for different purposes.

“These tubes were used in motorbikes. Later
on, people were amazed as to how I laid my hands
on them! The other important components were
the coolant and the distilled water. For the
coolant, I used a regular engine coolant from

Castrol. I did not, however,
trust the purity of the distilled
water found in garages, so I

borrowed two litres of it from my college labora-
tory. I, then mixed one part of coolant with four
parts of distilled water. I connected the rig,
screwed in the right parts, and voila—my water
cooling setup was ready,” he explains.

To test his cooling system, Sanjay did some
volt modding—increasing the voltage intake of his
motherboard—on his A7N8X Dlx nForce2 Ultra
motherboard. The cooling setup enabled him
touch a core voltage of 2.05 volts. The resulting
heat dissipation was around 146 watts. Compare
this to the normal heat dissipation of 65 watts at
a core voltage of 1.65 volts, and you know how
much cooling the system was doing! Of course,
running a motherboard at that voltage for too
long meant that you would need to replace it
within a few hours, so Sanjay settled down at a
core voltage of 1.7 volts, which is still significantly
higher than the normal 1.65 volts. 

Let’s Talk About The Money
Sanjay’s constant experiments have led to moth-
erboard and processor burnouts. Not to say,
they’ve also burnt a hole in his pocket, but this
hasn’t deterred this Information Science student
from experimenting further.

His aim now is to design and build his own
water block. “Once my exams are done, I’ll get
down to developing my own water block and
make a Do-It-Yourself kit. I plan to sell these for Rs
4,000. That is significantly lower than what most
water cooling systems cost today,” he says.

Not for the faint-hearted or even the moder-
ately geeky, water cooling will remain niche
because of the level of customisation it requires.
However, you do get computers that have a
liquid cooling system installed, notably the
Apple G5. Remember, you can’t just slap a water
block on your processor and overclock it! If
you’re interested in water cooling, make sure
you know what you’re doing! 

mithun_kidambi@thinkdigit.comSanjay Rao, the whiz who did it

Check out the rig—with the water
block, neon lighting and all
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Day 1: Features Galore
It’s finally here! I’m gushing with an enthusiasm thatNature only bestows upon five-year-olds. Installing 3dsmax8 from the DVD is extremely simple. And in no time, I findmyself staring at the new version in joy and wonderment.As I survey the user interface, it reaffirms one of the thingsI have admired in Discreet/Autodesk all these years—nomatter which version of 3ds max you’ve worked on before,migrating to the latest version is no more difficult thaninstalling it; it looks the same! No bothering with newbuttons cropping up unexpectedly—just start and begincreating. Ingenious. 

Day 7
I approach the new ‘Hair and Fur’ plugin withconsiderable apprehension. Working with hair has alwaysbeen a recurring nightmare for me; how do I know thatthis isn’t going to be another?I was wrong, diary. This is the easiest it’s ever been tocreate hair in 3ds max; I can comb it, cut it, clump it, growit… and apparently crash it, too. Let me try that again. Ah,it didn’t crash this time. A moody plugin, I guess.

Day 13
Today, I shall finally be able to properly texture my 3Dteddy bear. Instead of spending long, tedious hours withthe UVW mapper ensuring that everything is just so, I cannow use the new Pelt mapping feature. It’s like I ripped myteddy apart, painted on its skin as if it were a flat piece ofpaper, and then put it back together again. Fantastic! It’llbe on to bigger, better animals for me now.

Day 22
Virtual characters look silly without their clothes, and Imust brace myself for the daunting task of modelling thesaid clothing. But wait, what’s this? It appears I can drawpieces of clothing and ‘sew’ them together! Now that can’tbe accurate… why, it is!! All I have to do is draw the pieces

of cloth and use the Garment Maker to decide how to sewthem up. Turn to the new Cloth modifier, and voila! Abrand new pair of underg… err… trousers for my character.I can now get this cloth to behave as if it were silk or evenstarched cotton!

Day 26
Ah, the varicolured Character Studio biped… a fun littleguy to start building a human model with, but the poorchap couldn’t turn a doorknob until now. I helped himalong his way by adding a new Twist link to his elbow andnow he can rotate his wrist without moving his elbow—much more like us, in the real world. 

Day 28
I was shocked to learn today that the Mental Ray renderer,which now comes bundled with 3ds max, used to cost morethan 3ds max itself at one time! And no wonder, too. I usedit to render a scene and it simulated real-life lighting rightdown to the red glow that my big red beach ball cast onthe white floor. 

Day 30
My demo expires today; the good times are over. In a fewhours, I shall be greeted with a dreaded “Your trial periodis over. You must purchase this software to continue.” Toparaphrase a favourite character, all I can say is, “they hastaken it from us, Preciousss; and we wants it back!” nimish_chandiramani@thinkdigit.com

Nimish Chandiramani

An ominous silence fell upon the Digit workplace that day. Clearly, we were in the presence of Greatness. A copy of the

much worshipped and more coveted 3ds max 8 - one of, if not the greatest legends of 3D software—was amongst us,

and I was the Chosen One. In the tradition that all us Ones must follow, I have chronicled my adventures here.

3ds max 8
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Nimish Chandiramani

The trials and tribulations of setting up your
own enterprise are many. Even after the
actual establishment, there remain niggling

issues. Information needs to be spread, customers
need to be brought in, and you still need to decide

on your corporate identity—visiting cards, letter-
heads—the list is long. 

To get the professional look you desire for your
promotional material, you would normally turn
to high-end (read expensive) software such as
Quark XPress or Adobe InDesign. You would then
need to spend long hours learning how to use the
software, and some more long hours designing

your publication. And if you need quick
results, you might even need to hire a
professional. Oh, the financial horror!

Thrifty businesspeople, though, would
use Microsoft Word to publish their mate-
rial. It’s taken for granted that every new
PC comes with Word, and it even offers a
few respectable features that can help you
design your publication. However, as the

For the
publishing needs
of your small
enterprise, 
MS Publisher
could just be the
sweet trade-off
between 
MS Word and
‘professional’
software

Pick, Choose, Publish!

Digital Tools l Jumpstart
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Digital Tools l Smart SoHo
With You All The Way
If you need a common theme to run through all
your material, turn to Publisher’s Design Sets.
Depending on what you’re looking for, design
sets offer you sets of templates. 

Consider the case of The Little PR Firm. One
of their clients needs to organise an event to
launch their new product. The Little PR Firm has
to set up a Web site and send flyers and invita-
tions for the event. If they’re using Publisher, all
they need to do is look up the “Special Event”
design set—there are template sets for Web sites,
brochures and invitations just waiting to be
used. One step further is the star of this show—
the Master Set that has templates for everything
from calendars to purchase orders and invoices. 

Beautifying Your Phonebook
If you use Excel or Access to organise your data,
but are bored of plain old tables, Publisher offers
some relief. One of Publisher’s smartest features
is its ability to integrate with data sources such
as Access databases and Excel sheets. Use the
Mail and Catalog Wizard to pick your data
source, and apply a template to present the data.
You’ll soon see your customer database in your
brand new “customer details” publication.

Look Here!
Another highlight of Publisher’s template-driven
approach is the Design Gallery. It offers

frequently-used items such as feedback forms,
coupons and labels that you can insert into your
publication. You can also add a healthy dose of
zing using accents, pull-quotes (blurbs with
interesting quotes), and our favourite, the
Attention Grabber—‘Unbeatable Prices!’

To The Presses!
After designing your publication, Publisher
helps ensure that all is hunky-dory when you
finally go to print. The first is the Design Checker
that checks for data that’s outside the page,
hidden or overflowing text, even pictures that
have been distorted upon resizing. Once Design
Checker deems your publication safe for print-
ing, use the Commercial Printing Tools to adjust

name suggests, it is at the end of the day a word
processor, and can only do so much before it has
you seeking different kind of professional help.

The middle ground, then, would be a package
that can create a professional-looking publication
swiftly and without added investment. Coming
through in this hour of need is Microsoft
Publisher 2003, which now comes bundled with
your installation of Microsoft Office 2003. It offers
a handy collection of tools to get your publication
out as quickly and painlessly as possible.

Pick Me! Pick Me!
The philosophy of Publisher is to
minimise the time between your
realising that you need a publica-
tion and actually having it in
your hand. It offers templates for
nearly all the print material you
might ever need—letterheads, visiting cards,
brochures, catalogues, flyers, advertisements,
banners, greeting cards… whew! 

For the restaurateur, there are templates for
menus, take-out menus, and even wine lists.
There are even a few whimsical templates, such
as folding instructions for paper airplanes! Not
content with print media, Publisher also offers
templates for basic Web sites and e-mails. All you
need to do is pick one and tweak it to your needs.
And, if you aren’t happy with the templates
Publisher provides download more from
Microsoft Office Online.

Publisher offers a huge collection of
templates to suit your every mood

The Master Sets let you select a common theme for all
your documents

Use the design gallery
(above) for some neat
attention grabbers (left)

Keep the kids out of your hair
with the instructions for a
paper plane
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your colours. Also embed the fonts you use, this
way, even if your printer doesn’t have these fonts
on the PC, your publication won’t be affected.

Beyond Print
Establishing a presence in print is not really
enough for today’s businesses—the word must be
spread, and the Internet is just the way to do
that. Publisher also offers a number of templates
for a basic Web site that would tell your
customers about you. The best way is the Easy
Website Builder, which lets you specify exactly
what your site will contain. 

Digital Tools l Smart SoHo

(Above) The Design checker
will tell you what's wrong
with your publication.
(Right) Use the Commercial
Printing tools before finally
going to print

Publisher also offers HTML templates for e-
mail messages, be it to inform your audience of an
upcoming event, a new addition to your product
or services list, or just general correspondence.

So Is It For Me?
Despite all its advantages, using Publisher isn’t
entirely a bed of roses. While it’s all very well to
lay out a few pages of text, the autoflow feature
is rather eccentric. If your publication is more
than a few pages long, it will be an uphill task!
You cannot directly manipulate the HTML code
in your Web page. Publisher isn’t capable of
much beyond what you can do using its
wizards. It is best for its wide choice of
templates that make your publication process
quick and easy, but it won’t make professionals
happy just yet. 

nimish_chandiramani@thinkdigit.com

Creating a Web site is a snap with the Easy Website
Creator in Publisher
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Jayesh Limaye

W
hat better way to
start off the year
than by getting your-
self a new PC? We’ve

done all the hard work for you!
What follows is a comparison
test to help you choose from
amongst many of the branded
models available.

As you probably know, the
first thing you’ve got to decide on
when getting a new PC is whether

it’s going to be Intel-based or
AMD-based. Last year saw some
heady battles between the two,
and AMD leads as of right now.
This translates into a big change
in the PC market: a few years ago,
thinking about an AMD system
for your home was sort of a weird
idea. You had to have “Intel
Inside”! Nothing could be further
from the truth today, and sport-
ing the AMD 64 sticker on your PC
bonnet is the in thing.

The Indian PC market is quite
different from those abroad. Here,
assembled PCs in the desktop
segment still have a stronghold on
the consumer’s psyche, given the
price difference vis-à-vis branded
PCs. Branded PCs are now trying
to break out of the “expensive”
mould. While some brands such
as HP, HCL and Acer have been
around in the country for quite
some time, there are several new
entrants, such as Krypton.

Here’s where our comparison
tests come in. We’ve compared
some of the biggest brands in the
country head-to-head—this
comparison therefore gives us an
opportunity to tell you about
what best PC brands are available
in the Indian market.

We won’t say our comparison
tests are the be-all and end-all of
the matter, but they will defi-
nitely give you a fair idea of price
to performance ratios and more.
As always, we advise you to use
this comparison just as a guide
when making your purchase
decision.

We can hear you saying, “Why
not assembled?” While assembled
PCs may be cheaper, there are
issues such as customer support
and pirated software. These are
usually not talked about when
you make your purchase. With a
branded PC, on the other hand,
you’re assured of legal software
with warranties, and generally, of
good service. Of course, you’ve got
to read the fine print!

We divided the PCs we
received for our tests into three
segments—those below Rs 25,000,
those above that cut-off, and
Media Center PCs. We advise you
not to decide right at this point
how much you want to spend—
first take a look at what’s on offer!

DIGIT JANUARY 2006
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There are several advantages of a branded PC over an assembled
one. However, with so many brands out there, and so many different
needs, it can be hard to choose. But we’re here to help!
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The Value PCs
Rs 25,000 is not just a nice, round
figure—it’s also a good cut-off
point to segregate PCs, going by
current prices. This segment is
primarily targeted at beginning
home users, work-at-home indi-
viduals, students, etc. 

We should emphasise here
that based on what we’ve seen in
this test, a sub-25K PC is not to be
dismissed as a “cheap PC”—
several models that fell in this
category offer you very decent
features indeed!

In this segment are featured
seven PCs: the Compaq Presario
SR1502IL, Compaq Presario
SR1008IL, Datamini Festiva MG
Value, HCL Ezeebee PI 873, HCL
Ezeebee 4981, Zenith Premium 7D,
and the LG XT1-VH1SHP1.

Features
Of the seven PCs mentioned above,
two were AMD-based, and five
were Intel-based. It was good to see
a branded PC in this segment—the
HCL EzeeBee PI 873 —featuring the
powerful AMD Athlon64 proces-
sor. But this wasn’t the only PC in
this segment with a powerful
processor: the Zenith Premium 7D
sported a 3.0 GHz Intel Pentium 4
with HyperThreading Technology,
which is something we didn’t
expect in this, the value category.
These are high-end processors, and

these two PCs therefore bring
powerful number-crunching capa-
bilities at an affordable price.

We also saw some of the best
hard drives being featured on some
of these PCs. While most sported
the older and slower IDE interface,
the HCL PCs came equipped with
the faster SATA drives. In terms of
drive capacities too, HCL lead the
pack with 74 GB and 80 GB drives,
whereas the others stopped at 40
GB—which these days is considered
the bare minimum (read “almost
inadequate”).

In the memory department,
once again, only the HCL PCs came
with as much as 512 MB of RAM.
The Compaq, LG and Zenith PCs
came with just 128 MB of RAM,
and since this was shared by the
onboard graphics, heavy perform-
ance penalties were obvious: we
could actually see these PCs crawl-

ing compared to others with larger
memories.

The HCL and Zenith PCs came
with Combo drives, while the rest
came with plain CD-ROM drives.
We should mention that the Data-
mini PC came with the sloppiest
CD-ROM drive we’ve ever seen—it
had a hard time reading even its
own driver CD, and we had to
connect our own optical drive to
install the OS, drivers and bench-
mark applications! The Compaq
SR1502IL and the Zenith PCs had
optical drives more or less similar
to that of the Datamini.

As we’d expected, none of the
PCs in this segment featured a
separate graphics card, going for
onboard solutions instead. Of
these, the Intel GMA 900 is the
most feature-rich, and is DirectX 9
compliant—which means that it is
ready, out-of-the-box, for the next
version of Windows—Vista. It is also
good for moderate gaming, and is
markedly faster than the other
onboard solutions in this category
such as the SiS 330 Mirage and
Intel Extreme Graphics. Of the
seven PCs in this category, the HCL
Ezeebee 4981, Zenith Premium 7D,
and the Datamini Festiva MG Value
featured Intel GMA 900.

Micro ATX cabinets were the
choice of most brands, while the
Datamini provided an ATX cabi-
net—albeit of an inferior build

Compaq Presario SG1008IL

As in all our tests, the home PCs reviewed here were
rigorously benchmarked and tested. We chose the

benchmarks and tests considering they needed to be run on a
range of computers, from the least powerful to the most
powerful. Windows XP Pro with SP1 was freshly loaded, along
with DirectX 9.0c, and the drivers from the driver CDs provided
with the PC (or from the manufacturer’s Web site, if a driver CD
was not provided) were loaded. This was done even on the Media
Centre PCs, because the Windows XP Media Center 2005 OS that
ships with these PCs is not available off-the-shelf—and the
version that came on the CDs provided comes with SP2, on which
one of our benchmarks doesn’t run.

The tests and benchmarks consisted of the following.
FarCry: This is a Direct3D game that accurately measures the
Direct3D gaming subsystem. We chose FarCry because it uses a
fairly modern graphics engine and reflects how future games will
play on the system.
Call of Duty: This OpenGL game is used to test the strength of the
OpenGL graphics subsystem. We chose Call of Duty because it runs
easily even on motherboards with onboard graphics.
PC Mark 2004 (PCMark04): This is an industry-standard
benchmark that measures the CPU, memory, graphics and
hard disk performance of the system, and hence is a good
system-wide benchmark.
SiSoft Sandra 2005 SR3: This consists of benchmark modules
that measure CPU, filesystem and memory performance.

Ziff-Davis Business Winstone 2004: This benchmark suite runs
various applications such as WinZip, Excel 2002, PowerPoint 2002,
etc., to measure the real-world performance of a system. It returns
a score that is comparable with any system that runs this test suite.
Dr. DivX 1.06: This is a video encoding application used to
encode DivX files. We encoded a 100 MB MPEG2 file to DivX and
noted the time taken to encode.
DBPowerAmp: This is an audio conversion tool used to encode
audio files. We converted a 200 MB WAV file to a VBR MP3 file at
the highest possible quality, and noted the time taken to encode.
DisplayMate: We used DisplayMate Video Edition to evaluate the
quality of the monitor by gauging the sharpness and clarity of
the display.
Nero CD-DVD Speed: We used this application bundled with
Nero Burning ROM to create a 700 MB test data CD, and then
used the CD to test the average speed of the optical drive and
also its access time.
Speaker Test: Various types of audio files were played on the
speakers that came with the PCs (if any did), and we noted the
quality of the audio.

In addition to these tests and benchmarks, features such as
the number and type of optical and hard drives, monitor type
and size, mouse and keyboard type, ports, cabinet type, front
connector options such as USB and card readers, airflow
considerations, and bundled accessories such as speakers and
gamepads were taken into account before we decided on each
PC’s overall score.

How We Tested
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quality. All the brands deserve
credit for taking airflow into
consideration in the design of
the cabinet.

On the upgradeability front,
the Compaq Presario SR1502IL
and the HCL EzeeBee PI 873 came
with AGP 8x graphics slots, while
the Datamini and the HCL Ezee-
Bee 4981 came with PCIe x16
slots. The others didn’t have
graphics slots for upgradeability.
The Zenith PC, with just 128 MB
of RAM, fortunately had four
memory slots (out of which three
were free), and hence provides
good memory upgrade options.
The Zenith also featured four
unused SATA ports.

The best OS we saw in this cate-
gory was RedHat Linux Worksta-
tion—with the HCL PCs—whereas
the Compaq PCs came with Free-
DOS, which is as good as not
providing an OS at all. The pack-
age contents of the Compaq PCs,
too, were minimal - but remember
that this is the value category!

Performance
What we saw in the features was
reflected in our performance
tests. The HCL PI 873 and the
Zenith Premium 7D, with their
considerably more powerful
processors, raced ahead with the
highest points in the CPU tests of
SiSoft Sandra and PCMark04.
They also logged better scores in
video as well as audio encoding,
again because of their proces-
sors. It’s clear that these two
PCs are the best number-crunch-
ers amongst the value-category
PCs, and are the best suited
of the lot for computation-inten-
sive tasks.

In the SiSoft Sandra memory
test, the LG and the Zenith
failed, and the (inadequate) 128
MB of shared memory seems to
have been the cause. Note here
that the Zenith PC came
equipped with one of the most
powerful processors in this cate-
gory; it was held down only
because of the low amount of
memory. The HCL EzeeBee PCs
came with memory modules in
dual- channel configuration and
hence scored good points,
exhibiting a healthy memory
bandwidth, which is necessary
for handling applications such as
multimedia and image editors,
database applications such as
Oracle, and so forth.

The Compaq Presario SR1502IL
scored the lowest in the Nero CD-

DVD speed test, and this can be
blamed on the poor-quality CD-
ROM drive. The Zenith and Data-
mini also logged very slow speeds
in this test. You’ll have to seriously
consider upgrading your optical
drive if you decide to get one of
these three PCs. The Compaq
Presario SG1008IL, with its better
optical drive, scored the best in
this test.

We could not install some
games on the computers with
128 MB of RAM, because that’s
below the games’ minimum
system requirements. These PCs,

therefore, failed our gaming
tests. The HCL PCs, with 512 MB
of RAM, performed well in these
tests due to better graphics and
more RAM. As noted earlier,
these make good PCs for moder-
ate gaming.

All the PCs in this segment, of
course, came with CRT monitors.
When we compared the moni-
tors, there wasn’t much varia-
tion, except that two PCs—the
Compaq Presario SG1008IL and
the HCL Ezeebee 4981—came
with 17-inch monitors. These
larger monitors were, of course,
easier on the eyes.

The Zenith and the Compaq
Presario SR1502IL did not bundle
speakers with their PCs; all the
others did. The ones on the HCL
PCs sounded better than those on
the others—not that the speakers
were really good, they were just
comparatively better. 

The Zenith PC—even with its
low 128 MB of RAM—was the top
scorer in PCMark04, which is a
synthetic benchmark used to eval-
uate the overall performance of a
PC.  The Business Winstone 2004
benchmark is a real-world bench-
mark; here, the HCL EzeeBee
PI 873 scored 24.1, which was the
best in its class. This means it can
run day-to-day applications such as
office software and business appli-
cations better than the other PCs
in this category.

Conclusion
The PCs in this segment were not
as lacklustre as we’d expected
them to be—for example, like we
said, we never expected to see an
Athlon64 or a Pentium 4 with HT,
or for that matter 512 MB of RAM,
in a PC in this category. Essentially,
this points to the fact that good
PCs have gotten cheap.

The Compaq Presario SR1502IL
is priced the lowest at

Rs 17,990, and the SG1008IL—also
from Compaq—is priced at
Rs 19,990; Compaq is trying to
make headway into the value-cate-
gory market in a big way. The LG
XT1 retails at Rs 25,000, which is
too high for a PC with its specifi-
cations.

In the tests, the HCL PCs were
always ahead of the rest, with
their superior specifications,
features and package bundle. In
fact, they also bundled a 100-hour
internet package as well as games
and other software. The Datamini
was not far behind, though,
when we took overall points into
consideration.

The HCL EzeeBee PI 873 merits
special mention. It was the second-
best PC in this category, featuring
the powerful Athlon64 3000+
along with 512 MB of RAM. It was
amongst the favourites, and was
left behind only because of
marginally lower scores.

We decided that the HCL Ezee-
Bee 4381 would be the Digit Best
Buy Gold winner.

PCs ABOVE Rs 25K
The PCs in this, the second cate-
gory, had considerably more fire-
power than the Value PCs, and
came with better components; we
cannot, however, call them “high-
end” by any standards. Seven PCs
comprised this category: the Acer
Aspire SA80, Acer Aspire ASP
V4324, Compaq Presario
SR1630IL, Datamini Festiva MG,
Datamini Festiva MG Premium,
LG XD8-L92ARP1, and the Krypton
Voyager 9.

JANUARY 2006

HCL EzeeBee 4981

Krypton Voyager 9
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Scoreboard                             Value PCs

Low price
Low amount of RAM

Low price
Low amount of RAM

Great performance
None

Datamini Festiva MG Value Series
21.48

Intel Celeron D
2.7
IDE / 37 / 7200
CD-ROM
256 / DDR / 400
Intel GMA 900

Intel 915GL
LGA 775
PCIe x16
4 / 3.5
PS2, Wired Optical
CRT / 15
4
300
2 USB and Audio
4 / 2
10 / 100
3 / 3 / 3.5
2 / 2 / PCIe

None
None
None
6 / 4
Headphones
1
22.99

7472 / 3503
15544 / 18370

26 / 7
27 / 22
30 / 25
2731 / 2763

16.37 / 91

29.7 / 23.7
21.08 / 17.95
15.3
3075
3674 / 3291
870 / 3092
67
179

3 / 4
3 / 3 / 3.5
1.75 / 1.75
23,350
12.33
56.80

Compaq Presario SR1502IL
18.52

AMD Sempron 3000+
1.8
IDE / 40 / 5400
CD-ROM
128 / DDR / 400
SiS 330 Mirage

SiS 760GX
Socket 754
AGP 8x
6 / 2.5
PS2, Corded ball
CRT / 15
2
250
None
6 / None
10 / 100
2.5 / 3 / 3
2 / 3 / AGP 8x

FreeDOS
NIS 2005
HP utilities CD
6 / 4
None
1
16.61

8132 / 3739
17266 / 18613

39 / 8
43 / 32
43 / 33
2660 / 2674

16.84 / 452

Failed / Failed
Failed / Failed
Failed
2690
3314 / 3054
524 / 2414
66
183

3 / 3
2 / 2.5 / 2
1.5 / 1.5
17,990
16.00
51.13

Compaq Presario SG1008IL
18.52

Intel Pentium IV
2.4
IDE / 40 / 5400
CD-ROM
128 / DDR / 333
Intel Extreme Graphics

Intel 845GEV
Socket 478
None
6 / 3.5
PS2, Corded ball
CRT / 17
2
300
None
4 / 2
10 / 100
3.5 / 3 / 3.5
2 / 3 / None

FreeDOS
NIS 2005
HP Utilities CD
6 / 4
None
1
18.94

6408 / 3252
14980 / 18764

38 / 8
42 / 32
43 / 32
2220 / 2263

36.76 / 81

Failed / Failed
Failed / Failed
12.5
2605
3166 / 2649
555 / 2405
65
184

3 / 4
2.5 / 2.5 / 2
1.5 / 1.5
19,990
14.40
51.86

BRAND
Features
CPU 

Brand And Model
Clock Speed (GHz)

HDD Interface / Size (GB) / rpm
ODD Type
RAM Amount (MB) / Type / Speed (MHz)
Graphics Processor
Motherboard
Chipset
CPU Interface
PCIe / AGP Slot
Keyboard Shortcut Keys (Y/N) / Ergonomics (So5)
Mouse Interface, Technology
Monitor Type / Size (Diagonal Inches)
Number Of 5.25-inch Bays
SMPS Power Rating (W)
Front Connectors
Modem / Speakers Type
LAN Type
Quality Of Buttons: Keyboard / Mouse / Cabinet (So5)
Number Of Memory / PCI / Graphics Slots
Package Contents 
Operating System CD
Anti-Virus Package
Games / Educational Software / Other Software
Recovery / Driver CD
Miscellaneous (Headphones, Web cams, Gamepad, etc)
Number Of Years For Warranty
Performance
Sisoft Sandra 2005
CPU Dhrystones / Whetstones
CPU Multimedia Integer (iter per sec/FP iter per sec)
Hard Disk Drive
Drive Index (MBps) / Access Time (ms)
Sequential / Random Read (MBps)
Sequential / Random Write (MBps)
Memory ALU To RAM / FPU To RAM (MBps)
Nero CD-DVD Speed
Average Read Speed (x)/ Access Time (ms)
Gaming
Call of Duty 800 x 600 / 1024 x 768 (FPS)
FarCry 640 x 480 / 1024 x 768 (FPS)
Business Winstone 2004
PCMark04 Marks
CPU / Memory
Graphics / HDD
Audio Encoding (DBPowerAmp) (sec)
Video Encoding (Dr. Divx) (sec)
Monitor DisplaymateTest
Horizontal / Vertical Bar Resolution (So5)
Fine Focus / Fine Res. / Diagonal Res. Matrix (So5)
Speakers Special Audio / Movie Files Test (So5)
Price (Rupees)
Price Index
Overall Score (Out Of 100)
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Great performance
None

Powerful processor, 512 MB of RAM
Low on graphics

None in particular
Expensive

Powerful processor
Low amount of RAM

JANUARY 2006

HCL Ezeebee 4981
23.20

Intel Pentium IV
2.6
SATA / 80 / 7200
Combo
512 / DDR / 400
Intel GMA 900

Intel 915GL
LGA775
PCIe x16
4 / 2.5
PS2, Wired Optical
CRT / 17
2
250
2 USB and Audio
4 / 2
10 / 100
2.5 / 3 / 3
2 / 2 / PCIe and G.E.A.R.

RedHat Workstation
None
SuperVoice, 1000 Golden Games
6 / 4
None
1
27.99

7209 / 3379
18752 / 13307

49 / 7
55 / 40
55 / 39
3284 / 3287

31.99 / 94

45.8 / 38.5
29.91 / 26.39
20.7
3198
3657 / 3807
982 / 4244
65
172

3 / 4
3 / 3 / 2.5
2.5 / 2.5
24,990
11.52
62.71

HCL Ezeebee PI 873
22.64

AMD Athlon64 3000+
2.0
SATA / 74 / 7200
Combo
512 / DDR / 400
VIA / S3 Unichrome Pro

VIA K8M800
Socket 754
AGP 8x
4/2.5
PS2, Wired Optical
CRT / 15
2
250
2 USB and Audio
4 / 2
10 / 100
2.5 / 3 / 3
2 / 3 / AGP

RedHat Workstation
None
1000 golden games
6 / 4
None
1
23.11

8924 / 4108
19042 / 20499

52 / 6
58 / 43
58 / 42
2527 / 2528

32.09 / 89

Failed / Failed
30.43 / 37.58
24.1
2968
3687 / 3175
606 / 4520
58
169

3 / 4
2 / 2.5 / 2
2.5 / 2.5
21,990
13.09
58.84

LG XT1-VH1SHP1
19.68

Intel Celeron D
2.4
IDE / 40 / 5400
CD-ROM
128 / DDR / 333
Intel Extreme Graphics

Intel 845GV
Socket 478
None
6 / 3.5
PS2, Wired Ball
CRT / 15
2
250
2 USB and Audio
6 / 2
10 / 100
3.5 / 3.5 / 3.5
2 / 3 / None

Linux
None
Norton Internet Security 2004
6 / 4
None
1
16.26

6537 / 3062
13569 / 16033

42 / 9
48 / 34
47 / 33
Failed / Failed

20.46 / 85

Failed / Failed
Failed / Failed
11.5
2539
3131 / 2561
551 / 2529
78
214

3 / 3
1.5 / 1.5 / 1.5
1.5 / 1.5
25,000
11.51
47.46

Zenith Premium 7D
19.12

Intel Pentium IV with HT
3.0
IDE / 37 / 5400
CD-ROM
128 / DDR / 400
Intel GMA 900

Intel 915GL
LGA 775
None
4 / 3
PS2, Wired Optical
CRT / 15
2
250
None
6 / None
10 / 100
3 / 2.5 / 3
4 / 2 / None

None
None
None
6 / 4
2 SATA Cables
1
20.35

8767 / 6312
21572 / 28584

52 / 6
58 / 42
57 / 42
Failed / Failed

14.48 / 87

Failed / Failed
Failed / Failed
12.9
3773
4568 / 3601
760 / 3504
60
154

3 / 3
2 / 2 / 2.5
0 / 0
23,000
12.51
51.99
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Features
Almost all the PCs here featured
the Intel Pentium IV processor, but
only the Datamini Festiva MG
Premium sported the even more
powerful Pentium IV with Hyper-
Threading Technology—this puts it
in a league of its own. The Acer
Aspire ASP V4324 sported the AMD
Athlon64 3200+, and the Krypton
had a 3500+, both of which are
very powerful processors.

The Datamini Festiva MG
came with a CD-RW drive, and the
Krypton was the lone PC with a
DVD-Writer. All the others came
with Combo drives. This is unfor-
tunate, because the prices of DVD-
Writers have plummeted to a level
where you can get one in lieu of a
Combo drive for just a few
hundred rupees extra.

SATA hard drives were
common in this category; the
exception was the Acer Aspire
SA80, which featured a slower IDE
hard drive. Hard drive capacities in
this category didn’t see much vari-
ation; they were all either 74 or 80
GB. All the PCs had 256 MB of
RAM—except for the Krypton with
512 MB—which can be considered
just about OK for this price range.
The funny thing is, the HCL PCs in
the value category came with a
healthy 512 MB of RAM, and we
were left wondering why none of
the manufacturers except Krypton
could provide the same in this, the
more expensive category.

The Acer ASP V4324 was the

lone PC with a GeForce4 MX 440
64 MB AGP graphics card. The
others were content with onboard
graphics solutions, which
included the nVidia 6100, Intel
GMA 900 and the SiS 330 Mirage. 

PCs with the Intel GMA 900
and nVidia 6100 have the advan-
tage of being Vista-ready, because
of DirectX 9 compliance. The
nVidia 6100 is also the only
onboard graphics chipset that
supports Shader Model 3.0. With
the exception of the Compaq
Presario SR1630IL, all the PCs at
least provided an option to
upgrade the graphics subsystem
with the addition of an AGP or a
PCIe graphics card.

The displays in this category
were either LCDs or 17-inch CRT
monitors. The Acer SA80 came
with a 15-inch LCD, and the Data-
mini Festiva MG Premium came
with a 15.4-inch widescreen LCD.

Most of the cabinets we saw
were Micro ATX, with the excep-

tion of the two Datamini PCs,
which came with ATX cabinets—
thus providing four 5.25 inch bays
for upgrades. The build quality of
these cabinets, unfortunately, was
sub-par. Air ventilation seems to
have been taken into account in
the design of all the cabinets, with
the exception of the Krypton and
the LG XD8—whose cabinets were
too sleek to allow for good venti-
lation. The Krypton cabinet
featured an eye-catching multi-
coloured LED.

With the exception of the
Compaq PC, all the cabinets had
the USB and audio connectors on
the front, enabling easier accessi-
bility. The Acer Aspire SA80 went
one step further, integrating a
multi-card reader capable of read-
ing SM/XD, SD/MMC, CF and
MS/MS Pro cards. This feature is
useful for those who own digital
cameras or any other device that
uses removable Flash cards, such
as mobile phones and PDAs.

The Acer Aspire SA80 came
with a wonderful package consist-
ing of 11 CDs and DVDs: there were
movies, encyclopaedias, utility
software, and more. Sadly, there
were no speakers bundled; Acer
seems to have thought the speak-
ers on the LCD display would do.

Most of the PCs here came
with FreeDOS or with no OS at
all. The exception was the Acer
Aspire SA80 and the LG XD8,
which had Linux installed. The
Datamini Festiva MG Premium
came with 5.1 speakers. The Acer
Aspire ASP V4324 came with
Creative 2.1 speakers and a force-
feedback gamepad.

Performance
The Krypton Voyager 9, with its
AMD Athlon64 3500+, was the top
scorer, with the highest points in
the CPU test module of SiSoft
Sandra. In the real world, this
means that the V4324’s 64-bit
processor can rip through complex
computations faster than can
other processors in this category.

In terms of memory module
configuration, the manufacturers
have done customers a disservice:
for better memory bandwidth, a
dual-channel configuration is reco-
mmended, with a pair of matching
modules in the memory slots. All
the manufacturers except Krypton
left one of the two memory slots
free, and if you want to upgrade to
dual-channel, you’ll have to
procure a matching memory
module from the manufacturer.

DDR RAM: Double Data Rate RAM is a type of
memory that handles data at twice the speed
of the old SDRAM. DDR RAM typically operates
at 266 MHz, 333 MHz and 400 MHz effective
speeds, while the actual speeds are 133, 166
and 200 MHz respectively.
DDR2 RAM: Double Data Rate 2 RAM is a
memory type based on chips designed to run
at speeds higher than that of DDR RAM, such
as 533 MHz and 667 MHz. Very few
motherboards right now support DDR2 RAM.
Dual-channel: When two RAM modules are
plugged into two slots marked for two different
memory channels, then theoretically, the data
flows at twice the normal rate through the
RAM. This is known as dual-channel memory
configuration.
IDE: IDE stands for Integrated Drive
Electronics, and is a standard interface for
hard drives, optical drives and other physical
storage devices. It is also known as ATA, which
stands for Advanced Technology Attachment,
or Parallel ATA. The various types are ATA33,
ATA66, ATA100 and ATA133, based on the

transfer speed. It uses a 40-pin connector
cable that may consist of 40 or 80 conductors.
PCI: Peripheral Component Interconnect is a
standard used on all current-generation
motherboards and expansion cards used to
connect two devices. The data transfer rate of
a PCI bus can be up to 133 MBps.
PCIe: Peripheral Component Interconnect
Express is a new PCI standard that transfers
data at speeds equivalent to AGP 16x, which is
roughly 4.3 GBps.
SATA: Also abbreviated as S-ATA, short for
Serial ATA, is an interface for physical storage
devices such as hard drives. It is a serial link
and consists of a single cable with a minimum
of four wires creating a point-to-point
connection between devices. The transfer rates
for SATA begin at 150 MBps; for SATA II, this
figure is 300 MBps.
Time-shifting: Time-shifting is a feature of
PVR software that allows you to pause, replay
or skip a portion of a live TV programme. With
the time-shift feature, you have total control
over how you watch television.

Jargon Buster

Compaq Presario SR1630IL
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Since all the memory
modules were in single-channel
configuration, scores in the
memory benchmarks were
expectedly low—with the Acer
Aspire SA80 scoring the lowest.

The DVD-RW drive on the
Krypton was the fastest in this
category, but the others weren’t
too bad.

In the gaming benchmarks—
Call of Duty and FarCry—the Kryp-
ton Voyager 9, with the nVidia
6100, emerged the fastest, outper-
forming all the other graphics
solutions and giving amazing
frame rates. The Acer ASP V4324
with the GeForce4 MX 440 was
second-best.

The Acer ASP V4324 and the
Krypton were the fastest in our
audio encoding test, and the
Krypton was the fastest at video
encoding. The Datamini Festiva
MG Premium also exhibited top-
notch performance in PCMark04,
proving it had a well oiled sub-
system. We therefore expected it
to be the PC with the best overall
performance. The Krypton scored
26.6 in Business Winstone 2004,
which was the highest, and
which means it’s better suited
than the others for office and
business applications.

As we expected, the Creative
2.1 speakers, known for their
better acoustics, produced great
sound. But the 5.1 speakers
accompanying the Datamini
Festiva MG Premium sounded
even better, and seemed to
provide a more immersive
experience.

Conclusion
The choice of better-quality
components is one of the reasons
for the markedly better perform-
ance (and somewhat higher
prices) of the PCs in this segment,
as compared to those in the Value
segment.

The LG XD8 was the most
expensive, being unreasonably
priced at Rs 40,000. The Krypton
Voyager 9 was the last PC we’d
received for the test, and had we
received it a few hours later, it
might not have made it to the
tests at all. Frankly, we’d expected
an ordinary PC from Krypton, but
we found a surprise package: this
PC, powered by the Athlon64
3500+ and with 512 MB of RAM
and a DVD-RW drive, was the best
performing PC in this category.
Had it been priced a bit lower, it
would surely have won Gold.

The Acer Aspire ASP V4324 at
Rs 25,999 was the least expensive
of the lot, while also being a good
performer! Features, too, were top-
notch; we therefore adjudge it,
without reservation, the winner
of the Digit Best Buy Gold in this
category. 

MEDIA CENTER PCS
You can do regular tasks on a
Media Center PC (MCPC), but
that’s not what you’d be buying
one for! A MCPC is meant to be the
media hub of your living room,
enabling you to listen to music,
watch movies, pause live TV and
replay it—and also get some work
done! For all this, you’ll need good
horsepower, which, unfortu-
nately, some MCPCs lack. But
MCPCs have been in the market
for quite some time now, and
since we’re comparing home PCs,
we decided we had to include
these in our comparison.

This segment was relatively
unpopulated, with only four PCs
qualifying as MCPCs. Remember
that you’ll only see branded PCs in
the MCPC segment, since the
components are chosen carefully
to work in tandem with the OS.
Assembling a PC to make it qualify
as an MCPC would be impossible,
because not all components
conforming to the Windows XP
Media Center Edition standard are
available off-the-shelf—nor is the
OS itself. This fact—that the hard-
ware is so niche—also makes
Media Center PCs much costlier
than their home desktop
counterparts.

We should mention here that
the HCL PC, strictly speaking,
didn’t conform to the Windows
XP Media Center Edition standard.
It didn’t come with a  TV-Tuner at
all. The Acer, too, didn’t ship with
one, but they did send it in as an
“optional component.”

Some of the old brands are
here, and one new entrant in

Acer ASP V4324

JANUARY 2006
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Scoreboard                             PCs Above Rs 25K

Great performance and price
None

Great package bundle, LCD 
Low on graphics

Reasonably priced
None

Acer Aspire SA80
24.76

Intel Pentium IV
3.0
IDE / 74 / 7200
Combo
256 / DDR / 400
SiS 330 Mirage

SiS 661GX
LGA 775
AGP 8x
4 / 2.5
USB, Corded Optical
LCD / 15
2
250
2 USB and Audio, SM / XD, SD / MMC,
CF, MS / MS Pro
4 / None
10 / 100
2.5 / 3.5 / 3
2 / 3 / AGP 8x

Linpus Linux
Norton AntiVirus 2005
11 CDs / DVDs, NTI CDMaker Pro,
PowerDVD, SunJVM, AspireTV
6 / 4
None
1
25.48

8302 / 3889
17262 / 20397

51 / 6
57 / 43
56 / 43
1376 / 1378

33.23 / 95

21.1 / 13.1
17.44 / 9.76
20.6
3165
3976 / 2288
821 / 4472
59
172

4 / 4
4 / 4 / 3.75
1.5 / 1.5
33,999
9.18
59.41

Acer Aspire ASP V4324
22.64

AMD Athlon64 3200+
2.2
IDE / 74 / 7200
Combo 
256 / DDR / 400
nVidia GeForce4 MX 440

VIA K8M800
Socket 754
AGP 8x
4 / 2.5
USB, Wired Optical
CRT / 17
2
250
2 USB and Audio

4 / 2.1
10 / 100
2.5 / 3.5 / 3
2/3/AGP 8x

None
None
None

4 / 6
Force Feedback Gamepad
1
30.28

9815 / 4507
20934 / 22536

51 / 6
57 / 42
57 / 42
2761 / 2763

33.16 / 96

47.1 / 36.1
53.28 / 30.71
22.6
3585
4056 / 3460
1114 / 3935
52
157

3 / 4
3 / 3 / 4
3.5 / 3.5
25,999
12.00
64.92

BRAND
Features
CPU 

Brand And Model
Clock Speed (GHz)

HDD Interface / Size (GB) / RPM
ODD Type
RAM Amount (MB) / Type / Speed (MHz)
Graphics Processor
Motherboard
Chipset
CPU Interface
PCIe / AGP slot
Keyboard Shortcut Keys (Y/N) / Ergonomics (So5)
Mouse Interface, Technology
Monitor Type / Size (Diagonal Inches)
No. of 5.25-inch bays
SMPS Power rating (W)
Front Connectors

Modem / Speakers Type
LAN Type
Quality of Buttons: Keyboard / Mouse / Cabinet (So5)
Number of Memory / PCI / Graphics slots
Package Contents 
Operating System CD
Anti-Virus package
Games / Educational Software / Other Software

Recovery / Driver CD
Miscellaneous (Headphones, Web cams, Gamepad, etc.)
Number Of Years For Warranty
Performance
Sisoft Sandra 2005
CPU Dhrystones / Whetstones
CPU Multimedia Integer (iter per sec / FP iter per sec)
Hard Disk Drive
Drive Index (MB/s) / Access Time (ms)
Sequential / Random Read (MBps)
Sequential / Random Write (MBps)
Memory ALU To RAM / FPU To RAM (MBps)
Nero CD-DVD Speed
Average Read Speed (x) / Access time (ms)
Gaming
Call of Duty 800 x 600 / 1024 x 768 (fps)
Far Cry 640 x 480 / 1024 x 768 (fps)
Business Winstone 2004
PCMark04 Marks
CPU / Memory
Graphics / HDD
Audio Encoding (DBPowerAmp) (sec)
Video Encoding (Dr.Divx) (sec)
Monitor Displaymate Test
Horizontal / Vertical Bar Resolution (So5)
Fine Focus / Fine Res. / Diagonal Res. Matrix (So5)
Speakers Special Audio / Movie Files Test (So5)
Price (Rupees)
Price Index
Overall Score (Out Of 100)

Compaq Presario SR1630IL
21.80

Intel Pentium IV
3.0
SATA / 74 / 7200
Combo
256 / DDR2 / 400
Intel GMA 900

Intel 915GV
LGA 775
None
4 / 3
PS2, Corded Optical
CRT / 17
3
250
None

4 / 2
10 / 100
3.25 / 3.25 / 3
2 / 3 / None

FreeDOS
NIS 2005
HP Utilities CD

6 / 4
None
1
27.78

8315 / 3894
17282 / 20426

53 / 6
59 / 43
59 / 44
2658 / 2659

37.02 / 86

36.4 / 32.1
29.15 / 24.24
20.6
3482
4110 / 3401
914 / 4577
57
157

3 / 4
2.5 / 3 / 3.5
1.5 / 1.5
29,990
10.40
59.98
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None in particular
Lacklustre package bundle

Good performance
Expensive

Great performance
None

None in particular
Expensive

Datamini Festiva MG
22.12

Intel Pentium IV
2.6
SATA / 74 / 7200
CD-RW
256 / DDR / 400
Intel GMA 900

Intel 915GL
LGA 775
PCIe x16
4 / 3.5
PS2, Wired Optical
CRT / 17
4
300
2 USB and Audio

4 / 2
10 / 100
3 / 3 / 3.5
2 / 2 / PCIe

None
None
Nero Burning ROM 6, CyberLink
PowerDVD
6 / 4
Headphones
1
26.30

7449 / 3506
15472 / 18374

51 / 6
57 / 42
56 / 43
2768 / 2771

30.1 / 98

35.6 / 31.6
24.35 / 21.89
19.4
3218
3748 / 3382
926 / 4317
64
172

3 / 4
3 / 3 / 3.5
1.75 / 1.75
31,700
9.84
58.26

Datamini Festiva MG Premium
23.04

Intel Pentium IV with HT
3.0
SATA / 74 / 7200
Combo
256 / DDR / 333
Intel GMA 900

Intel 915GL
LGA 775
PCIe x16
4 / 3.5
PS2, Wired Optical
LCD / 15.4 Wide
4
300
2 USB and Audio

4 / 5.1
10 / 100
3 / 3 / 3.5
2 / 2 / PCIe

None
None
Nero Burning ROM 6, CyberLink
PowerDVD
6 / 4
None
1
29.45

8969 / 6511
22092 / 29303

51 / 6
57 / 42
57 / 43
2317 / 2318

31.51 / 98

37.2 / 31
28.93 / 23.84
20.7
3945
4699 / 3272
920 / 4134
58
150

4 / 4
3 / 3 / 3.5
3.75 / 3.75
35,850
8.70
61.19

LG XD8-L92ARP1
21.68

Intel Pentium IV
3.0
SATA / 80 / 7200
Combo
256 / DDR / 333
Intel GMA 900

Intel 910GL
LGA 775
AGR (Accelerated Graphics Riser)
4 / 2.5
PS2, Wired optical
CRT / 17
2
220
2 USB and Audio

6 / 2
10 / 100
3 / 3.5 / 2.5
2 / 2 / AGR

Osioux Linux 1.0
None
Nero Burning ROM 6, CyberLink
PowerDVD
6 / 4
None
1
25.70

8295 / 3888
17237 / 20372

49 / 6
55 / 41
54 / 39
2095 / 2093

33.22 / 96

35.9 / 26.9
26.16 / 21.45
19.4
3344
4073 / 2944
838 / 4424
58
165

3 / 3
2.5 / 2.5 / 2
1.5 / 1.5
40,000
7.80
55.18

Krypton Voyager 9
21.80

AMD Athlon64 3500+
2.2
SATA / 74 / 7200
DVD-RW
512 / DDR / 400
nVidia GeForce 6100

nVidia C51G
Socket 939
PCIe x16
4 / 3
PS2, Wired optical
CRT / 17
0
200
2 USB and Audio

4 / None
10 / 100
3 / 3 / 3
4 / 2 / PCIe

None
None
Nero Burning ROM 6, CyberLink
PowerDVD
6 / 4
None
1
32.66

9864 / 4493
20685 / 22569

53 / 6
59 / 43
59 / 43
4365 / 4373

37.67 / 102

78.8 / 53.2
86.85 / 47.87
26.6
3721
4103 / 4390
1528 / 4187
52
148

3.5 / 4
3 / 3 / 3
0 / 0
33,800
9.23
63.69



this segment is Sahara. The PCs
featured here are the Acer Aspire
E500, HCL Beanstalk 4958, HP
Pavilion m7280in, and the
Sahara R3.

Features
As we mentioned earlier, the choic-
est components went into the
making of these Media Center PCs.
The core component of a Media
Center PC is the TV-Tuner card—
but there was none in the Acer and
HCL PCs! We asked the companies
for the TV-Tuners. Acer was quick
to respond by sending us the TV-
Tuner. Although the Sahara R3
came with a TV-Tuner and a
remote, they forgot to send an IR
receiver, so the remote turned out
to be of no use!

The HP Pavilion m7280in
came with a Conexant CX23416
TV-Tuner, as did the Acer Aspire
E500. The Sahara R3 featured an
even more exotic ATi Rio 550 TV-
Tuner. All these feature hardware
MPEG encoders that offload the
CPU and take it upon themselves
to encode video to MPEG during
video capture.

The functions of an MCPC call
for high CPU power, and all these
did come equipped with high-end

CPUs. The first three were
powered by the Intel Pentium 4
with HyperThreading Technology,
while the Sahara R3 was powered
by the AMD Athlon64 3500+, the
most powerful processor in this
test—which was also featured on
the Krypton Voyager 9 in the
previous category.

We witnessed many firsts in
this category. For the first time in
this entire shootout, we saw a
SATA II drive—with the Acer E500.
The HP m7280in had a 160 GB
hard drive, which means ample
space for capturing content and
also for other functions such as
time-shift.

Also, for the first, we saw a
PC come with a LightScribe DVD-
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Almost every computer shipped these
days has Windows XP installed as the

default operating system. Windows XP has
several different editions—five, to be
precise. These are Windows XP
Professional, Windows XP Home Edition,
Windows XP Tablet Edition, Windows XP
x64 and Windows XP Media Center
Edition 2005.

Of these, Windows XP Media Center
Edition 2005 is the one that most people
generally do not know much about. Here's a
brief explanation of what's in Media Center
Edition 2005.

What needs to come across at the
outset is that Windows XP Media Center
Edition 2005 is heavily oriented towards
the multimedia or entertainment aspect
of using a PC. Media Center PCs aim to be
the entertainment hub of a digital home,
and Windows XP MCE aims to enable just
that. The pretty interface is extremely
user-friendly, and lets you do stuff at the
touch of a button. And beneath this
cool surface runs a robust and well-
oiled NT kernel.

Networking support is very good in
Windows XP MCE, as with Windows XP Pro.
However, there's some stuff available in
Windows XP MCE that is not available in the
regular Windows XP:

DVD Recording: Windows XP MCE allows you
to record DVDs in a format that is compatible
with consumer DVD Players.

TV-Functionality: MCE supports dual TV-
Tuners, which means you can record
programmes using one tuner while watching
TV using the other. This includes both cable
and satellite transmissions.

Media Center Extenders: These are
networking devices that let you connect your
Media Center box to other devices, such as a
display, over a wired or wireless network.
This gives you with the ability to do things
like watch HDTV even if your MCPC is in
another room.

My Videos: This offers an alternate view of
your 'My Videos' folder in Windows XP,
organising files and folders by date or by
name, and displaying a thumbnail image for
each clip. My Videos supports common
video types including standard .avi, .mpg,
and .wmv files.

The Remote Control: This piece of hardware
is standard with Windows XP MCE. You can
do just about everything on MCPC using the
remote without once having to get up from
your couch.

What’s So Special About Windows Media Center Edition 2005?

HCL Beanstalk 4958

Scoreboard                             
BRAND
Features
CPU 

Brand And Model
Clock Speed (GHz)

HDD Interface / Size (GB) / rpm
ODD Type
RAM Amount (MB) / Type / Speed (MHz)
Graphics Processor
Motherboard
Chipset
CPU Interface
PCIe / AGP slot
Keyboard Shortcut Keys (Y/N) / Ergonomics (So5)
Mouse Interface, Technology
Monitor Type / Size (Diagonal Inches)
Number of 5.25-inch bays
SMPS Power rating (W)
Front Connectors

Modem/Speakers Type
LAN Type
Quality of Buttons: Keyboard / Mouse / Cabinet (So5)
Number of Memory / PCI / Graphics slots
Package Contents 
Operating System CD
Anti-Virus Package
Games / Educational Software / Other Software

Recovery / Driver CD
Miscellaneous (Headphones, Web cams, Gamepad, etc.)

Number Of Years Of Warranty
Performance
SiSoft Sandra 2005
CPU Dhrystones / Whetstones
CPU Multimedia (integer iter per sec / FP iter per sec)
Hard Disk Drive
Drive Index (MBps) / Access Time (ms)
Sequential / Random Read (MBps)
Sequential / Random Write (MBps)
Memory ALU to RAM / FPU to RAM (MBps)
Nero CD-DVD Speed
Average Read Speed (x) / Access Time (ms)
Gaming
Call of Duty 800 x 600 / 1024 x 768 (fps)
Far Cry 640 x 480 / 1024 x 768 (fps)
Business Winstone 2004
PCMark04 Marks
CPU / Memory
Graphics / HDD
Audio Encoding (DBPowerAmp) (sec)
Video Encoding (Dr. Divx) (sec)
Monitor DisplayMate Test
Horizontal / Vertical Bar Resolution (So5)
Fine Focus / Fine Res. / Diagonal Res. Matrix (So5)
Speakers Special Audio / Movie Files Test (So5)
Price (Rupees)
Price Index
Overall Score (Out Of 100)
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Media Center PCs

Gigabit LAN
Low memory and hard drive capacity

Good package bundle 
No bundled TV-Tuner

Great performance and package
Expensive

Reasonably low price; 17-inch LCD
None

JANUARY 2006

HCL Beanstalk 4958
28.35

Intel Pentium IV With HT
3.0
SATA / 80 / 7200
DVD-RW
512 / DDR2 / 400
Intel GMA 900

Intel 915G
LGA 775
PCIe x16
4 / 3.5
USB, Wireless Optical
LCD / 15
2
300
None

4 / 2.1
10 / 100
3.5 / 2 / 3
4 / 2 / PCIe

Windows XP MCE 2005
Unistal-Kaspersky
Many Microsoft Games and 1000
Golden Games CD pack
4 / 4
Remote Control, Headphones, 128 MB
USB Drive
1
31.14

8787 / 6366
21563 / 28574

47 / 7
53 / 38
53 / 37
4630 / 4658

28.91 / 108

50.4 / 41.6
34.33 / 30.1
21.1
3745
4661 / 4640
1091 / 4437
57
145

4 / 4
4.5 / 3.5 / 3.5
3.5 / 3.5
48,990
7.51
67.00

Acer Aspire E500
28.82

Intel Pentium IV With HT
3.0
SATA II / 80 / 7200
Combo
256 / DDR2 / 400
ATi Radeon Xpress 200

ATi Radeon Xpress 200
LGA 775
PCIe x16
4 / 2.5
USB, Corded Optical
LCD / 15
2
300
2 USB, Audio, FireWire, Multi-card
Reader

4 / None
Gigabit
3.25 / 3.5 / 2.5
2 / 2 / PCIe

Windows XP MCE 2005
Norton AntiVirus 2005
NTI CD / DVD Maker 7

4 / 4
Remote Control, Conexant
TV-Tuner
1
28.10

9012 / 6525
21120 / 28342

51 / 6
57 / 42
57 / 43
2325 / 2324

32.12 / 97

28.4 / 22.5
44.21 / 28.12
21.5
3825
4701 / 2245
945 / 4012
58
151

4 / 4
3.25 / 3.25 / 3.25
1.5 / 1.5
45,999
8.00
64.92

Sahara R3
29.48

AMD Athlon64 3500+
2.2
SATA / 80 / 7200
DVD-RW
512 / DDR / 400
ATi Radeon Xpress 200

ATi Radeon Xpress 200
Socket 939
PCIe x16
4 / 3.5
PS2, Corded Optical
LCD / 17
2
300
2 USB and Audio

4 / 2
10 / 100
3.5 / 3.5 / 3
4 / 3 / PCIe

Windows XP MCE 2005
None
Nero Burning ROM 6, CyberLink Suite,
TUL i-TV
4 / 4
Remote Control, ATi Rio 550 TV-Tuner

1
28.31

9816 / 4478
20869 / 22460

43 / 9
56 / 37
23 / 23
2710 / 2714

37.37 / 106

29.2 / 23.2
45.82 / 30
24.1
3543
4063 / 3340
1040 / 3663
53
156

4 / 4
4.5 / 4.5 / 3.5
2.5 / 2.5
51,519
7.14
64.93

HP Pavilion Media Center PC m7280in
21.40

Intel Pentium IV With HT
3.2
SATA / 160 / 7200
LightScribe DVD Writer
512 / DDR2 / 400
ATI Radeon X300 SE

Intel 915P
LGA 775
PCIe x16
4 / 3.5
USB, Wireless Optical
LCD / 15
2
300
2 USB, Audio In/Out, FireWire, S-Video
And Composite In, Personal Media Drive
Bay For USB 2.0, Multi-Card Reader
4 / 2.1
10 / 100
4 / 3.5 / 4
4 / 3 / PCIe

Windows XP MCE 2005
Norton Internet Security 2005
Encyclopaedia Britannica 2005 DVD,
Sonic MyDVD Plus, MS Works, WinDVD
4 / 4
Remote Control, Conexant TV-Tuner,
3 LightScribe CDs
3
34.10

9351 / 6675
22987 / 30467

49 / 6
54 / 40
54 / 40
4942 / 4941

32.09 / 114

64.6 / 47.5
102.77 / 48.83
23.6
4436
4957 / 4960
1418 / 4810
57
131

4 / 4
4 / 4 / 3.5
2.5 / 2.5
64,990
5.66
71.13
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RW drive—this was with the
HP m7280in. A LightScribe drive
can burn labels onto compatible
media: you burn a CD/DVD, then
flip it and burn the label! Also, the
HP and HCL PCs came with wire-
less keyboards and mice.

The HP came with an ATi X300
SE with 128 MB of DDR RAM,
which allows you to enjoy a fair
amount of gaming. The Sahara R3
featured the ATi Radeon Xpress
200 graphics chip, which happens
to be DirectX 9 compliant. These
two MCPCs also featured TV-Out.

The Acer and HP featured
multi-card readers on the front, in
addition to the USB and audio
connectors. The Acer needs the
front USB ports since it has only
two USB ports at the back, and
these are used up by the mouse
and keyboard.

The HP cabinet was unique: it
had front connectors for S-Video
and Composite In, and a remov-
able drive bay to plug in an exter-
nal hard drive. On the top was a
small compartment for storing
optical media.

The Acer E500 decided to do
away with the stock heat sink of
the Pentium 4, and came with a
custom heat sink-fan assembly, in
which the fan blows hot air side-
ways, directed towards the rear
exhaust grille of the cabinet.

Being Media Center PCs, all the
four came with remotes. The
remote that came with the Sahara
R3 was the sleekest, though it
featured fewer function keys.

The HCL Beanstalk came with a
decent speaker set—a 2.1 set from
Altec Lansing. It came with a good
software bundle, consisting of four
Microsoft games and a 1,000-game
CD pack. 

Performance
The Sahara R3, equipped with the
most powerful processor in this
test (the Athlon64 3500+), scored
very high in SiSoft Sandra’s CPU
arithmetic test. The other PCs
scored better in the multimedia
benchmark.

The HCL and HP PCs featured
memory in dual-channel
configuration, which boosted
their memory bandwidth to
almost double the regular band-
width. This reflected in the
memory benchmarks. Demand-
ing applications such as video
capture and gaming can benefit
from this.

Armed with the ATi Radeon
X300 SE, the HP scored the highest
in the gaming tests, leaving the
others behind by a huge margin.

The HP m7280in will therefore
afford a good level of gaming.

PCMark04 again saw the HP
m7280in score the best, proving
that it is capable of good overall
performance. In the Business
Winstone 2004 benchmark, the
Sahara R3 and the HP m7280in
were neck and neck, posting
equally good scores. These PCs
are therefore not just for multi-
media applications—they handle
office and business applications
just as well.

In the LCD display tests, the
Sahara R3 scored very high in
the sharpness and focus depart-
ments, but we must mention
that the quality of the LCD on
the Sahara R3 is not too good: it
shows a colour tinge when
viewed at a vertical angle, which
wasn’t the case with the others. 

When it came to speaker
quality, the Acer with its
Altec Lansing speakers won
hands down.

Conclusion
There were only four contenders in
this category, and this was no
major shootout. But these MCPCs
did sport better features than the
PCs in the earlier categories.

The main contributing factors
towards the cost of these PCs are
the operating system and compo-

nents such as TV-Tuners with
hardware MPEG encoders. The

HP m7280in is priced at Rs 64,990,
which makes it the most expensive
PC in this entire test; the Acer E500
at Rs 45,999 is the lowest-priced in
the MCPC category.

The HCL Beanstalk 4958
emerged the second-best, despite
it not having come with a TV-
Tuner card. It scored well
in the gaming tests, and also exhib-
ited higher memory bandwidth
due to its dual-channel configura-
tion.

Taking into account the three-
year on-site warranty (unlike the
one year provided by the others),
and also the better features and
performance, we awarded the
Digit Best Buy Gold to the HP Pavil-
ion m7280in.

Summing It All Up
We were disappointed at the lack
of PCs targeted at gamers: most
manufacturers preferred onboard
graphics rather than an AGP or a
PCIe graphics card, which is an
absolute necessity for any decent
gaming capability. The exceptions
were the HP Media Center n7280in
and the Acer Aspire V4324, but
even these came only with entry-
level graphics cards. Similarly, we
felt that in the sub-25K category,
the manufacturers could have
easily provided CD-Writers rather
than CD-ROM drives.

The Media Center market is
still at a nascent stage in India,
and most PC users in this country
are only just waking up to the fact
that such PCs exist. They haven’t
gotten very popular so far because
of their high prices, which in turn
are largely due to the fact that the
XP Media Center Edition OS is
tightly integrated with such PCs,
and you cannot get the OS off-the-
shelf—even if the components are
available from abroad. This
picture is sure to have changed
when we test PCs the next time
round; prices of MCPCs are sure
to plummet. And, of course, we
expect the PCs that were priced
above Rs 25K to move into the sub-
25K bracket. 

jayesh_limaye@thinkdigit.com

HP Pavilion m7280in 
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Phone Web SiteCompany E-mailBrand

Contact Sheet Branded PCs

Acer
Compaq
Datamini
HCL
HP
Krypton
LG
Sahara
Zenith

Acer India (Pvt) Ltd
HP India Sales Pvt Ltd
GES Technologies Ltd
HCL Infosystems Ltd
HP India Sales Pvt Ltd
Priya Ltd
LG Electronics India Pvt Ltd
Sahara Computers and Electronics Ltd
Zenith Computers Ltd

080-25219520
0124-2566111
022-28290296
0120-2520977
0124-2566111
022-56663100
0120-2560900
0120-5397777
022-28377300

ailenquiries@acer.co.in 
incontact@hp.com
sayeed@ges.co.in 
wecare4u@hcl.in
incontact@hp.com
prom_bom@priyagroup.com
salvi@lgezbuy.com
info@saharacomputers.co.in
info@zenith-india.com

www.acer.co.in
www.hp.com
www.ges.co.in
www.hcl.in
www.hp.com
www.priyagroup.com
www.lgezbuy.com
www.saharacomputers.co.in
www.zenith-india.com
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Photos make for
great reminiscing
and viewing, don’t
they? I had been
on a well-deserved
breather. Once I
returned, I found I
had more than a
hundred images of
the glorious time I
spent. And that
meant sorting,
arranging and
popping them into
albums. This time,
I decided to see
how much of a
difference
technology would
make when it
came to creating
and sharing my
photo album.

I had to get the photos scanned. Taking advantage of
the office scanner, I copied them onto my PC. It was
fairly easy. After this, it was a matter of some
reorganising on my PC. This did take some effort
though.

Time taken: Almost an hour
Cost: Having used office equipment, nothing

My second task—of searching for an online photo
album—was truly delightful. There were many
options to choose from, but I finally settled on
Yahoo! Photos which I found relatively user-friendly.

Time taken: 20 minutes

All I had to do was upload the photos from my PC
onto the album. The online album also had a feature
wherein I could upload as many photos as I wanted
with a single click! I could post comments about the
pictures, and even invite others to do the same. Soon
I had the album created and arranged. 

Time taken: 10 minutes

Voila! My album was ready for viewing. I informed
friends and family via e-mail, and they could visit
the site at their convenience. This way, no-one
could complain about not being able to access
my pictures.

You can arrange your photos in an album... ... Or you can scan and upload them

1

2

3

4

Frankly, the old way is just not “the way” anymore. While it
did offer me the luxury of poring through the album, it took

a lot of time to fill in the photos. The album now lies among my
already huge collection of photo albums. I will also need to
preserve them, which is another task altogether. On the other

hand, uploading pictures online was quicker. It’s just the
scanning that took some time. But hey, they’re now online—for
posterity! Plus, I could also post notes along with my photos.
Having all my trip photographs online meant no repeated trips
to the cupboard. The Tech Way is a sure winner!

OLD
WAY

TECH
WAY

Total Time Taken: 3 hours, 35 minutes
Total Cost: Rs 150

Total Time Taken: 1 hour, 26 minutes
Total Cost: Rs 0 

And 
The

Winner
Is...

Jyotsna Rege (jyotsna_rege@thinkdigit.com)

Finally, they were all in. And did it feel good! I
finally had an answer to all the queries of “Are the
snaps out yet?” I could now say, “Yes, they are. And
no, I am not bringing them over. If you want to see
them, come on over.”

Organising A Photo Collection

I moved on to placing all the snaps inside the photo
album. Wait a minute! I realised I first needed an
album. I spent the better part of the morning
finding a suitable album.

Time taken: 2 hours
Cost: Rs 150 for the album

I collected my photos from the photo studio. At
home, when I tried to sort them, it sure wasn’t easy.
Did I take the boat ride first or the trek? Both were at
the same location. And so I went about trying to
arrange the pictures chronologically according to the
venues and activities.

Time taken: 35 minutes for 60-odd photos

Inserting photos in an album is faster when you
have some people helping you. In my case, it was
even better as the duo helping me were the ones
who took the same trip. Well, we took an hour to
complete the job, but the presence of friends helped
me relive the trip!

Time taken: 1 hour



Robert Sovereign-Smith 

How many times have you tried to play
a video file in Windows Media Player

and got a message that informs you of a
missing codec? Sometimes, even this
doesn’t happen, and the file refuses to
play, or just plays audio with no video, 
or vice-versa.

A codec (code-decode) is nothing more
than a set of instructions given to a
software media player so it can
understand the file it’s reading. If you try
and play a file that’s encoded and
compressed with a certain algorithm, you
need the same algorithm’s decoding
capabilities in your computer’s software
library. That’s why you need to have
codecs installed on your computer. 

The DVD Codec
Many users, despite having DVD-ROM
drives, don’t prepare their systems for
DVD movies. They don’t install all the
software that comes with their drives.

Software such as PowerDVD install
MPEG-2 codecs, thus enabling your
computer to play DVD movies. If the
MPEG-2 codec isn’t installed, you’re never
going to be able to play movie DVDs. This
can cause confusion: regular data DVDs,
such as the Digit DVD, will play fine. 

In order to make sure that you have an
MPEG-2 DVD codec installed, go to Start >
Run, type in “DVDUPGRD /DETECT”
(without the quotes) and press [Enter].
You should see something like the visual

shown
alongside. 

If there is a
codec
installed, then
you should try
and play the
DVD movie
with the
program that
installed it. If
there’s no
codec
installed, you
need to install

one. These codecs are installed along with
any software DVD movie player, such as
PowerDVD.

Other Video Codecs
Most of the movies you download from the
Net (legally or illegally) are compressed
DVD rips. Just as people started making
MP3s from audio CDs, people now make
AVI files from DVDs using a particular
codec for compression in file size. Some of
the more popular codecs are the DivX and
Xvid codecs, which are freely available. 

You’ll often find that the same movie
could be over 2 GB in size or just a few
hundred MB. This happens because of the
quality settings chosen when compressing
the original DVD movie.

Unfortunately, just as with DVD
movies, AVI files encoded and compressed
with a codec need the same codec to be
installed on your system.

Since there are hundreds of codecs
available, just relying on your media
player to figure out which one is needed,
really isn’t a good solution. Windows
Media Player, for instance, will often just
not identify the required codec properly,
and will try to connect to the Net and then
give you an error message. There are two
possible solutions for this problem:

1. You can install codec packs that
contain all the popular codecs used to
encode the majority of files on the Web.
These packs, such as Kazaa Lite Mega
Codec Pack, should solve almost all the

codec problems you may encounter with
your system. 

However, they also install a lot of
unnecessary codecs which you may never
use. For those who are paranoid about
keeping their registry as clean as ever,
manually choosing which codecs you want
while installing the pack is, perhaps, a
good way to go.

2. If you really want to get to the heart
of the matter and find out which file was
encoded with which codec, a third-party
tool such as GSpot Codec Information
Appliance will help you with all the
information you need. All you have to do
is go to www.headbands.com/gspot,
download the installer and install it. 

Now, if a file refuses to play, you can
run GSpot, choose to open the file and
press ‘Render’. GSpot will attempt to play
the file, and simultaneously match the
codecs used with its own database of
codecs. When a problem occurs, or some
codec does not work as it’s supposed to
(corrupt codec files), GSpot will tell you
exactly what the problem is.

Though there are a few problems with
audio streams in video files, these
generally get sorted out upon installing a
codec pack. The same principles as with
video codecs apply.

The lack of uniformity in compression
algorithms has brought us to a stage
where we have millions of video files
available on the Internet, but
unfortunately, too many different ways of
encoding them. We hope you’re now
better armed to deal with these problems
in the future.

robert_smith@thinkdigit.com

If you’ve ever wanted to pull your hair out when a DVD Movie refuses to play,
or a video you downloaded plays more like an MP3 than a video,

you have a tech nightmare on your hands. Here’s how you can fix it

Use “DVDUPGRD /DETECT”
to check for DVD decoders

Codec Headache

Just open a file in GSpot to see what codecs
were used to encode it

Use GSpot Codec information Appliance to
check whether your system has any problems
of missing codecs

DIGIT JANUARY 200674



Watch All You Want!

The Yes MMP8 is a portable DVD
player with a difference—it

features a slate form factor and is
disc-based. There is no internal
memory to store media. Measuring
22 x 15.3 x 2.6 cm and weighing
close to 700 grams without the
battery, the device is a bit bulky—
but makes up on features and
performance.

The MMP8 supports a variety of
media formats, from standard DVD,
VCD and MP3 to picture CD and even
MPEG4 and DivX. Yes, that’s right—you can also view DivX
movies burnt onto CD or DVD. CD-RW and DVD-RW discs
are also supported. Where performance is concerned, we
found no issues—the MMP8 played all the media formats
we tried out.

The glossy black front facia sports a decent-sized
7-inch screen. The controls are located on both sides as
well as on the top edge, and the optical drive can be
accessed from the rear. The included rechargeable lithium
battery pack affixes to the rear right.

Audio output is through an integrated speaker and
through the bundled earphones. A unique feature is the
availability of a USB port and a Flash card slot. The MMP8
can play supported media formats—including audio, video
and images—straight off any USB device such as USB
drives, digital cameras, MP3 players and digital

camcorders, and also off MMC, SD and Memory
sticks. You can also connect the player to your
TV and use the bundled wireless slim remote.

SPDIF digital output is also provided, so
you can enjoy 5.1 surround sound on an
existing external Dolby Digital or DTS
amplifier. Apart from a standard power
adaptor that powers the player and charges
the battery, you get a car charger for
when you take the device with you on a

road trip.
The player displays an

Explorer-like interface to
list the music and video

tracks on a disc. Menu
navigation is easy enough, and the remote

allows you to specify settings such as the TV system
(PAL/NTSC), TV type (4:3/16:9), password, and more.

The bundled 4200 mAh battery lasted about 3.5 hours
with DivX playback—enough for even a long movie. Apart
from being somewhat bulky and carrying a slightly high
price tag, this is a decent product to consider if you don’t
want to miss out on your entertainment on a vacation.

Company Thakral Computers Pvt Ltd

Price Rs 15,990

Phone 0 98101 38708

E-mail info@iloveyes.net

Web site www.iloveyes.net

Rating

Let’s Entertain!

The MSI MegaView 588 is a great personal entertainer. The
3.5-inch, wide view angle QVGA LCD provides vivid video

playback. It supports WMV, WMA, MPEG-4, DivX, WAV, MP3,
JPEG and GIF. MSI has also provided a transcoding utility to
convert videos into formats
playable on the player.

The device sports a 20 GB hard
disk, a recorder function that
allows you to record videos in
MPEG-4, a microphone to
record short memos, and an
FM tuner. It is also equipped
with USB 2.0 On-The-Go, and an
SD/MMC card reader.

The Li-Ion rechargeable battery lasted us 3.5
hours with video and six hours with audio playback.
The audio quality of the earphones is acceptable, and sound
from the inbuilt speaker is exceptionally clear.

Company Micro-Star International

Price Rs 24,500

Phone 011-51758808

Web site www.msi-india.com

Rating
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Sony VRD-VC20 DVDirect

Sony has recently introduced the world’s first hybrid
DVD recorder, capable of burning DVDs with or

without a PC—the Sony VRD-VC20 DVDirect. It works as
an external 16x DVD burner when connected to the PC,

and supports all the common formats.
The real advantage of the DVDirect is

that it connects to various video sources
such as VCRs, analogue and digital video
cameras.  DVDirect synchronises with a
connected DV Camcorder. Recording
and pausing can be controlled with the
camera buttons. Also, if your video
camera’s batteries die out, the recording
is paused and you can resume recording
after charging! There is no video output
on the device, and the video camera
needs to have a video display if you
want to monitor what you’re recording.

Company Rashi Peripherals Pvt Ltd

Price Rs 19,990

Phone 022-28221013

E-mail navinderc@rptechindia.com

Web site www.sony.com

Rating

1 2 3 4 5

1 2 3 4 5

MSI MegaView 588

1 2 3 4 5

Yes MMP8 Portable DVD Player 
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Asus W1S00

The Asus W1S00 laptop is the first laptop featuring a TV-
Tuner to have arrived at our Test Centre. Specifications

include an Intel Pentium M 1700 MHz processor, 512 MB of
RAM, a 60 GB hard drive, and a Combo drive. The vibrant
15.4-inch 16:9 wide screen has a WXGA+ resolution of 1680 x
1050 and good viewing angles. The 64 MB ATi Mobility
Radeon 9700 graphics card makes for a good gaming laptop.

Almost all the connections are on the left - USB 2.0, LAN,
phone jack, PCMCIA, FireWire, and the input
to the TV-Tuner. There’s also a multi-card
reader that reads SD/MMC/MS/MS Pro cards,
as well as Wi-Fi and IR. The remote control
is tucked inside the PCMCIA slot, where its
Li-Ion battery charges; it can be pulled out
when needed. The remote works with the

bundled Asus Mobile Theatre, a
media centre
application.
The sound system

consists of two speakers
and a subwoofer hidden on

the bottom surface. The bundled
earphones help realise the 4.1 sound mode, and the sound
quality is commendably good for a laptop. However, the
W1S00 is below par when it comes to office applications, and
battery life is a relatively low 85 minutes.

Company ASUS Tek Computer Inc.

Price Rs 1,25,000 + taxes 

Phone 022-56290787 

E-mail info_india@asus.com.tw 

Web site www.sus.com.tw

Rating

Play Away! 

Logitech’s G15 keyboard is targeted at gamers. It’s wider
than most other keyboards, and the wrist rest offers

good support. There are two USB ports on the front, and it
has a controllable blue backlight.

The G15 has 18 programmable keys, each of which have
three modes. The accompanying macro profiling
application lets you assign a particular
combination of keys to a single such
key. These keys can really help RTS
and MMORPG players. Recording
macros is simple, and Logitech
has provided profiles for
most new games. 

Of particular
interest is the new LCD
display, which isn’t just a
display—it’s a platform
Logitech is trying to push. If game
developers take to it, game statistics
such as ammo and life will be displayed
on the screen. For now, Logitech has included an LCD
clock, a performance monitor and a media display (for
WinAmp, iTunes and WMP info) for the LCD.

At Rs 5,000, this keyboard is worth the money if you’re
an avid MMORPG or RTS gamer.

Company Logitech Electronic India Pvt Ltd

Price Rs 4,995

Phone 022-26571160

E-mail response@logitech.com

Web site www.logitech.com

Rating

Logitech G15 Keyboard

Game for more?

Part of the gaming series from Logitech, the G5 is a
corded laser mouse sporting Logitech’s new colour

combination—a mixture of
brick-red, silver and smoke
black. The rugged feel and
rough texture makes for
perfect grip. The mouse is
designed to neatly fit into the
palm of a right-hander, with
a  nice groove on the left for
the thumb—but we do think
it may be a little too big for
those with smaller palms.

The G5 is very light, and
speaking of weight, it comes
with eight little weights—of 4.5
gm and 1.7 gm—which you can add
to a small removable tray at the base
to attain the right weight for your
gaming comfort!

Installing drivers for the mouse is not
essential, as almost all the buttons function
as they should even without driver installation.
If you install the drivers, a lot of features can be
controlled via the Logitech SetPoint utility that comes
with the drivers.

Apart from the usual buttons, the scroll wheel can also
be used as a button—you could, for instance, use the button
to enable page zooming, and then move the scroll up or

down to zoom in or out respectively. There’s also a button
just above the thumb groove—we wish there were two! Two

buttons would not only enhance Web site
navigation, but could also be configured for

various gaming actions.
The mouse sensitivity can be

increased or decreased on the fly
using two tiny buttons just below

the scroll. Higher sensitivity suits
fast FPS games such as Unreal

Tournament, and decreasing the
sensitivity while using a sniper will

bag more ‘head shots.’ The sensitivity
presets are 400 dpi, 800 dpi, and a max of

2,000 dpi. But using the SetPoint utility that the
driver installs, you can change the sensitivity
settings. You can add two user-defined
sensitivity levels in between 400 to 800 dpi and
800 to 2,000 dpi.

The G5 scores high for the level of
customisation it provides, but at the end of the
day, it is an expensive mouse.

Company Logitech Electronic India Pvt Ltd

Price Rs 4,450

Phone 022-26571160

E-mail response@logitech.com

Web site www.logitech.com

Rating

1 2 3 4 5
1 2 3 4 5

1 2 3 4 5

Logitech G5 Laser Mouse
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XFX XGear PC Wireless Controller

We managed to lay our hands on XFX’s
soon-to-be-launched XGear PC Wireless

controller, so we could give you a sneak preview!
This ergonomically designed wireless gadget fits the

hands perfectly, and the scratch-free rubber handles make
for easy grip. The controller feels nicely balanced in your
hands while playing—a welcome feature in those tricky
situations when you’re fighting to save your life. The RF
receiver plugs into a USB port, and the controller can be
used within a distance of 30 feet from your PC.

Two reflex motors in the controller
translate signals from games into

actual vibrations to simulate
impact. A switch at the bottom

lets you choose between low
and high intensity levels for
the vibrations.

A macro button on the
controller lets you assign

up to a 30-step button sequence to four
different buttons. This is useful when you want to

execute complex manoeuvres in strategy or third-
person shooter games with the help of a single

button press. Other special functions of the
controller include a turbo button for rapid firing, and
assignment of keyboard or mouse keys to the controller
using the driver.

The wireless controller uses 4 AA batteries, and goes into
sleep mode to conserve power when no key is pressed for five
minutes. This is a must-have accessory for serious gamers—
watch out for the launch!

Web site www.xfxforce.com

Multimedia To The Max!

The classy N70 is the latest phone from Nokia.
Weighing 126 grams, the N70 is no

featherweight; however, clever use of lines and
curves helps in masking the phone’s size. 

The 176 x 208, 262 K colour screen is
gorgeous and remains legible even in bright
outdoor settings. The large screen on the
N70, however, has limited the size of the
keypad, which was our biggest gripe with
this phone.

The N70 has an extensive list of
features that includes a 2-megapixel
camera for stills and video, a 0.3-
meagapixel camera for
videoconferencing, a music player
capable of playing most audio
formats, and FM radio. Audio
playback was great, and the FM
reception splendid. The camera
does a good job in most lighting
conditions; however, you’ll need to be
extra careful about camera shake with this phone.

The battery lasts around two and a half days with normal
use. Bundled with the phone are a 64 MB RS-MMC card and a
hands-free earpiece. The phone retails at Rs 27,919.

Company Nokia India Pvt ltd

Price Rs 27,919

Phone 0124-5199000 

E-mail natesh.bv@nokia.com 

Web site www.nokia.co.in

Rating

Nokia N70

1 2 3 4 5

The Fast And The Strong

The first ThinkPads to
feature widescreen LCDs,

the Z series from Lenovo
moves away from their strictly
business styling for notebooks.
The Z60t is a thin and light
model in the range, and weighs a
little less than 2 kg. Featuring a
14-inch widescreen LCD, the Z60t
comes with an option of covers—
black or titanium. The titanium
special-edition cover provides added
durability and a scratch-resistant
finish.

Powered by an Intel Pentium M
760J processor running at 2 GHz on a
915GM chipset and complemented by
512MB of DDR2 memory, the Z60t runs
most standard applications with ease.

An 80 GB 5400 rpm SATA hard drive
provides ample storage space. Other features
include an integrated DVD-RAM drive, keyboard light
and SD card reader. Connectivity options include gigabit
LAN, a 56K modem, Wi-Fi, Infrared and Bluetooth.
Available ports include 3 x USB, FireWire, PC card slot,
VGA, S-Video and audio jacks.

The full-sized keyboard features new multimedia
keys, along with touchpad and pointing stick options for
pointer control. Security and protection features include

a biometric fingerprint reader and Active
Protection System for protecting data.

The Z60t comes with Windows XP
Professional with applications such as
Rescue & Recovery, Client Security
Solution, and ThinkVantage Productivity
Center preloaded. You also receive a
three-year global warranty.

The laptop scored 21.3 in Business
Winstone and 3,437 in PCMark 2004,
which are above average; this means

day-to-day applications will run
faster. Battery life is

over two hours
with DVD

playback.
This laptop is,

overall, a very decent
performer: with great

looks, useful features and a
host of security options, the Lenovo

Z60t is worth the money.

Company Lenovo (India) Pvt Ltd

Price Rs 94,900

Phone 1600 4254240

E-mail buy@in.lenovo.com

Web site www.lenovo.com/in

Rating
1 2 3 4 5

Lenovo ThinkPad Z60t
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5.1 Speakers
Artis X10 Mini

Compact, sturdy, clear 
sound
Slightly weak bass 

Contact Kunhar 
Peripherals Pvt Ltd
Phone 022-56345758
E-mail salesbom@kunhar.com  
Price Rs 14,000

Graphics Cards (Mid Range)
XFX GeForce 6600GT 256 MB

Great performance,
good features
High price

Contact Rashi Peripherals
Phone 022-28221013
E-mail navinderc@
rptechindia.com
Price Rs 13,999

CRT Monitors (17-inch)
Acer AC715

High resolution of 1600 x
1200 @ 75 Hz, good repro-
duction of finer details

None

Contact Acer India Pvt.Ltd.
Phone 080-5219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 6,995

CRT Monitors (19-inch)
Samsung SyncMaster 997DF

Good colour reproduction, 
compact
None
Contact Samsung Electronics

India
Phone 011-51511234 
E-mail marketing@
samsungindia.com
Price Rs 13,999

PVR Software
WinDVR 3.0 

Ease of use, Pause TV,
Zoom-in on TV, Tiled
Preview of channels, DV-to-
MPEG, Good picture clarity
None  

Contact www.intervideo.com

Cell Phones 
Sony Ericsson W800i

Feature rich and fast phone 
Can do with a better colour
co-ordination

Contact Sony-Ericsson India 
Phone 124-2560808 
E-mail dhiraj.soni@

sonyericsson.com
Price Rs 25,000

LCD Monitors (15-inch)
Acer AL1512

Very competitively priced,     
good contrast ratio
No vertical swivel

Contact Acer India Pvt. Ltd
Phone 080- 5219520-23
E-mail rajesh_aiyar@acer.co.in
Price Rs Rs 9,999

LCD Monitors (17-inch)
Acer AL714sm

Light, good greyscale 
reproduction
None

Contact Acer India Pvt Ltd
Phone : 080-5219520 / 23
E-mail rajesh_aiyar@acer.co.in
Price Rs 14,999

Flash based MP3 Player
Samsung YP-T8

Feature packed, video play-
back 
Average bundled earphones 

Contact Samsung India
Electronics Ltd.  

Phone 011-51511234
E-mail subrotah.b@

samsung.com 
Price Rs 14,900

YES YMP-910
Excellent audio perform-
ance, extra features
Average quality earphones

Contact Thakral Computers
Phone 022-24914090
E-mail prashantgoel88@

gmail.com
Price Rs 7,640

Graphics cards (High End) 
XFX GeForce 7800 GTX
256 MB

Extreme performance, great
price, exotic features 
None
Contact Rashi Peripherals
Phone 022-28221013
E-mail navinderc@ 
rptechindia.com
Price Rs 32,950

Hard drive based MP3 Player
Samsung YH-J70

Good audio quality, video
playback

Average bundled earphones
Contact Samsung India

Electronics Ltd.
Phone 011-51511234
E-mail subrotah.b@samsung.com
Price Rs 22,900

Linux 
Xandros Desktop OS 3

Simple to use
Paid

Contact G.T. Enterprise
Phone 080-2669 5890/91/92/ 
93/94 
E-mail gtcdrom@vsnl.com 
Price Rs 3,914

SuSe 9.3 Linux Professional
Up-to-date software bundling
None

Contact G.T. Enterprise
Phone 080-2669 5890/91/

92/93/94 
E-mail gtcdrom@vsnl.com 
Price Rs 4,398

Motherboards
Mercury PI915GVM

Supports PCIE, DDR/DDR II
RAM, 6-channel audio

Only 2 PCI slots. No SATA.

Contact Kobian ECS India Pvt ltd
Phone 022-23020767 / 774
E-mail mumbai@kobian.com
Price Rs 4,750

MSI RS480M2-IL
+ PCIE based, 6 channel
audio, supports 4 GB RAM,
socket 939, Firewire port
No Gigabit

Contact Tirupati Enterprises 
Phone 033-22251192 
E-mail mail@tirupati.net
Price Rs 4,950

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT JANUARY 2006
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Digital cameras (Mid
Range)
HP PhotoSmart 945

8X optical zoom, big lens
results in some great photo-
graphs

Not quite pocketable

Contact J.J Mehta and sons
Phone 022-24326865
E-mail sales@jjmehta.com
Price Rs Rs.16,500

Digital cameras (High
End)
Sony CyberShot DSC-P200

Compact, 7 Mega Pixel
performance oriented camera

None

Contact Sony India Pvt. Ltd
Phone : 011-55006600
E-mail mktginfo@ap.sony.com
Price Rs.20,990

PCs above Rs 25K
Acer Aspire ASP V4324

Good performance and pack-
age contents, low price
None

Contact Acer India (Pvt) Ltd.
Phone 080-25219520
Website www.acer.co.in
Price Rs.25,999

Media Center PCs

HP Pavilion m7280in
Great design, features and
performance
Expensive 

Contact HP India Sales Pvt. Ltd 
Phone 0124-2566111
E-mail www.hp.com  
Price Rs.64,990

Digital cameras (Entry level)
Canon PowerShot A400

Class leading performance and
decent feature set 

A bit expensive in its class
Contact Macro Foto
Phone 022-22618639
email macrofotoone@yahoo.com
Price Rs.8,995 

Digital cameras (Mid Range)
Sony Cyber-Shot DSC-W5

Reproduces some great photo-
graphs, good features to close
the list

Relatively expensive in its class 

Contact Sony India Pvt. Ltd.
Phone 011-55006600 
E-mail mktginfo@ap.sony.com
Price Rs.18,990 

Home Inkjet Printers
Pixma iP1000

Economical; decent photo
printing. 
No output tray; no PictBridge  

Contact Canon India Ltd
Phone 0124-5160000
E-mail www.canon.co.in
Price Rs 3,195

Office/ Photo Inkjet
Printers
Canon Pixma iP 3000

Fast, excellent photo and 
text printing
No LCD 

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 7,495

Colour Laser Printer
Epson AcuLaser C1100

Duplex printing, network 
ready, excellent performance
High Cost per page

Contact Epson India Ltd
Phone 080-3051 5000
E-mail aculaser@eid.epson.co.in
Price Rs 36,500

Mono Laser MFDs
Canon MF 3110

High speed, low price
No fax

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 19,995

Lifestyle Ultra Portable
Laptop
Sony VAIO VGN-S46GP/S

Good looks, Great performance,
excellent LCD display
None 

Contact Sony India Pvt Ltd
Phone 011-55006600
E-mail mktginfo@ap.sony.com
Price Rs 99,990

Lifestyle Workhorse Laptop
Acer Ferrari 4002

Great looks and flaunt value,
great performance  
None

Contact Acer India (Pvt)Ltd
Phone 080-25219520
E-mail ailenquiries@acer.co.in
Price Rs 99,999
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Mono Laser Printers
Canon LBP 2900

Great Performance, price
Lacks Duplex printing and

network capabilities.

Contact Canon India Ltd. 
Phone 0124-5160000 
Web site www.canon.co.in  
Price Rs 9,995

Brother HL 6050D
Excellent performance, 
duplex printing,economical 
printing
Not Network Ready

Contact Brother International. 
Phone 022-25797470
Web site www.brother.co.in  
Price Rs 35,100

Brother MFC-8440
Good print and scan 
quality, Sheetfed & CIS
scanner
Low scan speed 

Contact Brother International. 
Phone 022-25797470
Web site www.brother.co.in  
Price Rs 35,000

Value PCs
HCL Ezeebee 4981

Great performance and
upgradable
None

Contact HCL Infosystems Ltd.
Phone 0120-2520977 
Website www.hcl.in
Price Rs.24,990
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Jyotsna Rege

As the national portal of India,
the www.india.gov.in claims
to be “developed with an

objective to enable a single window
access to information and services
being provided by various Indian
Government entities.” 

Indeed, we can say that the
statement is justified. For the fairly
simple objective that the site has, it
packs a whole lot of data. Of the few
sites that provide information on
the Indian government, we found
this site to be the most comprehen-
sive despite its fairly recent launch.  

All About India
As part of the national e-gover-
nance plan, the site is designed by
the National Informatics Centre
(NIC). Its Web pages have a pristine,
well-segregated look and appear
multi-hued at first glance. Popular
customary icons and colourful
images of the Indian culture are
placed on the top bar. Designed for
use by both nationals and visitors,
the site provides the latest updates
on the activities and legislations of
the Indian government. 

The prominent sections
‘Business’, ‘Overseas’, ‘Citizens’,
‘Government’, ‘Know India’, and
‘Sectors’ are very comprehensive.

Under ‘Citizens’, there are eight
links—Health, Education,
Employment, Housing, Law & Order,
Travel & Tourism, Banking &
Insurance, and Taxes. Now, if you just
click Health, five other links pop up—
Schemes & Programmes, Alternative
Systems of Medicine, Hospitals &
Medical Institutions, Government &
Health, and Acts, Laws & Policies—
well, you get the idea.  

Right in the middle of the home
page, is a section called ‘Spotlight’
featuring the Special Economic
Zones Act 2005. This section is regu-
larly updated and focuses on the
most topical issues. Moreover, at the
bottom of the Web site are links per-
taining to Maps, Web Directories,
Greetings and other miscellaneous
items. Currently, the Web site is also
displaying a banner regarding the
Pravasi Bhartiya Divas that will be
held in January 2006. The site also
offers Web casts of the live proceed-
ings of Rajya Sabha.

Useful In Its Entirety
The site has put together extremely
useful, interesting and varied con-
tent. The Maps section displays
demographic and sectoral maps
besides containing national and
state maps. Users can get them-
selves registered on the site. And
every time a user logs into the site,
say, if he or she is a resident of

India.gov.in  

Bhopal, then the user can access all
possible data there is on Madhya
Pradesh. This section has been cus-
tomised based on the user profile
saved with India.gov.in. State and
national directories are also avail-
able which have a search base with
numbers and names and again, they
all are up and running. If you have a
registered phone number, it’s bound
to be present here!   

At the extreme right side of the
page is a section called ‘How do I?’.
Here, a multitude of things, from
obtaining various certificates to
determining the status of stolen
vehicles has been explained verba-
tim. Although the link is divided
into seven subheadings and has all
possible information a citizen of
India would require. Imagine being
able to check the status of the
speed post mail you sent! Well, you
can do that here.

The Web site has its shortcom-
ings—the login box is visible only
after navigating to the right of the
page. You will practically stumble
across it rather than spot it when
scanning the page. Although the site
boasts of various links, very few of
them are actually available. 

All said and done, these flaws
are quite trivial compared to what
the site offers. Information can be
accessed without losing one’s way
and one can access other features
easily without having to divert to the
home page, courtesy a tool bar on
the right side of every page.
Besides, the number of links
India.gov.in provides to other Web
sites is exhaustive. All in all, the site
collates all that is necessary and
does so with ease. 

jyotsna_rege@thinkdigit.com

Exclusively catering to the public, those with civic sense will be pleased with India.gov.in

The home page: perhaps a little too much clutter and colour, but comprehensive nonetheless

The ‘How Do I?’ page is a great repository of information and
answers for everything India related
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Most or all of us use Word,
but not many of us bother
with its advanced features.
These features aren’t
“hidden” in any way—they’re
right there in the menus; it’s
just that we don’t bother to
experiment! Here are some
features all of us can find use
for at some time or the other.

AutoText
AutoText offers a way to
store and quickly insert

text, graphics, fields, tables,
bookmarks and other items
that you use frequently. Word
comes with a number of
inbuilt AutoText entries
divided into different
categories. For example, if
you’re working on a letter,
Word can offer letter-specific
AutoText entries, such as
salutations and closings.

You can also, of course,
create your own AutoText
entries. It’s as easy as Insert >
AutoText > AutoText. Here,
you’ll find the field where
you can enter your own
AutoText. This is useful if you
often use the same large or
complex item and don’t want
to have to reinsert or retype
it, or if you want to store text
that contains a particular
style or format. For example,
if you send customers a
monthly report that always
includes the same lengthy
disclaimer, you can create
an AutoText entry for the
disclaimer. 

When you create an
AutoText entry, it’s
automatically linked to the
paragraph style of the text or
graphic you used to create
the entry. This style is what
Word uses to determine
which submenu the new
AutoText entry appears in on

the AutoText submenu in the
Insert menu. For example, if
your report’s disclaimer has
the Normal style, Word links
the AutoText entry to the
Normal style. When you later
want to insert the entry, you
will find the entry on the
Normal submenu (Insert >
AutoText). In Word 2002,
when you click Insert >
AutoText, you’ll see “Drag to
make this menu float.” Drag
that item, and you will see
the submenus.

AutoCorrect
AutoCorrect
automatically corrects

text errors such as incorrect
capitalisation and typos. You
can also use AutoCorrect in

much the same way that you
use AutoText, to store text or
graphics you plan to reuse. If
you create an AutoCorrect
entry that contains text only,
Word stores the entry
without formatting. If you

create an AutoCorrect entry
that contains a field, sym-
bol, paragraph mark,
imported graphic, or an
object other than text, Word
preserves the entry’s original
formatting. Select the text or
graphic you want to store as
an AutoCorrect entry.

On the Tools menu, click
‘AutoCorrect Options’ and go
to the AutoCorrect tab (make
sure the ‘Replace text as you
type’ checkbox is selected.) 

In the ‘Replace’ box, type
in what you want to
replace—that is, the
abbreviation or word that
Word replaces automatically
as you type). In the ‘With’
box, type in (or paste) what
you want to replace that text
with. If this contains
formatting, the ‘Plain Text’
and ‘Formatted Text’ options
will appear.

To save the entry without
its original formatting,
click ‘Plain text’, and to
save the entry with its
original formatting,
click ‘Formatted text’.
Click ‘Add’. When
you’re ready to
automatically insert
the AutoCorrect entry,
type the entry name
followed by a space or
punctuation. You can
store your own symbols
as AutoCorrect entries.
Go to Insert > Symbol.
Click the symbol you
want, and click
‘AutoCorrect’. Store the
AutoCorrect entry as
usual. 

Choosing Between
AutoText And
AutoCorrect

AutoText and
AutoCorrect use

different methods to
insert entries
automatically. After
setting up an AutoText
entry and turning on
AutoComplete, you can
choose whether or not
to insert the entry into
your document. By

contrast, when you use
AutoCorrect to automatically
correct text as you type,
Word will always insert the
text. If you decide you don’t
want the AutoCorrect entry,
you must undo the insertion.

Advanced Features 
In Word 2002

SECRETS THAT KEEP YOU AHEAD IN THE RACE

GENERAL TIPS
Advanced Features In Word 2002 83

OpenOffice.org 2.0 Writer 89

30 MINUTES EXPERT
Use Sticky Notes With Windows 85
Movie Files

Create Your Own Today Screen 88

Themes For Pocket PC

How often have you corrected typos by
backspacing and then retyping? Avoid
all the hassle with AutoCorrect

Click Insert > AutoText. The little
bar in red above can be dragged

The AutoText toolbar lists out
AutoText in various styles

In AutoCorrect, you can choose between
formatted and unformattted text. You’ll
want to choose the former in most cases
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AutoFormat A Table
You can quickly format
a table by using the

Table AutoFormat command.
The Table AutoFormat
command will automatically
resize your table to fit the
largest entry and apply
predefined borders and

shading. To format a table by
using Table AutoFormat,
place the insertion point in
the table to be formatted.
Choose Table > Table
AutoFormat. Select one of
the predefined formats.
Observe the preview window.
As you select different
formats, a representation of
the format is displayed in
the Preview area. Click ‘OK’
to apply the format to the
table containing the
insertion point. 

Sorting Data In A Table
To sort data in a table,
first make sure the

header row is unique
looking from the rest of the
data (bold, italicised or
larger). Put the mouse
anywhere in the table.
Choose Table > Sort. In the

‘Sort By’ drop-down list box,
select the field name by
which you want to sort. In
the ‘Type’ drop-down list
box, select ‘Text’, ‘Number’
or ‘Date’ according to the
contents of the column
selected in the ‘Sort By’ box.
Select ‘Ascending’ or
‘Descending’ and click OK.

Comparing Documents
Comparing documents
is useful to view

changes to a document that
was not revised by using
change tracking. 
Go to Tools > Compare and
Merge Documents. Open the
document you want to
compare the current
document with. 
Click the arrow next to
‘Merge’, and then do one of
the following: 
1. To display the results of the
comparison in the original
document, click ‘Merge’.

2. To display results in the
currently open document,
click ‘Merge into current
document’.
3. To display the results in a
new document, click ‘Merge
into new document’. 

When you compare
documents, Word marks text

that was added and/or
deleted, just as it would if
change tracking had been
turned on.

Versions In One File
Look at the File >
Versions menu, and the

options offered therein. The
menu is intuitive and doesn’t
need too much explanation.

If you have a document
that may be revised in the
future, you might want to
keep a record of each
different draft. You can set up
the document so that Word
saves a snapshot of the
current version automatically
each time you or another
reviewer closes the document
after making changes. All
versions are stored within
one document, although
Word displays only the
current version by default.

For each version in the
document, Word records the

date and
time when
the version
was saved
and the
name of
the person
making the
changes.
You can
view any
one of the
previous
versions in
a separate

window by opening that
version from File > Versions.
You can also open, print, and
delete earlier versions.

Reviewing Comments 
View the comments

of a single reviewer:
Click Show >  Reviewers on
the Reviewing toolbar, and
select the Reviewer the
comments from whom you
want to see.

Locate a specific comment:
Click ‘Go To’ on the Edit
menu. In the ‘Go to what’
box, click ‘Comment’. In the
‘Enter reviewer’s name’ box,
click the reviewer’s name.
Click ‘Next’ until you find
the comment you want.

Review one change at a
time: Click ‘Next Change’ or
‘Previous Change’ on the
Reviewing toolbar.

Accept the change: Click
‘Accept Change’ on the
Reviewing toolbar.

Reject the change: Click
‘Reject Change’ on the
Reviewing toolbar.

Accept all changes in one
pass: In the drop-down next to
‘Accept Change’, select ‘Accept
all changes in document’.

Reject all changes in one
pass: In the drop-down next
to ‘Reject Change’, select
‘Reject all changes in
document’.

(In the above two drop-
downs, there are other
options you can explore and
experiment with.)

What Is A Table Of
Contents?

A table of contents is a
list of headings in a

document that you can
insert in a specific location.
You can use a table of
contents to get an overview
of the topics discussed in a
document or to quickly
navigate to a topic. 

You can create a table of
contents for a document that
you plan to print as well as
view in Word. For example,
when you display the
document in print layout
view, the table of contents
includes page numbers along
with the headings. When you
switch to Web Layout view,
the headings are displayed as
hyperlinks so that you can
jump directly to a topic.

Multiple Selection
With Word 2002, users can
now use a feature that’s been
in Excel for a long time: mul-
tiple selection. This allows
you to select multiple areas of
text in a document simultane-
ously, so that you can then
apply styles and formatting
all at once. This feature is typ-
ically enabled by selecting
some text and then using
[Ctrl] to select other blocks of
text, which is similar to the
way you’d select multiple
icons in Windows Explorer.
One useful feature of multiple
selection is that you can do
searches within the area that
are highlighted, excluding the
unselected portions of the
document.

Bet You Didn’t Know

Use TableAutoFormat to format a
table using one of many styles

When you want to merge documents, you’re presented
with a menu under ‘Merge’. Try out all three of them!

Did you know you could automatically sort data in a table in Word?
After selecting to sort data, you’re presented with various Sort Options
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There are a few small, handy
things which, unfortunately,

aren’t part of Windows. One such is
Sticky Notes—the virtual equivalent
of writing down tasks on paper and
sticking it somewhere around you as
reminders. Adding such a feature to
the OS is very easy—all you need to
do is download and install a free
tool! But what we’ll try here is to
avoid installation of any third-party
software, and use some parts of the
OS (here, Windows XP) to add a
‘Remind Me’ program. Of course,
you can call it whatever you want.

What Do You Need?
You just need Windows XP,
though this trick can also be

done on other Windows versions
with a slight change in approach.
The idea here is to use Windows’
long file names to our advantage.

Creating Your Own
File Type
Since we’re going to create a

reminder note tool, it would be nice
if we had a different file type. Open
any explorer window, say ‘My
Computer’. Click on ‘Tools’ > ‘Folder
options’. Choose the ‘File types’ tab
and hit the ‘New’ button to create a
file extension. Type in ‘rdme’ (short
for “Remind Me”, of course) in the

‘Create new extension’ window, and
hit [Enter]. 

Assigning An Action And
An Application
In the same ‘Folder options’

menu, with ‘RDME’ selected, click
‘Advanced’. This will open the ‘Edit
File Type’ window; click the ‘New’
button to assign an action and an
application for the tool we are
creating. Under ‘Action’, type in
“open”, and under ‘Application used
to perform action’, type in
“notepad.exe” and then click ‘OK’ to
close the window.

Selecting An Icon
The ‘Edit File Type’ window
is already open; click

‘Change Icon’ and choose any of the
icons that you feel resembles a
sticky note. For this example, we
chose the 28th icon on the 3rd row,

which looks like a few papers
pinned at the top left corner.

Once you’ve chosen the icon,
type in “Remind Me” in the text box
just before the ‘Change Icon’ button.
Click ‘OK’ and close all open
windows one after the other.

Creating The Required
Registry Values
Open the Registry Editor.

Collapse HKEY_CLASSES_ROOT and
right-click on ‘.rdme’. Select New >
Key and type in “ShellNew”. Let
‘ShellNew’ be selected on the left
pane; on the right pane, right-click to
select New >  String Value and type in
“NullFile”. Exit the Registry Editor.
Right-clicking on free space anywhere
in Explorer or on the desktop will
show up ‘Remind Me’ under ‘New’. 

Using “Remind Me”
Let’s consider that your
mom is after you to go to the

market, and you assure her you’ll go
a little later. So, you right-click on
the desktop and choose ‘Remind Me’
under ‘New’. This creates the icon
we chose on the desktop, allowing
you to type in something—you type
in “Go to market to buy groceries…
see list.” You can type the list of

groceries in the Notepad window
that opens on double-clicking the
reminder note.

In the above, we have actually
created a Notepad file to open for a
user-created extension (.rdme), and
then we gave an icon to our so called
app—and also listed it in the registry

so we can access it with a right-click.
The short reminder note you type in
is actually a file name— thanks to
Windows for allowing long file
names! Who needs third-party
software for something so simple!

anup_nair@thinkdigit.com

Use Sticky Notes With Windows
Need to use virtual Post-its on your Desktop? All you need is Notepad!

Use Folder Options to create a file type—an
extension for “Remind Me”

Select an icon
that
resembles
sticky notes

You can now choose ‘Remind Me’ under ‘New’ to
add reminder notes!

A few ‘Remind Me’ notes stuck on the desktop
reminding you of things to do. Clicking ‘Go to
market’ shows the grocery list you entered
earlier in Notepad

Digital Tools l Tips & Tricks
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Create A Table Of
Contents

In your document, apply
inbuilt heading styles

(Heading 1 through Heading
9) to the headings you want

to include in your table of
contents. Click where you
want to insert the table of
contents. On the Insert menu,
click Reference > Index and
Tables, and then click the
‘Table of Contents’ tab. Do
one of the following:
1. To use one of the available

designs, click a design in
the Formats box. 

2. To specify a custom table of
contents layout, click
‘Options’ and choose the
options you want. 

Apply A Different Style 
To apply a paragraph
style, click the

paragraph or select the group
of paragraphs you want to
change. Or to apply a
character style, click the word

or select the words you want
to change.

On the Format menu,
click ‘Styles And Formatt-
ing…’ This will open the
Styles and Formatting pane to

the right.
Click the
style you
want to
apply.

If the
style you
want is not
listed, select
another
group of
styles in the
‘Show’ box. A
paragraph
mark appears
to the right
of each para-
graph style. A
bold,
underlined
letter ‘a’
appears to
the right of

character styles. A table icon
appears to the right of each
Table style.

Recording A Macro
Macros are a string of
commands that are

recorded in order so as to
execute them with one
keystroke. Many times when
users become more

experienced, they want to
speed up tasks that they do
on a regular basis. By
creating a macro, the user
can become much more
productive, because multiple
commands can be executed
with one keystroke. Let’s
look at the process of
creating a simple macro in
Word that will check the
spelling, save the document,
and then go into print
preview—all with just
one keystroke.

Open any document.
Click on Tools > Macro >
Record New Macro. The
Macro dialog box opens. In
the top of the dialog box is a
field that reads ‘Macro
Name’. Type in the name of
your new macro. Next, click
on the Keyboard button in
the ‘Record Macro’ dialog
box. The ‘Customize
Keyboard’ dialog box opens.
Now, click in the area inside
the ‘Customize Keyboard’
dialog box that reads ‘Press
New Shortcut Key’. The
insertion point is placed into
that text field. This area is
where you assign a keystroke
command to your macro.

Press [Alt] + [1]. The
command should appear
inside the ‘Press New
Shortcut Key’ area, and under
it will appear a message
indicating if that particular
keystroke command is
already used. If it is not being
used, it should read
“Currently Assigned to:

[unassigned]”. If it is
unassigned, you’re OK; if not,
change the keystroke to
another containing [Alt] +
[another number]. Click
‘Assign’. The macro is
assigned that particular
keystroke.

Click ‘Close’. The ‘Macro
Record’ toolbar appears. It
doesn’t consist of much; you
can (without customisation)
only pause/continue or stop
recording. Now, while the
Macro is getting recorded,
check spelling in the
document until the spell
check is finished. Next, save
your document. Then, click
File > Print Preview. Click the
Stop button on the ‘Macro
Record’ toolbar. Your macro
has been recorded. Now you
can test the macro by
executing the keystroke
assigned by you.

Tab Stop Selection
Buttons

Left Tab—Use this
selection to set a left-

aligned tab stop.
Center Tab—Use this
selection to set a

centered tab (to centre a
heading, for example).

Right Tab—Use this
selection to set a right-

aligned tab.
Decimal Tab—Use this
selection to set a

decimal-aligned tab.
Bar Tab—This is not a
tab stop per se. In

paragraphs where a bar tab is

The Format Painter
The Format Painter lets you copy text formats from one
location to another. You’ve probably often seen the
Format Painter icon on the toolbar, but never used it!
Using it is convenient if you want the same format(s)
applied to text in different locations. The Format Painter
copies all text formats, including the font, font size,
colour, and character effects. The Format Painter saves
time and helps create consistent formatting throughout a
document. It can also be used to copy paragraph formats,
such as alignment settings.

So how do you use it? First, click on the text with the
format(s) you wish to copy. Click the Format Painter once if
you want to copy formats to one other location, or double-
click it if you want to copy to multiple locations. Now select
the text at the new location(s) that you want to format. If you
double-clicked earlier, the Format Painter will remain active,
allowing you to select text at multiple locations. Remember
(if you double-clicked) to click the Format Painter button
again when you’re done to turn it off.

Bet You Didn’t Know

After creating a document using various heading
styles, Word can automatically generate a TOC. The
format will depend on the type of headings you used

Try out the macro feature and see
how much time it saves you!

You can easily apply different styles to your document in one pass
using the Styles and Formatting task pane
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set, a vertical line is inserted.
This feature is used in legal
documents.

First Line Indent—You
can use this selection to

set the indent for the first
line of a paragraph. Instead
of using the Format >
Paragraph dialog box,
position (click) this selection
on the ruler bar where you
want the indent to be.

Hanging Indent—You
can use this selection

to set the indent for second
and subsequent lines of a
paragraph. Instead of using
the Paragraph dialog box,
position (click) this selection
on the ruler bar where
you want the hanging
indent to be.

Setting Tab Stops
By default, left-aligned
tab stops are set every

half-inch across the page. To
set your own tab stops, you
can use the Tabs selection on
the Format menu; or you can
make tab setting changes
directly on the Ruler Bar. The
tab stops you set yourself will
be displayed on the Ruler Bar
using a separate symbol for
each type of tab setting;
default tab stops are not
displayed.

To set tab stops directly
on the Ruler Bar, do the
following: 

Position the insertion
point—or select a section of
text—where you want the
change in tab stops to occur:
to change the tab stops for a
single paragraph, click
somewhere within a
paragraph to be changed. To
change the tab stops for
several existing paragraphs,
select (highlight) the
paragraphs. This could be the
entire document. To change
the tab stops for a new
paragraph, click at the
beginning of a new, blank
line (this could be at the
beginning of a new
document). The new line
spacing will continue to each
new paragraph when you tap
the [Enter] key.

If the type of tab you
want to use is not already
selected, click the tab button
at the left end of the Ruler
Bar and make a selection.
Descriptions of tab stop

selection buttons are
provided in the next tip.

On the Ruler Bar, click at
the point where you want to
place a tab stop. 

Keep clicking until
you have positioned all
desired tabs.

Using the Tabs Dialog Box
You can also select the
tab alignments and

position tabs using the Tabs
option on the Format Menu
or in the Paragraph dialog
box. Using this method also
allows you to include a
leader (such as a dot leader)
to a tab stop. 

Make desired changes in
the Tabs dialog box, clicking
the ‘Set’ button to set each
tab stop. If you want to delete
a tab, click that tab setting in
the tab listing and then click
the ‘Clear’ button. To clear
all tab stops, click the ‘Clear
All’ button. When finished,
click ‘OK’.

Add a Watermark
Watermarks add an
overall graphic

dimension to a newsletter,
flyer or letter on a special
topic. The watermark is
printed in the centre of the
page; you can select the size
you want. Change its colour
in a paint program before you
insert it as a background
picture. Open a new
document, and from the
toolbar, select Format >
Background > Printed
Watermark. You will have an
option to place either a
Picture Watermark or a Text
Watermark. 

For a Text Watermark,
type in the text, its font, size
and colour. Explore the
‘Layout’ and ‘Transparency’
options. Click ‘Apply’ and
then ‘OK’.

For a Picture Watermark,

you will be able to first select
any picture you have
available, and then select its
size and whether it will
appear “washed out” or have
more colour. Click Apply and
then OK.

Creating Forms
You can use the Forms
toolbar to create

documents for onscreen tests,
activities, reports and
multiple choice quizzes.
Forms allow a user to tab
through the fields and make
changes/additions.
Select  View > Toolbars and
check the Forms toolbar to
select it. This will bring up
the Forms toolbar. You’ll see
several buttons:
1. Text Form field: To add
text within the document, for
fill-in-the-blank forms. The
surrounding text will adjust
to the length of the answer.
2. Check box form field:

Users can tab through and
press [Enter] to insert a
checkmark.
3. Drop-Down form field: To
specify choices for the user to
select. The person using the
form will need to use the
[Down Arrow] and [Enter]
keys to review and make the
selection.
4. Form Field Options: Click
here to create the choices.
Your first choice will show in
the box. (You will have to lock
the form first in order to see
your choice in a pull-down
menu.)
5. The two table tools help
you to easily create a table to
tab through. This is especially
handy when creating reports
and other classroom forms.

When your information
and fields are entered, use
6. Form Field Shading: When
this is selected, it shades text
fields so that the user can see
them. The shading does not
print out.
7. Protect Form: When you
have finished setting up your
form, click this button to lock
the form. It will prevent the
user from changing your
form/template.  If you want to
make additional changes, you
will need to unlock the form.

Consider doing the
following:
1. Highlight the answer field

Above: A document with a “washed-out” watermark.
Below: A document with a watermark that has not been
washed out. In most cases, you’ll want the former

When you choose to insert a watermark, you’re
given three options. Explore these
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Acustom Today Screen can
completely change the look of

your Pocket PC or Windows Mobile
device—you can use your favourite
background image, and customise
the colours of the menus, text,
navigation bars, and notifications
bubbles. You can download
thousands of themes free from
various Web sites. One such is
www.pocketpcthemes.com.

Alternatively, you can use a free
tool called Microsoft Pocket PC 2002
Theme Generator V2 to create
personalised themes. You can also
use the tool to edit and personalise
other themes you’ve downloaded on
your desktop PC. The tool can be
downloaded from www.microsoft.
com/windowsmobile/downloads/the
megenerator.mspx.

So how do you create your own
theme using this neat software?

Get started 
Download and install the
Theme Generator tool from

the link mentioned above. Click
Start > Programs > Theme
Generator to launch the software.

Choose your background
Click ‘Create a new theme’.
Then, click ‘Browse’ to choose

a background image for the Today

Screen. After you’ve selected the
image, click ‘Modify this image’ to
change the image attributes. You can
choose from different effects such as
negative, greyscale, flip, and mirror.
You can also set image brightness and
transparency levels from this window.

If the aspect ratio of the image
you chose is different from what is
required, you can click and drag on
the rectangular frame on the image
preview to choose the desired
portion of the image. After you’ve
done this, click ‘Next’ to continue.

Choose An Image For
The Start Menu
Here, you have the option of

using the same image you chose in
the previous step, or you can use a
different image. If you choose a
different image, you can again set

the image attributes by clicking
‘Modify this image’. Remember to
choose the appropriate portion of
the image by dragging on the
frame in the preview. Click ‘Next’
to continue.

Choose Colours
The next screen lets you
specify custom colours for

various screen elements such as
Today text, navigation bar,
command bar, navigation tray,
message, and more. Click on the
drop-down to choose the specific
element, then click on the colour

options below to bring up the colour
palette. You can now choose the
desired colours. Click ‘Next’ after
you’re done.

Save It
Provide a name for the
theme you just created, and

choose the desired location on your
hard disk where you want it saved. 
Click ‘Finish’ to generate and save
the newly-created theme. This file
can be transferred later to your
mobile device using ActiveSync. 
Using the Explore tool, just copy it
to the Windows folder of your Pocket
PC. Then go to the Today Screen
settings and select the new theme to
activate it! Now you can proudly
display your new creation! 

deepak_dhingra@thinkdigit.com  

Create Your Own Today Screen
Themes For Pocket PC
It’s child’s play to create a custom theme for your Windows Mobile device…
there’s a free tool that helps you do this!

This free tool lets you create your own Today
Screen themes

Change the attributes for the Today Screen
background image

Choose a Start Menu image

Customise the colours for your Today Screen
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Few of us realise we can use something other than Microsoft Office for daily home
and office use. The good thing is, OpenOffice.org is very similar to Microsoft Office

OpenOffice.org is an
office package by Sun

Microsystems. The package
was initially introduced for
*nix OSes and Sun OS
machines, and was later
compiled for Windows. It’s
free, and is probably the
best alternative to MS
Office. You can get the
latest OpenOffice.org
package for free from
http://download.openof-
fice.org/2.0.0/index.html.

The switch from
Microsoft Office to
OpenOffice.org, while saving
a lot of money, is also easy:
the user interface of OOo
(OpenOffice.org) is very sim-
ilar to that of Microsoft
Office. Take a look at a snap-
shot of the Toolbar (below),
and you’ll see that the two
packages are very similar.
Most (but not all) editing,
formatting, and other such
options are located under
the same menus as those of
Microsoft Office.

Here, we introduce you
to OpenOffice.org Writer
running on a Linux (Ubuntu
5.10) machine. Note that the
following basic tips are also
applicable to OpenOffice2
Writer installed on a
Windows machine. 

Count The Words
Unlike in the earlier
version, Word count is

easily accessible in
OpenOffice.org2 Writer.
Just click Tools > Word
Count. More comprehensive
details of a document are
available under File >
Properties > Statistics Tab.

This tab displays details
such as the number of
paragraphs, lines,
characters, graphics, etc.

Check Spelling
OOo doesn’t have a
grammar check

feature. But it does have a
spell check feature, which
sports an auto-complete
feature that will intuitively
auto-complete the word you
are typing and display the
auto-completed portion with
a grey highlight. Hitting
[Enter] will save you the time
of typing in the entire word.
If you’ve written a few pages,
it keeps a tab on the oft-
repeated words, and adds it
to the auto-complete list.

Save In MS Word Format
You can save an OOo
Writer file in MS Word

format. The default format
is, however, .SXW. If you’ve
already saved the file as an
SXW, and if you’re

wondering if the text
formatting may become
corrupt when converting to
the MS Word format, don’t
worry: you have another
option - PDF. To export your
document as a PDF file, use
File > Export as PDF. You’ll
also find, under File >
Export, the output choice
between PDF and xHTML.

Adding Comments
To add a Comment,
click Insert > Note...

This will open a dialog box
where you can type in your
remarks. You can also
author the comment in the

same box. A little yellow
rectangle appears at the end
of the cursor position,
indicating a Note; move the
mouse pointer over it to
display the remark.

Changing Page Numbering
Some writers split
their chapters into

separate documents, in
which case page
numbering becomes a
daunting task. Writer
allows you to append page
numbers greater than 1 to
a the first page of a
document.

Let’s use page numbers
on the footer. Insert a
footer using Insert > Footer
> Default, and then add a
page number to it by going
to Insert > Field > Page
Number. Now, to start the
page with a number
greater than 1, move the
cursor out of the footer to
any paragraph on the first
page, then click Format >
Paragraph. This will open
the ‘Paragraph’ dialog box.

On the ‘Text Flow’ tab,
select ‘Insert’ under the
‘Breaks’ section, and also
enable ‘With Page Style’.
This will activate the drop-
down menu from where
you need to choose ‘First
Page’ (see screenshot below),

and then type in a page
number. Click ‘OK’.

Track Time Spent
There’s a feature in
Writer that comes in

handy when you want to know
how much time you’ve spent
writing an article. Go to File >
Properties, and choose the
‘General’ tab. Make sure,
however, that you have saved
the document before you
proceed with checking the
time—the time duration is
recorded only for saved files.

Create A Template
If you need text files to
have specific line

spacings, margins, borders, etc.
then you should create a user-
defined template. Open a new
document and do the
necessary page setup. Now click
File > Templates > Save…; this
will open the Templates dialog
box. Type in a name for your
template under ‘New Template’
and choose ‘My Template’ from
‘Categories’. Click ‘OK’.

To use the template thus
created, go to File > New >
Templates and Documents; a
dialog box opens. Choose
‘Templates’ from the left pane;
select ‘My Templates’ from the
centre pane to display a list of
user-defined templates. 

OpenOffice.org 2.0 Writer

OpenOffice.org 2.0 Writer looks very similar to Microsoft. The only
thing is, some menu items are in different locations

The Paragraph dialog box has all you need for formatting paragraphs
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task pane.
To apply your new style to

other text, highlight a line,
for example, and in the Styles
and Formatting Task Pane,
double-click ‘Centred
Heading’.

Customise Your Toolbars
Right-click on the
Standard toolbar

(which, we assume, you’ve
kept visible) and click
‘Customize’. You’ll see three
tabs—’Toolbars’,
‘Commands’, and ‘Options’.
Under ‘Commands’, you’ll
see—probably for the first
time—all the commands
Word is capable of! Each of
these commands can be
placed on a toolbar of your
choice.

To navigate to a
command, go to a Category
(the list on the left). The
commands under that
category will be visible. You
can simply click on a
command and drag and drop
it onto a toolbar of your
choice. So, for example, if you
want to add ‘Next
Misspelling’ to the ‘Extended
Formatting’ toolbar, first
check ‘Extended Formatting’
in the Toolbars tab. Then, if

‘Next
Misspelling’ is
not already
there on that
toolbar, go to
the Commands
tab, navigate to
‘Next
Misspelling’,
and drag and
drop it onto the
‘Extended
Formatting’
toolbar.

Of course,
you can drag
and drop any
command at all

onto any toolbar at all. You
can create new toolbars and
give them names, too!

Create Your Own Custom
Word Templates

Why use the same kind
of blank document

every time you open Word?
You might want to use a
different font every time, and
you probably reformat the

document every time.
Similarly, you might want a
signature with every file,
including, possibly, a picture.
You can create a template of
your favourite font styles and
sizes and use it whenever you
want—it’s as easy as creating
a new document. Then, each
time you open a document,
what you’ll need to do is click
File > New, and in the task
pane that opens up, go to
“New from Template”—and
select your template.
To create a custom template,
click View > Task Pane. If the
‘New Document’ task pane is
not visible, select it from the
drop-down menu in the
upper right corner of the task
pane. Now, in the New
Document task pane, click
‘General Templates’. In the
‘Templates’ dialog box that
appears, select the ‘General’
tab, click the ‘Blank
Document’ once to select it.
This will be the base for your
new template.

Under the ‘Create New’
section, click ‘Template’, and
click ‘OK’. Now comes the fun
part: in the new template,
add any text and graphics you
want to appear in all new
documents that you base on
the template, and delete any
items you don’t want to
appear. Also make the
changes you want to the
margin settings, page size

and orientation, styles, and
other formats. Finally, click
File > Save, and give your
template a name. 

Align Shapes Using
Gridlines

Did you know that
Word features a

drawing grid you can use to
align drawing objects, such
as AutoShapes? By default,
gridlines are not visible. To
make them visible, on the
View menu, point to Toolbars
and click Drawing. On the
Drawing toolbar, click Draw
> Grid. Select the Display
gridlines on screen checkbox.
Choose the options you want
and click OK.

You’re now ready to add
shapes to your document. To
see all the shapes available,
such as telephones,click
‘AutoShapes’ on the Drawing
toolbar and then click ‘More
AutoShapes’. Then make your
selections from the Insert
Clip Art task pane. 

and change its font, size
and colour so the answer
field is easily differentiated
from the question.

2. Add multiple spaces
between questions to make
them easier to read and
complete.

Creating a Style
You can define a specific
style and then use it to

format text throughout your
document. In this example,
we’ll create a “bold and
centred” style. To create this
style, double-click a word.
Click on ‘Bold’ in the toolbar.
From the menu, select
Format > Paragraph, or right-
click and select ‘Paragraph’.
Select ‘Centered’ for the
alignment and 1.5 lines for
the spacing. Click OK. With
your word still selected, from
the menu, select Format >
Styles and Formatting. ‘Styles
and Formatting’ appears in
the Task Pane. Click the ‘New
Style’ button.

In the ‘Name:’ box, type
in, say, “Centred Heading”.
Note the formatting
characteristics. Click OK. Your
new style, “Centred Heading”,
will now be listed in the
list of styles displayed in the

CWord allows you to create your own styles,
based on its predefined styles. Just select ‘New
Style’ from the Styles and Formatting task pane

Checkbox
Form Field

Text Form
Field

Drop-Down
Form Field

One of the most useful of Word’s advanced features is the ability to
create templates. Here we’ve created a template with a heading and a
picture. To open a document using the new template, click File > New,
which opens the New Document task pane. You’ll need to use ‘New from
Template’. Also, you might want to keep ‘Show at Startup’ checked

Form Field
Options

Insert
Table

Reset Form
Fields

Protect
Form

Form Field
Shading

Draw
Table

Insert
Frame

The Forms toolbar with its various elements
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TV To VCD
I bought a Techcom Super TV SSD-TV-670 PCI
TV-Tuner card. My problem is that I am

unable to write the files onto CD properly in
VCD mode. What mode should I use to get the
best out of my TV-Tuner card, and what are the
best PVR software and video and audio editing
software available?

Sagnik Bose

There’s no difference between a regular
video file and one you’ve captured

using your card. If you’re able to capture
video without any problems, you should
be able to write the files to CD in VCD
mode. You will need to purchase and
install a CD-burning software (such as
Nero Burning ROM) to do this.

After you start Nero, select the CD
format as ‘Video CD’, select ‘PAL’, and
click OK. Now simply drag and drop the
file you captured using your TV-Tuner
card into the Nero window. If the file
format is not conformant with VCD
standards, Nero will prompt you to re-
encode the file so it becomes compliant
with VCD 2.0 standards. Opt to re-
encode the file. This process takes some
time, but it produces VCDs that can be
played on any VCD player.

Some of the better PVR software are
InterVideo WinDVR from www.intervideo.com,
Cyberlink PowerVCR from www.cyberlink.com,
SageTV from www.sage.tv and ChrisTV from
www.chris-tv.com.

Adobe Premiere InterVideo WinProducer
and Ulead VideoStudio are some of the many
video editing software, and Sony Sound Forge
8.0, Adobe Audition, Cool Edit Pro and
GoldWave are some of the good audio editing
software available.

An Autopatcher Accident
I am using Windows XP with SP2. I’ve
installed Autopatcher XP, which was

provided with the last issue of Digit. From the
time that I’ve installed it, I’m not getting the
usual welcome screen, and during shutdown I see
a different interface. When I press [Ctrl] + [Alt] +
[Del], a window opens, describing something
about shutdown, logging off, etc. I want all these
set to the defaults.

Vinayak Vijayan

This happens because you accidentally
checked the box next to ‘Disable welcome

screen, force classic logon’. To restore the usual
welcome screen, start the Group Policy Editor by
clicking Start > Run and entering “gpedit.msc”.
Here, navigate to ‘Computer Configuration’,
expand ‘Administrative Templates’ and click on
‘Logon’. In the right pane, double-click ‘Always
use classic logon’ and set it to ‘Not configured’.
Exit the Group Policy Editor.

845: 266, 333?
I have an Intel 845GL motherboard with 128
MB of DDR 266 MHz RAM installed. I’ve

heard that the 845GL can also support DDR 333
MHz RAM with a BIOS upgrade. Is that true?

Manmohan Behera

The Intel 845 series of mother-
boards supports DDR 200 and 266

MHz RAM, and does not support DDR
333 MHz RAM even with a BIOS upgrade.
You may still be able to use a DDR 333
MHz module on this motherboard,
but it will run at a clock speed of DDR
266 MHz.

Download The Drivers!
I recently purchased a Nokia 6225 CDMA
cell phone with a data cable (DKU 5). I

installed PC Suite from Nokia to facilitate
data transfer. My problem is, I’m not able to

transfer data from my PC to the phone. Do I need to
install additional software?

Kavoor Branch

In order to connect the Nokia 6225 phone
with the DKU-5 to a PC, you’ll need to

download and install the drivers for the DKU-5
cable from www.nokia.com. These drivers
must be installed before you connect the
phone to the PC. It’s only after installing these
drivers that Windows will be able to success-
fully install and configure the cable. Also,
download the latest version of Nokia PC Suite
from the same Web site.

A 16-Bit Issue
I have a few educational CDs from which I’m
not able to install the software. When I

insert the CDs, I get a message that says,
“C:\Windows\System32\Autoexec.NT. The system
file is not suitable for running MS DOS and
Microsoft windows applications. Choose Close to
terminate the application.”

Balaji Vedahchalam 

Your Questions, Our Answers

Disable Classic Logon using the Group Policy Editor
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This message appears in XP when an MS-
DOS or 16-bit application is run. You’re

probably subsequently prompted to either quit
or ignore the error message, and choosing
either of these options quits the installation. 

The reason for this error could be one or
more of the following files being missing or
damaged: config.nt, autoexec.nt and/or
command.com. To resolve this issue, insert
your Windows XP CD in your drive, and open a
command prompt. At the prompt, type in the
following commands, pressing [Enter] after
each command (assuming X is your CD-ROM
drive letter).

expand X:\i386\config.nt_
%systemroot%\system32\config.nt
expand X:\i386\autoexec.nt_
%systemroot%\system32\autoexec.nt
expand X:\i386\command.co_ %system-
root%\system32\command.com
exit

Try running the installation to see if
the problem is resolved. If it persists:

In Notepad, type in the following:
dos=high, umb
device=%systemroot%\system32\
himem.sys 
files=40

Click File > Save As. In the file name
dialog box, type in “%systemroot%\
system32\config.nt” and click ‘Save’.

Click File > New. Type the following
entries in this new text document:
@echo off 
lh %systemroot%\system32\mscdexnt.exe 
lh %systemroot%\system32\redir 
lh %systemroot%\system32\dosx 
SET BLASTER=A220 I5 D1 P330 T3

Click File > Save As, and in the file name
dialog box, type in “%systemroot%\system32\
autoexec.nt” and click ‘Save’. 

If the problem is still not resolved, then
do the following:

Go to Start > Run, type in
“%systemroot%\repair” and hit [Enter].

We’re concerned with two files in this
folder: ‘Autoexec.nt’ and ‘Config.nt’. Right-
click on the Autoexec.nt file and select ‘Copy’.

Go to Start > Run, type in
“%systemroot%\system32” and hit [Enter].

Right-click anywhere in the folder and
select ‘Paste’.

Right-click on the Autoexec.nt file just
copied and choose ‘Properties’.

Select ‘Read-only’ and click OK.
Repeat the above steps for ‘Config.nt’.

Activate, Reinstall, Activate, ...
Whenever my computer got corrupt beyond
repair, I would reinstall the OS. I have a

registered version of Windows XP. Once reinstal-
lation is complete, the system asks me to activate
Windows. This has become a nuisance because
beyond 30 days, it just stops working. Is there
anything I can do? 

Dr K A Rasheed

Every single-user licensed edition of
Windows XP needs to be activated within

30 days of installation, failing which you will
not be able to log into Windows without acti-
vation. Re-activation may be necessary when
either you re-install Windows or when there
are major changes to your computer hard-
ware. Activating Windows XP is very easy, and
there are more than one ways to do it. We’ll
explain two of these.

A. Activating over the Internet:
Click on Start, point to All Programs >

Accessories > System Tools, and click ‘Activate
Windows’.

Click ‘Yes, let’s activate Windows over the
Internet now’.

Click ‘Read the Windows Product
Activation Privacy Statement’, then click

‘Back’, and then click ‘Next’. 
Click ‘No, I don’t want to register

now; let’s just activate Windows’ (if you
just want to activate Windows) and
click ‘Next’. The wizard will now estab-
lish a connection with the activation
server, which will process the activa-
tion request.

When the activation process is
complete, you’ll see a message: “You
have successfully activated your copy of
Windows”. Click OK.

B. Activating over the Phone:
This method is useful if you do not
have an Internet connection. You’ll
need to call a Microsoft customer serv-
ice representative over the phone. The

first step is the same as in the previous
method.

Click ‘Yes, I want to telephone a customer
service representative to active Windows
now’.

Repeat the third step from (A) above.
Follow the steps in the ‘Activate Windows

by phone’ dialog box, and click ‘Next’.
Call the toll-free number for your country

from the list.
An installation ID number will be

displayed on the screen, and you need to
provide this to the customer service represen-
tative, who will return a confirmation ID to
you. If you are re-activating, you will have to

Enter the customer ID to activate Windows XP
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Use XP’s Computer Management Tool

Anup Nair

Windows XP provides certain
powerful tools not seen in its
earlier versions. One of them is

Computer Management Tool. In this How
TO, we introduce you to and walk you
through much of what you can do with
the Computer Management tool.

The tool makes administration of the
computer easy—you get all the services,
applications, disk tools, and user and
group administration under one umbrel-
la. There are three main sections under
Computer Management: System Tools,
Storage, and Services & Applications.

We will look at those areas that we
can use in our day-to-day work.

How To Access Computer
Management
Right-click on My Computer and

choose ‘Manage’. This will open a new
window titled ‘Computer Management’.
The left pane displays the sections, as
we’ve mentioned, in a tree format. Click-
ing on each feature will show the corre-
sponding details in the right pane.

Using System Tools
The System Tools section has
everything to do with monitor-

ing your system, right from users and
groups to shared folders and the device
manager. ‘Shared Folders’ displays
Shares, Sessions and Open Files. Select-
ing ‘Shares’ will display your network
shared folders and also the Windows-
created share folder for remote access
by the Administrator. To disable sharing
of any folder listed here, open the fold-
er location and right-click it, select
‘Sharing and Security’ and uncheck
‘Share this folder’.

‘Sessions’ displays the users con-
nected to your machine; it also displays
information such as the type of user
(whether guest or administrator), com-
puter name, number of files opened,
connected time, and idle time. If you see
unexpected user(s) connected to your
computer, you can check under ‘Open
Files’ to know exactly what folder and
file is in use by that user. In ‘Open Files’,
you (as Administrator) can remove
access to any files that are in use, while
‘Sessions’ allows you to disconnect the
other user altogether.

‘Local Users and Groups’ displays
system users and user groups on your
machine. You can use it to add users and
specific groups. The user accounts can
be effectively controlled from here - you
can disable an account, set/reset pass-
words, and also force a user to change
his password at login. This tool is handy
for a machine that is used by more than
one person.

The Storage Section 
This section contains the two
most important tools—Disk

Defragmenter and Disk Management.
To use the Disk Defragmenter, choose

Disk Defragmenter from the console tree
and select a drive from those listed on the
right pane. Clicking ‘Analyse’ will give
you an idea whether or not to proceed
with the defragmentation process. In the
dialog box that appears, click on ‘Defrag-
ment’ to start the process (Refer How Disk
Defragmentation Works, Digit December
2005). This process will take some time
depending on the system and the size of
the partition being defragmented.

Creating partitions and formatting
them has become remarkably easy with
the inclusion of Disk Manager. It dis-
plays all the drives, even CD/DVD ROMs
and writers. This tool is designed to
help a user create a partition on a hard
disk without having to run any com-
mands or use a start-up disk. Since Win-
dows XP is already installed, your hard
disk would already have one partition.
If the entire hard disk space is used as
a single partition, then the tool is help-
less, as you are not permitted to split,
delete or format a partition that con-
tains the Windows OS. Those who have
used only a portion of the disk for the
XP installation can use this tool to cre-
ate more partitions (FAT32 or NTFS) on
their drive, and assign different drive
letters and volume labels to them.

To create a partition, right-click on
the unpartitioned space and select ‘New
Partition’. Thereafter, choose the type of
partition (primary, extended or logical)
you want to create. In the following
screen, give the size of the partition in
MB, a Volume Label, and the type of file
system FAT32 or NTFS). You can choose
‘Quick Format’ to save time. As opposed
to ‘Format’, ‘Quick Format’ doesn’t scan
the disk for bad sectors. If you want to
check the disk for bad sectors after instal-
lation is complete, open a command
prompt and type in “chkdsk /R” to start
the checkdisk utility. 

Services And Applications
Services are processes run by an
OS; some services are necessary

for the functioning of the system, and
some are optional. The ‘Services and
Applications’ section lists all the servic-
es and applications in Windows XP, and
also tells you the status of the
service/process. The section also gives a
description of each of the listed services.
Any service can be stopped, started or
restarted. For example, the Messenger -
which can be used to send messages to
a workgroup/computer/domain in a net-
work) is normally in the ‘Stopped’ state;

you can start this service if you want to
allow network users to send and receive
messages. This can be done by right-
clicking on the service name and
then selecting the appropriate option
out of ‘Stop’, ‘Start’, ‘Restart’, ‘Pause’
and ‘Resume’.

We’ve covered the basic tools that
help you ‘govern’ your computer. Com-
puter Management also includes Event
Logging, which keeps a record of all
software and user activity. This func-
tion is meant for administrators, espe-
cially those who deal with server-client
machines. 

anup_nair@thinkdigit.com

Windows XP allows you to control several aspects of the system from one location

Opening ‘Files’ under ‘System Tools’ in
Computer Management allows the
administrator to disconnect file transfers
initiated by an unknown user

You can start, restart, stop, pause and
resume a service by right-clicking on a service
and choosing an appropriate action
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cite the reason for re-installing Windows.
Once you type in the confirmation ID, activa-
tion will be complete.

If you do not wish to re-activate XP, there is
a way to back up the activation and restore it
when you re-install XP. Follow these
steps:

Navigate to the %windir%\System32
folder and locate the ‘wpa.dbl’ and
‘wpa.bak’ files, and copy them to a safe
location.

When you re-install XP, boot into Safe
Mode by pressing [F8] at boot time.

Navigate to the %windir%\System32
folder and rename the files ‘wpa.dbl’
and ‘wpa.bak’ to ‘wpaold.dbl’ and
‘wpaold.bak’ respectively. Copy the
‘wpa.dbl’ and ‘wpa.bak’ files from the
previous Windows installation to this
location. Windows XP will be activated
when you reboot.

Note that this procedure will not
work if you’ve made significant changes
to the computer hardware, or if you’re trying
to install XP on another computer.

All Topsy-Turvy!
I have a Pentium IV 2.8 GHz on a mother-
board with onboard Intel Extreme Graphics.

A few days ago, my niece accidentally pressed
some keys, and now the display is upside down!
What can I do to set it straight?

Amit Shah

The display got inverted because your
niece accidentally pressed the hotkey

combination that inverts the Intel Extreme
Graphics adapter’s display. To set it straight
again, press [Ctrl] + [Alt] + [Up]. To disable rota-
tion, right click the Intel Extreme Graphics
icon on the taskbar, select ‘Graphics Options’,
and then ‘Graphics Properties’. Click on the
‘Rotation’ tab and remove the checkmark from
the ‘Enable rotation’ box.

Alternatively, this can be accessed from
Display Properties > Settings > Advanced > Intel
Extreme Graphics > Graphics Properties.

Spanning A Backup
I took a backup of my C drive, and the size is
9.72 GB. I have a DVD-Writer, and the space

available on a DVD is 4.72 GB. I would like to copy
my backup file to DVDs.

Glenn Philips

Most file archiving utilities are capa-
ble of spanning archives across

volumes of specified sizes. WinRAR and
WinZip are two such. Let’s use WinRAR:
install it from www.rarsoft.com. Open
Windows Explorer and right-click on the
backup file you created. Click ‘Add to
archive...’. Choose a name for the archive
and set the compression parameters
according to what you want. Let the
archive type remain as RAR, and select
‘Create SFX archive’ if you wish to create
a self-extracting archive, using which
you’ll be able to extract the archive even
without installing WinRAR. In the ‘Split

to volumes, bytes’ dialog box, set the volume
size to 4,500,000,000 and click OK. Volumes of
4291 MB each will be created, and you can write
these to individual DVDs. 

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your 
query to be answered.
Rest assured, we are
listening!

Get Help Now!

Video On Linux
I have an Intel Pentium IV 1.80 GHz with 128 MB of RAM
and a 40 GB Maxtor hard disk. I have two OSes installed

on my PC—Windows XP Professional SP2 and Fedora Core Linux
2. I downloaded the Mplayer.tar file from www.mplayerhq.hu

and tried to install it on Linux, but am unable to do so.
How do I play video files in Fedora?

Krishna Gaire

Here's how to install MPlayer on Linux: down-
load the MPlayer code tarball from

www.mplayerhq.hu/homepage/design7/dload.html to a
temporary folder. Open the command window by typing
"Konsole" in the Run dialog box. Uncompress the tar.bz2
file by typing in the following commands:
su
(Enter the root password when prompted)

tar -jxvf (Filename).tar.bz2
Change to the temporary folder where you just extracted
the files, and enter the following commands.
./configure --enable-gui
make
make install
Without the --enable-gui switch, you will get a command
line player. For GUI mode, you will need to download
MPlayer skins from the MPlayer download page, and
extract them to /usr/local/share/mplayer/Skin.

For DVD playback, download and extract the Subtitle
Pack to the above location. MPlayer lacks DVD menus,
and you'll have to manually choose title numbers, chap-
ters and audio streams. Xine multimedia player from
http://xinehq.de and Ogle from www.dtek.chalmers.se/
groups/dvd are good alternatives for MPlayer, and have a
much better GUI and features.

Question 

of the

Month

Use WinRAR to span an archive across DVDs
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Every month my mailbox gets flooded with
all sorts of queries—about the best moth-
erboards, cell phones and even peripher-

als. Of late, processors seem to be the hot topic,
and everyone is eager to know what’s happen-
ing with dual-core processors.

The Intel vs AMD debate continues, and
people only want to know which processors
from their favourite company are a good buy.
While most think Intel is reliable, runs cold,
and has good resale value, others prefer AMD
for what they consider superior gaming
performance and overclocking abilities. 

All this made me realise there’s a lot of
misinformation floating about in the markets,
and even dealers do not seem to know any better.

This time round my task was, therefore, not
just to find the cheapest deal in town, but also
to put the mess of rumours around the whole
processor debate to rest.

As usual, I decided to take a trip to Mumbai’s
Lamington Road to find out what dealers were
saying. Although I have also received
complaints about not visiting other cities, I
don’t think the need arises, as the answers you
get from different vendors across cities are
almost identical—albeit in a different language!

The Questions
My first stop was this swanky new shop, proudly
proclaiming to be an AMD dealer—someone had
finally mustered enough courage to do it! I asked
for an AMD solution and was offered three
choices: Sempron, Athlon 64 and Athlon 64 X2.

I was told they have a good scheme wherein
a combo of a Sempron 2500+ and a motherboard
would cost me around Rs 5,000. Initially I thought
the scheme was for clearing the older stock of
Socket 462 Semprons, but to my surprise it was
the new Socket 754 series.

This is great for people building
entry level PCs—a complete PC could
be assembled for just Rs 16K. The
AMD Sempron 2500+ seems to be
very popular right now, and is the
most widely available—higher-
clocked Semprons are a rarity.

Similarly, the shop also had
schemes on Athlon64 proces-
sors. A combo of a 754 pin 2800+
Athlon 64 and a motherboard
was retailing for Rs 7,500; without
the offer, the CPU would cost Rs 5,000.
The dealer also told me that 939-pin Athlon
64 CPUs were in now, as they supported dual-
channel memory.  

A 939-pin Athlon64 3000+ retails for
around Rs 6,700, whereas an Athlon64 3,200+
costs around Rs 8,700. Though these guys had
heard of the dual-core Athlon64 X2 processors,
they hadn’t started stocking it yet, due to lack

of demand. 
Since he was an AMD-specific retailer, I

asked him about the reliability and resale value
of AMD processors. According to him, AMD
processors are as reliable as Intel processors,
and he hasn’t come across a single problem. He
said the resale value for AMD processors was
still a problem, but only because of misconcep-
tions and lack of information. “Heating in AMD
processors is no longer an issue; in fact, the
latest Venice core Athlon 64 processors run
cooler than their Intel counterparts,” he
proclaimed. I was impressed—finally, a dealer
that does his homework!

Intel processors, on the other hand, are
omnipresent, and you should be able to walk
into any shop and get one. That’s exactly what
I did: I walked into another shop that seemed as
swanky as the AMD retailer’s, just to try and
keep things fair. I asked for a Celeron processor
and was promptly advised to buy a 2.6 GHz
Pentium IV processor, as the price difference
isn’t much—the Pentium IV 2.6 GHz costs
around Rs 5,200, while the 2.6 GHz Celeron
retails for Rs 3,650. 

“The older processors have 478 pins, and
should plug into an existing motherboard if
you’re upgrading. The newer processors are
based on the LGA 775 socket, and are pinless.
The 64-bit Intel Pentium IV processors (which
fall in the 6XX family, and have model numbers
such as 670, 672, etc.) have all the latest features
such as HT, 64-bit capability, power-saving
SpeedStep technology etc.,” I was told.

The dealer conveniently forgot to mention
that 478-pin processors have been discontin-
ued. “Really?” was his unconvincing reply when
I informed him about this.

Across the market, I found that the Pentium
IV 2.8 GHz costs about Rs 5,700, the 3 GHz Rs
8,100, and the 3.2 GHz Rs 10,500. When I asked
around for the Pentium D dual-core processor,

I was told it’s currently sold as a combo—an
i945 motherboard and a Pentium D proces-

sor together cost about Rs 18,000.
At the end of the day, I reached the

conclusion that for the average user who
wants gaming and various regular desk-
top applications, the following processors

are good buys.
For AMD fans: Socket 939 AMD Athlon 64

3000+
For Intel lovers: 3 GHz Pentium IV 630

For those on a tight budget, a Sempron solu-
tion is ideal—it’s fast, cheap and reliable. Those
who swear by Intel should opt for the Pentium
IV 2.6 GHz over a Celeron processor. 

Agent 001

Heating in AMD
processors is no
longer an issue;
in fact, the latest
Venice core
Athlon 64
processors run
cooler than
their Intel
counterparts

Processor Purchases
This month, Agent001 tells you how to choose the right processor!

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Pradip Ingale
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Workstation: Assembled Or Branded?
I want to assemble a high-end system for mechan-
ical design, for which I’ve allocated around

Rs 2 lakh. I plan to run Idea and Catia on the system.
I’m thinking of going in for a dual-core Intel solution
with an nVidia Quadro 4500 Fx card. Please suggest a
good processor, mainboard, and graphics card with at
least 256 MB of memory. Also please suggest a vendor
from whom I can purchase these components.  

Manpreet Singh Rehsi

We generally work with consumer-
oriented products, and our opinion on

workstation and server-related products is
limited. Even then, I’d say that instead of assem-
bling a workstation, it would be advisable to opt
for a preconfigured workstation from a good
brand such as IBM, HP, Dell, etc. Unlike with a
desktop, there are simply too many considerations
with a workstation or server to go about assem-
bling one.

Dell has workstations that are configured to
run mechanical design applications such as Catia
and Idea. Dell’s Web site (www.dell.com) gives a
thorough run-down on how to choose a worksta-
tion with respect to the application one plans to
run. HP and IBM, too, have products in this range
that you should check out. Also, opt for an AMD
Opteron-based system over Intel—they are said to
deliver better performance than Intel processor-
based systems. 

Graphics For Games
I have an old Pentium IV machine with an AGP slot
on the motherboard. I want to play newer games

such as Terminator 3, Delta Force Xtreme, etc. The
current graphics card doesn’t help much, and I would
like to upgrade it. I have a modest budget of around Rs
5,000. Also, will my current 256 MB of main memory
with Windows XP as my OS be enough for such games?

Ankit Tyagi 

Before you purchase a graphics card, check
what type of AGP slot your motherboard

has. The older type of AGP slots are not compati-
ble with the newer AGP cards—there is a voltage
difference. I’d suggest any card based on the 6200
chipset from nVidia. XFX has a 256 MB card that
retails for around Rs 5,000. Alternatively, you can
also look for a 6600 chipset-based card, which
generally retails for Rs 7,000 but which delivers
much better performance than 6200-based cards.
I’d recommend 512 MB of system memory, and
that should be your other upgrade if you want to
play high-end games.

Gaming PC Or Gaming Console?
I’m planning to get myself a new PC mostly for
gaming purposes. However, with the launch of the

Microsoft Xbox 360 and with the Sony PS3 to be
launched, I am confused as to whether I should opt for
a PC or a game console. Also, when will these consoles
be launched in India?

Arka Bose

First, I don’t think the Xbox 360 will  come
to India soon, due to the low broadband

penetration here. The major revenue generator
for Microsoft via the Xbox 360 is its online service,
Xbox Live, which needs a high-speed broadband
connection. Until the broadband infrastructure
improves significantly, don’t expect the Xbox 360
to hit Indian shores.

Similarly, the PS3 is slated to launch in the
latter half of 2006, and is less likely to come to
India immediately. The atrocious pricing of game
titles leads to rampant piracy in India, and that
doesn’t help either. Moreover, in India, the social
acceptance of consoles is very low, and selling
them doesn’t sound like good business to most
dealers. I’d suggest you stick with a PC with good
graphics and processing power. 

A Question Of Formats
I want to buy a DVD-Writer that supports almost
all available formats. I don’t want to get stuck

with a drive that fails to read a particular format. I’ve
budgeted Rs 3,000; can you suggest a good model
from a reputed brand? 

Prateek Katiyar

It is difficult to single out a DVD-Writer
that will have absolutely no compatibility

issues with recording media. No matter what
drive you buy, you’re bound to encounter compat-
ibility issues sooner or later.

However, from experience, we know Lite-On
drives perform better than other brands when it
comes to compatibility. I’d suggest you opt for the
Lite-On 1693S, which retails for around
Rs 4,000. If you’re unable to get it, settle for the
Lite-On 1673S.  

A Modest Mobile 
I am planning to buy a cell phone, and my budget
is a modest Rs 15,000. The phone should play

MP3/MPEG4/AAC/WMA, and should have expandable
memory (up to 2 GB would be preferred) and USB mass
storage support. I can do without a camera.

Krushil

Sony Ericsson’s K750i has almost every-
thing you want. I can’t think of a cell

phone under Rs 15,000 that supports 2 GB of
memory; the K750i has support for memory cards
up to 1 GB. The K750i, however, will set you back
by about Rs 17,000. If you are a Nokia fan, the
6230i is the phone to go for: it supports nearly
everything you asked for, and has many more
features. Moreover, it retails at Rs 14,000.

Mobiles Revisited
I want to buy a new mobile handset. I’ve short-
listed a few models: the Nokia 6600, Nokia 3230,

Sony Ericsson K750i and the Samsung X600. My main
considerations are a brilliant display and good image
capture. My budget is Rs 16,000.

Aroop Patel

With your considerations in mind, I’d
suggest the K750i. Apart from what you

have asked for, the K750i also has features such as
a good media player, FM, Bluetooth, etc. Nokia’s
3230 is also a good handset if you are a Nokia fan.
The Samsung X600 and the Nokia 6600 are too
dated, and shouldn’t be at the top of your list. 

I don’t think the
Xbox 360 will
come to India
until the
broadband
infrastructure
improves
significantly

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related ques-
tions in this space.

Ask Away!

Ask Agent 001
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The bubble jet printer makes use of
a small ink-vapour bubble inside the
ink chamber

When the printer has something to print, it sends
a signal to a heating element, which starts to get
hotter. The vapour bubble expands from this heat,
pushing the ink towards the nozzle

When the bubble gets big enough, the
ink is finally pushed out of the nozzle
onto the paper

When the heating element
cools down, the bubble
becomes smaller, allowing
ink from the ink reservoir to
enter the chamber

How Inkjet  How Inkjet  

Bubble Jet Printing 



Piezoelectric Printing

Digital Passion l Visual Explanation

The piezoelectric printer works using the property of
some materials that makes them expand or contract if
an electric current is passed through them

When there’s something to be printed, the printer
sends an electrical signal to the piezoelectric crystal,
which starts expanding, pushing ink towards the nozzle

When the crystal has expanded to its
fullest, it pushes the ink out of the
nozzle onto the paper

When the electrical signal stops,
the crystal returns to its normal
size, and more ink can now come
into the chamber

  Printing Works  Printing Works

Piezoelectric Printing
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Ideal Material Management 
Since it opened in 1997, The Orchid has been using
the ShawMan Material Management Software
(MMS), a comprehensive program that  manages
the inflow and outflow of goods, generates regular
consumption reports and thereby facilitates
supply chain management. 

Shailesh Bhagwat, EDP (Electronic Data Pro-
cessing) manager, of the hotel says, “Whenever
there is a requirement for a product—be it a bar of
soap or a sofa set—the concerned department
makes an entry in the ShawMan MMS. This requi-
sition is authorised on the software by several per-
sonnel before it reaches the purchase
department.” 

The Orchid has made innovative use of the
ShawMan MMS by assigning ratings to its
retailers based on the reports generated by the

Renuka Rane 

ocated close to Mumbai airport, The
Orchid is Asia’s first certified eco-friendly
five-star hotel. Popularly called an “Ecotel,”

a term used for environmentally-conscious hotels,
The Orchid has received numerous awards for
being a pioneer amongst such hotels. It has used
technology extensively to further its commitment
to the environment, and also to keep a track of all
activities on the premises. 

The Orchid uses 43 software to  maintain
extensive digital records and manage processes
such as property management, material manage-
ment, accounts, inventory, and more. 

L

Online Degree Acceptance110

Wired Hospitality
Innovative use of
software can help
deliver better
service, maintain
quality levels, 
and more
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and this information is used by the hotel to serve
customers better.

The screen is akin to a spreadsheet, and shows
all statistics about the 245 rooms in the hotel—
from indicating which rooms are occupied to
whether there’s a ‘Guest In’ or ‘Staff In’. This data
appears automatically thanks to the key card every
guest has to insert in a slot at the doorway of the
room. Other details of guests’ requests for services
become visible on the Orchid Honour screen. 

This is possible courtesy the bedside Pamba
panel in each room, a microprocessor-based room
control system. The Pamba panel has switches that
let the guest control appliances in the room, and
call the butler. A unique feature here is the ‘Eco’
button;pressing this increases the temperature of
the room by a mere 20 C, thus helping save elec-
tricity. Bhagwat adds,“In air-conditioned rooms,
one gets accustomed to the interiors after a while
and a slight rise in temperature is not perceptible”.
Even the information of how many guests have
pressed the button, shows up in Orchid Honour.
Guests are informed about the “Eco” feature of the
panel, and those who press the button get a cer-
tificate of appreciation.

If there’s a guest complaint, it appears high-
lighted in green on the Orchid Honour screen. If
it’s not resolved within a specified duration, the
complaint gets marked red, and the matter pro-
ceeds to the seniors. The software has a paging
interface wherein any complaint is also sent as a
beep to the pager of the duty manager on the
floor. The hotel is now trying to expand the soft-
ware’s reach to mobiles so that SMSes can be sent
to the concerned personnel. 

The software also records all pertinent data
about guests—including demographic details,
number of visits, duration of stay, food prefer-
ences, and so on. Equipped with this information
generated by Orchid Honour, the hotel is able to
offer loyalty programmes to guests. 

Tech All The Way
At The Orchid, technology has revolutionised the
way information is managed. It has streamlined
activities and reduced the probability of human
error, at the same time increased productivity and
quality levels, and reduced costs. Some aspects—
such as the ‘Eco’ feature in rooms—are unique to
the hotel. But given the benefits and the ease of
use of software such as the ShawMan MMS, any
three, four or five-star hotel would do well to move
towards centralised control. 

renuka_rane@thinkdigit.com
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software.  When goods supplied meet the hotel’s
standards, suppliers are assigned ratings based
on parameters such as rate, quality etc. All these
are recorded in ShawMan. The MIS (management
information system) reports that ShawMan MMS
generates gives a complete picture of stock
received and dispensed, and helps the adminis-
tration team decide on the best suppliers. These
results are on our database, suppliers have to
maintain the same quality at our other outlets.

The software, according to Bhagwat, simpli-
fies things: “Though the process seems long-
drawn, it actually takes just a few minutes and at
the same time generates a higher degree of
accountability.” 

Efficiency And Cost Control 
There’s more to the ShawMan MMS than its ability
to maintain records and rate suppliers. When The
Orchid issues tenders and invites quotations for
items, details such as the lists of goods, quality,
rate and product codes, are maintained in the soft-
ware. ShawMan MMS thus keeps track of the move-
ment of materials between vendors and stores, and
helps get quality goods at best prices—an example
of how centralised software can aid a business.

The Orchid has instated annual rewards for the
best suppliers, who win the hotel’s patronage.
Being an ISO certified organisation, The Orchid
also sends personnel to suppliers’ warehouses and
thus ensures that standards are maintained. These
results are maintained in the ShawMan MMS.

Recipient of The Orchid’ “best supplier” rating
since 2002, Fruit Supplies, in Khar, Mumbai, has
been supplying goods to the hotel since its incep-
tion. Proprietor Vilas Shinde says, “We have to
follow strict standards for deliveries. The Orchid
also sends personnel to survey our godown,
ensure timely delivery and good quality. The rat-
ings have given us an incentive to work harder.”

Inventory control is another area where
ShawMan MMS is a big help: if a hundred bottles
of wine have been supplied, using the software,
one can keep track of each and every bottle,
leaving no scope for pilferage. Moreover, ShawMan
has been tweaked so that requisitions are accepted
only if they have been budgeted for.  

Ecology And Technology 
The other critical software the hotel uses is Orchid
Honour, which was developed in-house to meet its
specific needs as an Ecotel hotel. Based on Visual
Basic, the Orchid Honour software helps the
administration see all occupancy-related figures

Having a
centralised
software generates
higher degree of
accountability”

Shailesh Bhagwat
EDP Manager
The Orchid 

ShawMan MMS ensures error-free inventroy control

The Orchid Honour provides detailed data on occupancy



Mithun Kidambi

log, one of the fastest growing applications
on the Internet, is increasingly making its
presence felt in the corporate world. Gen-

erally viewed as an online journal that records any-
thing and everything that people think—be it
about their new car or someone else’s, blogs have
moved on to become one of the most potent mar-
keting, PR and CRM tools a company can have. 

It is easy to customise a blog and companies
worldwide are quickly picking up the trend.
Besides using the blog to promote themselves, cor-
porate offices use it to maintain a certain level of
transparency within their ranks. Companies can
also exploit blogs to engender strong relationships
with their customers and the media.

Here, we attempt to answer some basic ques-
tions: What are the uses of a blog? Why is it smart
business to have a corporate blog? Who in the com-
pany must be allowed to blog? What are the rules
that must be followed while maintaining a corpo-
rate blog? What sort of companies would gain the
most if they set up a blog? 

Let’s Get Started!
A blog is very similar to a Web page that can be
updated using a simple WYSIWYG (what you
see/what you get) interface. Most major Internet
companies and portals host a blog service such as
Google’s Blogspot and MSN’s MSN Spaces, that
have tens of millions of registered users.

Various methods can be applied if you want to
set up a corporate blog. Blogging tools can be
found on the Internet, and a few can be down-
loaded for free. The article in this section last
month (Digit, December 2005) spoke about setting
up a wiki at work. 

All wikis come loaded with a blogging appli-
cation, so you don’t need to set up a separate blog
if you’ve already have a wiki installed. Most con-
tent management systems today come with a
blogging application that can be installed. So don’t
bother downloading a blogging application if your
company’s Web site has a one installed.

A few firms also opt to let their employees and
management post their blogs on independent
service providers such as Xanga and Blogspot. How-
ever, if the corporate blog you plan to set up aims

Corporate
blogging can be
innovatively
used to boost
business and
improve
communication

Blogs Mean Business
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to improve the branding of your company or adver-
tise its products, then it would be ideal to have a
blogging application installed on your Web site.

Put Blogging To Good Use
Ideally, blogs should be more than just an exten-
sion of the marketing and advertising arm of the
company. It’s unreasonable to expect people to
repeatedly visit your blog if it’s used to promote
the company or its services. Corporate offices can
use blogs to regularly post company news. Macro-
media (radio.webblogs.com) used blogging to their
advantage when business slackened. 

Macromedia’s blog acted as a forum for man-
agers to discuss new product launches, to place
products before developers and users and obtain
feedback. It enabled a one-to-one correspondence
between consumers and  project leaders. The blog
also gave links to the best Flash examples, inter-
esting tips on using the software, and instances of
the most irritating bugs in the software. 

The result of the interaction on blogs is that it
reduces the feeling of an “Us vs Them” that most
consumers have towards any corporate entity.
Additionally, a blog builds up a certain level of
communication within the company. IBM, for
instance, has an internal podcasting system, which
puts up audio files on the Web that can be down-
loaded and played as a radio broadcast. Employees
use these podcasts to air their views on an open
platform, and IBM claims to have acquired a few
good product ideas through this service. 

While company Web sites provide detailed
technical specifications about their products, a
blog might offer new information due to its inter-
active nature. A blog can cover smaller issues that
people are eager to discuss, possibly creating a
loyal fan base in the process. 

Another good example is Apple, which set up
a blog (appleblog.com) to explain the intricacies
of their new photo-editing suite, Aperture. The
blog was a personal interaction between the
project lead, Joe Smith, and users who were eager
to know what Apple offered and how the software
differed from that of its competitors.

Corporate blogging could also act as a recruit-
ment tool. For instance, a blog that details the
work lives of employees or projects the company is
undertaking may attract individuals who are con-
sidering working with the company. A company
could put up details of its management style, focus
and future prospects. This could aid prospective
employees make a decision.

What Do I Post Online?
So how does one determine whether a corporate
business blog is well-written? The best blogs are
lively, relevant, straightforward, informal yet pre
cise. The content should be well presented. More-
over, people who are in a position to answer
queries posted by viewers must update the corpo-

Corporate
blogging can be
an effective
recruitment tool
as blogs detailing
work lives of
employees may
attract candidates

1. Be authentic
2. Be an unmatched resource
3. Once you start, don’t stop
4. Keep it relevant
5. Measure your effectiveness
6. Monitor other blogs
7. Trust your employees

8. Use blogs for knowledge 
management

9. Use wikis for employee and 
customer collaboration

10. Develop an organisational 
content strategy 

(Source: MarketingProfs.com)

Ten Cardinal Rules of Corporate Blogging

rate blog. Regular updates prevent boredom and
complaints. It helps if the blog also gives readers
insight into the interest areas of the author.

However, the author must bear in mind that
information given on the blog should be consis-
tent with the official line of the company. Of
course, sensitive company details are not to be
divulged. Some companies such as Microsoft and
HP let employees blog without too many restric-
tions. Others, such as Macromedia and Apple have
blogs maintained by project leaders and business
heads. Microsoft now has a blog (blogs.msdn.com)
that’s updated regularly by a senior level manager
in the consumer relations department. This blog
aims to keep a dialogue on between the company
and the consumer.

Nowadays, it has becomes rather necessary for
the CEO to maintain a blog if he is unable to have
a one-to-one interaction with all employees of the
company on a weekly basis. CEOs such as Mark
Cuban of the Dallas Mavericks, an NBA team, use
blogs to expand on the news stories published in
the papers about his company. Others like Rajesh
Jain of Netcore Solutions use them (emergic.org) to
focus on trends in the Indian IT industry.

All The Bare Facts
With all that a blog can do, it’s easy to overlook the
constraints that a corporate blog might face. Blogs,
by their very definition, bring publishing power
down to an individual. A blog is supposed to be a
freewheeling discussion between the blogger and
the reader. However, official policies of the com-
pany may be otherwise. 

Few companies would relax their stringent
media policies and allow open dialogue between
employees and outsiders. No company can be com-
fortable with the idea of sensitive information
being given to the public for ready consumption.
This, in turn, makes the whole idea of a blog inef-
fective. Despite there being blog tools which have
embedded levels of permission and accessibility,
corporate offices are apprehensive of the security
these offer. 

Software companies, media firms and other
organisations would do well to set up their own
blog. It’s in such a scenario that enterprises can
benefit as they can formulate their code of con-
duct and media policies keeping in mind the
emerging trend of blogging. After all, blogs are an
open forum to discuss the company’s ideas with
the consumers. As long as technical rigours are
worked out, corporate blogs can prove to be a very
effective means of communication to the advan-
tage of the company. 

mithun_kidambi@thinkdigit.com

Appleblog.com explains the features of its new products



110 DIGIT JANUARY 2006

Trend

Ithink the concept of online education is fantastic.
It’s a great method to open up education and
eliminates the need for people to relocate for their

studies and thus brings a whole world of
opportunities into the convenience of one’s home. 

We strongly support and encourage online
education in our organisation. A number of
employees are currently enrolled in online
programmes and we also have many e-learning
courses on our intranet.

I think that online degrees would be relevant in
fields like management, financial services, and as
refresher courses for working executives who would
not have the time to go to a traditional institute.

As an employer, I would not differentiate
between candidates who hold online degrees and
those who attended traditional brick-and-mortar
institutes. What would matter to me is the person’s
attitude, experience and capabilities. 

Online degrees are catching on fast abroad, but are yet to take off
in India. I feel that online courses are excellent for offbeat or
niche areas of study where fewer students enrol. In a traditional

institute, courses are held provided there’s a minimum batch size—there
is no such restriction online. It’s still time before professional
qualifications obtained online find acceptance, but supplementary and
post-graduate degrees are gaining ground.

For employers, judging the quality of an online programme would be
easier in fields like IT, Math etc. where the stress is on mathematical and
analytical abilities. For subjective fields like Management or Arts, it
would be difficult to pin it down and one would then need to look at the
quality of teaching; and this is where I think that having a traditional
degree might be more desirable. All things remaining constant,
prospective employers wouldn’t have issues with a candidate with an
online degree—the potential and promise the candidate shows would
take precedence. 

Gul Raj Bhatia
Country Manager, Marketing
Imaging and Printing Group,
Hewlett-Packard Sales 

The basic concept of online education has been around for a long
time, in the form of distance education. The former is a more
convenient way to deliver the same knowledge. Distance education

is suitable only for some degrees. For intsance, it’s fine with technical
education as opposed to an MBA, which requires a face-to-face interaction
and team work as part of the learning process. 

Personally, without sounding like a luddite, I’d like to sample the
actual knowledge dissemination process for online education, before
passing judgement. What a student gains from any education depends
very strongly on the quality of the pedagogy, as well as the motivation of
the student. That would apply to online education too, and perhaps more
so, with the reduced face-to-face interaction and supervision, and the
need for a self-driven schedule at times. 

As technology and bandwidth progress, we have access to richer and
better content on the Web. That will surely have a positive impact on
online education in the future.

Saurabh Kanwar
National Head, Marketing
Radio City

Kaizad Pardiwalla
Vice President
OgilvyOne Worldwide
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Do online degrees merit similar status as traditional on-campus programmes? 
Digit gets the employers’ and placement consultants’ take 

Online Degree
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Deepank Jain
Staffing Manager,
Intel India

Ajay Mallapurkar
Center Head,
Ma Foi Management
Consultants

Big names like Harvard University offer online degree
programmes, reaching out to students who seek the backing of
the brand, but cannot afford the high cost of relocating and the

tuition fees of such elite institutions. 
The value of an online degree from a reputed college might not

compare much with the traditional programme of the institute, but
since these institutions can still be selective about their admissions,
the brand value would still hold strong. 

A concern for students taking online courses is that they aren’t in
personal contact with their teachers and peers. Thus, they would miss
out on learning in person. Moreover, they must look at the selectivity
of an institute for an online programme—if the criteria are lax and a
large number of students selected, then the brand value of the course
is somewhat diluted.

It is still premature to say how online degree holders will fare when
compared with their traditional counterparts, but we should see online
degrees gaining massive popularity by around 2010.

S C Bhatia
Chief Executive,
Datamatics Staffing
Services

In India, online degrees are still picking up momentum. The relevance
of an online degree would also depend on the field—skills that are
required in the technology industry, for example, would require a lot

of hands-on training and lab work and an online programme cannot
offer the same. 

An online degree would be useful in general, non-technical fields like
management. At the ground level, though, I don’t think that an online
degree is a substitute for a degree obtained at traditional institution.
Online degrees would help people build high-level skills in their current
professions. Students could enrol for online degree programmes as a
source of continuous development to enhance specific skills. 

At Intel, we are still evaluating the relevance and applicability of such
degrees to job profiles in our company. Currently, we look for skills that
are highly technical and are supplemented by practical experience.

As told to nimish_chandiramani@thinkdigit.com

The bitter truth that candidates with MBAs must deal with today
is that they fall in one of only two categories—those who are from
a top-rung institute and those who are not. The latter category

are practically on a level playing field in the job market. A candidate’s
resume would reflect his qualification and experience—after that, the
interviewer may or may not find out whether the course was done
online or not depending on the direction the interview takes. If the
candidate’s profile speaks for him, the topic may not even come up.
What matters is the individual’s profile and work experience.

We have a good number of candidates in our database who hold
online degrees. I have personally interviewed some of them who hold e-
MBAs; I feel that for MBA degrees, at least, an online course lacks the
academic rigor and depth that a traditional degree programme offers.

When recommending a candidate to a company, I would focus on
the candidate’s experience rather than worry about whether the
qualification was obtained online or not.

Acceptance



Digital Leisure l Touched by Tech

Renuka Rane

Awonderful example of how
useful the Internet can be,
a blog has it all—from

being an online confessional
diary to becoming a platform to
rave and rant, and critique and
praise any and every subject
under the sun. And if bloggers
were to utilise some of their free
Web hosting space to promote a
worthy cause, it just could help
someone in need. 

Espousing a social cause on a
blog allows a blogger to do just
that: a blogging contest in aid of
cancer awareness has been
launched in Chennai. To partici-
pate, bloggers need to put up

content on their blogs

supporting the ‘Can Conquer
Cancer’ initiative. You can find
the contest at http://connexion-
sonline.biz/ conxw/ican/.  

What It’s About 
The contest was started by Mura-
likrishnan R, CEO of Quicksilver,
a placement agency. The idea of a
blog contest to promote aware-
ness came to him after the
tsunami of 2004. He says about it,
“The blogging circuit came alive
like never before to mobilise
resources for the tsunami-hit
regions and get help. I realised
that blogs can make a real differ-
ence in spreading awareness and
help dispel myths—in fact, the
use of a blog can achieve much
more than an e-mail or Web site
based campaign.”

An avid blogger himself,
Muralikrishnan also manages
the promotional work of Connex-

Technology Beyond Work
Leisure
Digital

ions, a popular departmental
store in Chennai. Connexions,
which is a major sponsor of the
blogging contest, recently joined
hands with the Rotary Club of
Chennai Metro to promote the
“Can Conquer Cancer”
programme. 

Murali further adds, “We
believe that there’s an upside to
any challenge, so when it comes
to spreading awareness about
cancer, we wanted to get every-
one involved. Essentially, we
want to spread the message that
cancer can be conquered, and get
everybody to do their bit.

“Our efforts aim at infusing a
positive attitude among bloggers
and readers and providing hope
to those battling the disease”. 

Can Conquer Cancer
The contest, which began on 28
November 2005, is still on. As the

Touched By Tech

Illustration Pradip Ingale

Blog For A Cause 
Blogs can 
go much
beyond
being online
diaries.
Here’s a
blogging
contest that
aims to
promote
cancer
awareness
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review and rate contest entries.
And five winning blogs are
slated to receive various prizes
including a USB 128 MB podcast
device, 350 MB of hosting space,
T-shirts, music CDs, dinner
coupons, and more. 

Moreover, all entrants will
have their blogs featured on the
popular online portal—
Sulekha.com. While contestants
retain the intellectual property
of their posts, Connexions will
use the entries as a hyperlink,

Connexions site states, “Blog a
smile, Blog a while, Blog what-
ever you feel like, but just
remember your writing could
help someone conquer cancer.
Lend a healing touch to your
imagination and watch how far
your keyboard strokes can go
towards motivation and
support.” 

The theme of the contest is
“Can Conquer Cancer.” Entries
can be in prose or verse and must
be 500 words in length. The
content must be motivational. It
can be a personal or a second-
hand experience, and has to be
original work. Even photo-blog-
ging, provided the photograph is
original, is permitted. 

With only one entry per
blogger, the contest is open to
bloggers worldwide. However,
blogs have to be in English.
Participants are required to
include any of the “i-CAN”
banners available on the Connex-
ions site to show their support to
the initiative.

Entries will be judged for
originality, content, style of
language and the message they
portray. A seven-member panel of
judges including four bloggers
and three non-bloggers will

Blogs can
make a real
difference in
spreading
awareness
and help
dispel myths
Muralikrishnan R
Connexions.com

feature them, or just display
them on the Connexions or any
other partner sites.

The Response
The Connexions site recorded
over 40,000 hits within the first
week of the contest being
announced. Some entries are
poignant—more so the ones that
include reminisces of the expe-
rience of cancer patients the
participants personally knew.
Other entrants have composed
inspirational poems, narrated
incidents, and even drawn
sketches, all revolving around
the theme of combating cancer. 

Smitha N, a blogger based in
the UK, says, “I have lived
through the life of someone
who faced the Big C, and I saw
her emerge though pain in such
a gallant, beautiful and smiling
way. So, I can empathise with
and feel the importance of this
initiative. More importantly, I
learnt that the big C is not that
big after all. That was the
moment I decided to celebrate
life. I am sure this initiative will
bring a few smiles to those diag-
nosed with cancer, and pass the
message that they ‘can’—and
emerge unscathed!” 

Another participant, Prabhu
Karthik, a software professional,
posted, on his blog, a first-
person account of family
members and close friends
suffering from cancer. 

Karthik says, “I believe blogs
provide a platform to write
about certain events that spur
you to write about them in the
first place. The reason I decided
to enter the competition was
not for the prizes, but the fact
that I would get a chance to
create awareness about cancer.
There’s a possibility that an
online search on cancer-related
issues could lead to my blog.
And if users read my posting   on
cancer and are benefited by it,
in terms of information, I would
consider my work done.” 

Muralikrishnan mentions
that in the future, Connexions
will try to promote other issues
such as AIDS awareness and
child abuse through more blog-
ging contests. In this way, such
contests would give bloggers an
insight into the pain and suffer-
ing of fellow humans, and help
prevent and curtail that by
creating awareness. 

renuka_rane@thinkdigit.com

Log on to Connexionsonline.com to participate in the ‘Can
Conquer Cancer’ blogging contest 
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Which browser has not been
in the news recently for

vulnerabilities?
a) Opera              c) Internet Explorer
b) Netscape        d) Firefox 

Which popular game console
has, or will have, in-built

parental controls?
a) The Xbox 360
b) The Quantum Fireball
c) The Nintendo Revolution
d) The Sony PlayStation 3

In which country has the
launch of the Xbox 360 been

reported as “lacklustre”?
a) The US c) Japan
b) The UK d) South Korea

Maxell plans to ship its first
holographic storage system in

late 2006. What will be the capacity
of a single disk? 
a) 1,600 GB c) 16 GB
b) 160 GB d) 1.6 GB

Alexa, a search company, is
opening up its index to anyone

who wants it—for money, of course.
Alexa has about five billion
documents in its index—about 100
terabytes of data. Who owns Alexa?
a) Amazon b) Microsoft
c) Intel d) Apple

A new top-level domain (TLD)
has recently been the subject

of a controversy—namely, whether
to approve it or not. The TLD will
cater to pornographic sites. What
is it called?
a) .sex c) .smut
b) .xxx d) .porn

What does the term
“Googlewhacking” refer to?

a) Formulating a search query that
brings up just one result

b) The act of putting up blog posts
that portray Google negatively

c) The act of pitting Google against
other search engines

d) Getting a job at Google’s HQ

What is Symantec soon
expected to do with its

popular products such as 
Norton AntiVirus?
a) Make them available for free
b) Increase prices while improving 

features and scan times
c) Make the products available as
online services

d) Merge them with McAfee’s
product lines

From which of the following
acts or supposed facts does

the term “booting” originate?
a) Early computers had to be kicked

to make them start
b) One can lift oneself up by 

pulling on one’s own bootstraps
c) The sector on a hard disk that 

stores data related to starting up
is called the boot sector

d) Boots, the pharmaceutical 
company, had a patent on the 
software that started up some 
early computers
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ACROSS
7. Search _______ provides Web site access (6)
8. Computer programme that interacts

with a particular device/software (6)
9. Windows NT Server (abbr) (4)
10. Portable disk with removable

cartridges (3,5)
11. End a program (5)
13. Carry out a function (7)
15. Information Services Electronic

Archiving (abbr) (7)
16. Unit of length (5)
18. File transfer from server to

desktop (8)
20. Computer-aided software

engineering (abbr) (4)
21. One millionth of a meter (6)
22. Synchronous DSP specification

language (abbr) (6)

DOWN
1. Set up computers for use (8)
2. _______ Wall-security measure (4)
3. Get hold of illegal software (5)
4. Plug or circuit board (7)
5. Power source for electronic 

devices (5,4,4)
6. SM in ‘SMB protocol’ (6,7)
12. Input devices that reads images converting it to digital

signals (8)
14. An e-mail _______ (7)

17. Automated Data Reports Submission System (abbr) (5)
19. Leave out part of text (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
tq@thinkdigit.com
Mark “TQ” in the
subject area.

All Part Of The Game
OK, so
Google is

popular enough
to have become
a verb. But of all online searches
conducted, how many actually 
use Google?

a) 36 per cent c) 76 per cent
b) 48 per cent d) 92 per cent

1

December 2005 Solution 

Answers

The ‘Stoned’ or ‘New
Zealand’ virus was a

classic computer virus,
which when it struck,
the computer displayed
the message “Legalise
Marijuana”. 

‘Tux’ is the name of the
official Linux mascot. 

Did You
Know?

Send in your answers to
the crossword with
complete contact details
to TQ@thinkdigit.com on
or before January 15. 
One lucky participant will
win Writing Effective
Use Cases
by Alistair Cockburn 
published by Pearson Education

8. a) Formulating a
search query that
brings up just one
result of mechanisms
9. c) Make them avail-
able as online services
10. b) One can lift one-
self up by pulling on
one’s own bootstraps

1.b) 48 per cent
2.b)  Netscape
3.d) The Sony 

PlayStation 3
4.c) Japan
5.a) 1,600 GB
6. a) Amazon
7.b) .xxx

Win!

Shailesh Patel of Bhopal wins the prize for
the December 2005 crossword

Crossword by Nitta Jaggi
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More and more people are using their PCs
as TVs, and software is being developed
by the dozen to help you get the best from

your TV-Tuner card. With Media Center PCs
becoming more popular, TV-Tuner software are
also being better designed; however, Personal
Video Recorder (PVR) software hasn’t entirely lost
out on presence. These software tune in to TV
channels, and capture screenshots and video in a
compressed format. Some can pause a TV show. 

The interface apart, the thin line that separates
PVR software from Media Center software is the
latter’s additional functionality that integrates
DVD, radio, picture and music playback capabili-
ties using a remote control, while retaining the
capabilities of PVR software.

The major parameters that we based our
comparison of PVR software on were ease of use,
features and performance. We took a detailed look
at six software in all—ChrisTV, iuVCR, NeoTV,
PowerVCR II 3.0, WinDVR, and WinVDR.
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If you have a TV-Tuner, you need PVR software. Here's a little
comparison of some of the better ones out there

Capture, Control, Create

ChrisTV
ChrisTV is a unique contender in the category of
PVR software—unique because the interface is so
dull! But make no mistake—all the functionality
is there: everything you need is a right-click away.

Ease Of Use
Installation is wizard-based, at the end of
which you’re prompted to configure the
settings. The process also includes setting up a
video capture device. This is an important step;
make sure you select your TV-Tuner card, since
your graphics card can also serve as an input
source for PVR software.

The interface is compact and the colour
combination dull, like we said. It looks like a
failed attempt at aping the Mac OS user inter-
face! The buttons on the panel make all the
important functions accessible. Advanced
settings become accessible with a right-click.
Clicking the “gear” icon button opens the
‘General Settings’ menu. This menu is at the
heart of ChrisTV’s configuration.
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Features And Performance
ChrisTV probably has almost all the features
you’d look for in a PVR software. It has the time-
shift feature by which you can pause a telecast,
forward through ads, and create your own TV
replay. This feature has three modes of opera-
tion: software DV encoder, software MPEG
encoder and hardware MPEG encoder. (The time-
shift feature works only with Windows XP,
Windows Media Center Edition or higher.)

Recordings can be stored as MPEG, AVI,
XviD, and more; recording is supported with
many codecs to choose from. The channel
preview and the recorded video quality are
satisfactory, whereas the snapshots (which can
be taken in the JPEG and BMP formats) give
remarkably better results.

Another prominent feature is the scheduler.
ChrisTV allows a user to schedule recordings
for the entire week. Just select the day of the
week and set a timed recording for that day—it’s
that easy!
Link: www.chris-tv.com

iuVCR
iuVCR features a simple interface, beneath
which lies a variety of features and options.
This software also features radio tuning (if your
tuner card supports it).

Ease Of Use
Installation is, again, wizard-based. The interface
design is so sober, it looks like software from the
Windows 95 era. The configuration options are
classified under the ‘Video’ and ‘Audio’ tabs. An
‘Info’ tab shows the important settings for
recording and compression. It also displays other
technical information, such as file size and
frame rate in fps along with a graph. Overall, the
interface may be confusing at first glance, but
you’ll find it is very organised once you’ve under-
stood the classification of the settings.

Features And Performance
Basic features include TV channel tuning, TV and
video capture, and compression of captured con-
tent to various formats including DivX. You may
need to install a codec pack on your Windows
machine before you can choose from various
compression formats for your capture. (We
installed K-lite Mega Codec pack.)

Capture/Recording can be controlled by
limiting it within a time frame, or by punching
in the maximum file size. Moreover, captured
files can either be saved in a particular folder in
a partition or in different locations across hard
disk partitions. 

This software offered scheduled and timer
recording. With timer recording you can set the
software to record for, say, the next one hour; with
scheduled recording, you can instruct the software
to record from, say, 5 pm to 7 pm for any specific
channel or input!

The schedule feature wasn’t very impressive,
though—it restarted the iuVCR software at the
scheduled start time, and it often recorded from
the wrong input. Overall, iuVCR is just about OK.
Link: www.iulabs.com/iuvcr/index.shtml

NeoTV
NeoTV needs to be tweaked by the developers;
there is plenty of room for improvement in
video recording as well as the user interface.

Ease Of Use
When NeoTV is run for the first time at the
end of the easy installation process, it requests

The configuration
settings of iuVCR are
classified under the
Video and Audio tabs

The video record settings in the ‘General Settings’ dialog
box have tabs and sub-tabs for finner record settings

The broad parameters considered for testing Personal Video Recorder software
were ease of use, features and performance. Our purpose here is to identify

and recommend one software that will serve your requirements on all counts.
Our Test Machine: We tested the PVR software on a Pentium IV 3.4 GHz dual-core
CPU with 1 GB of DDR 2 RAM and a LifeView FlyTV Prime 30 TV-Tuner card. A VCD
player connected to the Composite input of the TV-Tuner card served as the input
signal for testing purposes.
The Test: Software should be easy to use and configure. Keeping this in mind, we
looked for a clean interface and easy-to-use methods for configuring and setting
up the software.

Apart from the standard features, we also looked for the ability to zoom in
while watching TV, pause, and tile displays (showing more than one channel on a
single screen). Such features earned a software extra points.

Of course, we didn’t want software which had great features and which was
really easy to use, while not being able to capture video properly. Therefore, we
gave as much weightage to the quality of video capture as to the features and
ease of use.

How We Tested



Digital Leisure l Test Centre

120 DIGIT JANUARY 2006

you to set up audio/video sources and chan-
nels. You are taken to the ‘Configuration
Options’ dialog box. After you’re done with
setting up the software, the rather ordinary
blue user interface shows up. Moving the
mouse pointer over the buttons reveals their
functions. There aren’t too many options on
the panel for setting up the software, which
makes NeoTV good for first-time users.

Features And Performance
A unique feature in NeoTV is the reconfigurable
Hotkey option. User-defined keys can be set; this
helps you easily remember the keys you set for
various functions such as record, stop, next
channel, previous channel, etc.

NeoTV can handle recording of telecasts in
MPEG, VCD and DVD formats, and snapshots are
saved as BMP files. The quality of snapshots is
really good, but we couldn’t judge the quality of
video capture—the saved file turned out to be
corrupt. Our repeated attempts to capture video in
different formats were in vain. Given the fact that
we weren’t even able to capture video, we can’t
recommend NeoTV.
Link: www.mediostream.com/products/
index_neotv.html

PowerVCR II 3.0
CyberLink’s PowerVCR II is the most commonly
bundled software with most TV-Tuner cards.
With the advent of Media Center PCs, CyberLink
now supplies PowerCinema. Nevertheless,
PowerVCR II still has the punch to be amongst the
most-sought-after PVR software.

Ease Of Use
The procedure for installing PowerVCR II 3.0 was
somewhat lengthy—it installs the Intel Indeo
codec pack right in the middle of installation.
The option to not install Indeo wasn’t offered.

Those who have used CyberLink products
earlier will know the characteristic interface
scheme—it resembles an actual DVD player with
knobs and buttons. A similar scheme is used here,
more like a blend of a set-top box and a DVD player.
The preview screen looks like a flat plasma TV. 

A side panel bar is provided to directly access
certain features such as the recording scheduler
and the DV Tape Transcoder. Overall, the inter-
face and the software are elegantly and profes-
sionally designed.

The software starts with a hunt for channels
and stops at the very first signal it detects; detec-
tion is so fast, you’ll notice it only if you discon-
nect the TV cable and connect only the composite
input. This is of immense help, because you don’t
have to dig around in the configuration settings to
set an input mode for the software—the available
signal is quickly detected.

Features And Performance
Despite the professional look of the software,
PowerVCR seemed to be lacking on the features
front. Its closest contender is WinDVR, which
impressed us with its performance and features;
read on to see whether PowerVCR can keep its
winner tag from a couple of years ago.

The snapshot feature took images only in
BMP format, and although the clarity of the
images was commendable, it would have been
nice to have an option for JPEG.

The ‘Instant TV Replay’ feature allows you to
pause a live telecast while it (the ongoing telecast)
is being recorded to disk. You can, therefore, replay
and even forward ads at will. The file converter
helps convert a captured file from MPEG to other
formats such as AVI.

If you want to record everything on your
camcorder to DVD, you can use the ‘DV Tape
Transcoder’ feature, which converts your DV files
to MPEG. Creating a DVD from this is accom-
plished via the ‘Direct burn to DVD’ feature.

The TV channel preview quality was very
good; in fact, PowerVCR and WinDVR were the
only two PVR software that showcased grain-less
picture reproduction. Video captures are stored
by default in the MPEG format. The quality of the
capture was also very good—we didn’t see any
jerks, nor did we notice any pixelation.

All in all, PowerVCR might well be the best
PVR software out there—which is also probably
reason for it being bundled with most
TV-Tuner cards!
Link: www.cyberlink.com/multi/download/
trials_2_ENU.html

WinDVR Version 3
Two years ago, we did a similar comparison.
WinDVR finished as the challenger to
PowerVCR. Now we’re back to our testing desk,
looking for something new in WinDVR!

A user-customisable hotkey is avaiable under NeoTV’s
configuration settings

The interface of PowerVCR is very similar to that of
PowerDVD. Most features are accessible on the panels
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Ease Of Use
A wizard guides you through the installation process. The UI
might seem cluttered at first, but the functions of the but-
tons soon become clearer. You shouldn’t have a hard time
configuring the software to tune in to TV channels and
other inputs such as Composite. The configuration options
are well-defined.

Features And Performance
WinDVR is a promising piece of software,
considering its feature set. First, the live TV
preview was outstanding. The preview did-
n’t show up any pixel
grains. Colour repro-
duction did seem a lit-
tle dull, but that can be
corrected from the
colour settings in the
configuration options.

WinDVR helps you
take a closer look at a
channel telecast by a
nifty implementation of
the zoom feature. This
helps you to magnify a
selected area with negli-
gible distortion.

If you want to see
what’s going on on, well,
16 channels simultane-
ously, then multi-chan-
nel preview is what you are looking for. Yes, WinDVR allows you
to watch 16 channels at the same time! The quality of channel
preview as well as that of video recording were superior as
compared to almost all the other software; only PowerVCR was
close to  the quality of WinDVR.

Because the feature list thus far was impressive, we were a
little surprised to see that the recording feature was left
uncontrolled—that is, there was no time limiter or disk space
limiter option. This means that recording will continue until
it’s manually stopped—or until the disk space is exhausted!

Other features include DV-to-MPEG conversion and burn-to-
disc; these can be used together to record from a camcorder to
a disc. Barring the cost of this package, it has all the features
and quality to beat the top-rated PowerVCR II.
Link: www.intervideo.com/jsp/WinDVR_Profile.jsp

WinVDR
No, that wasn’t a typo—this is
WinVDR we’re talking about,
not WinDVR. But the similari-
ty in the names doesn’t reflect
in the quality of WinVDR.
We don’t really recommend
this software.

Ease Of Use
WinVDR’s interface is so
mediocre, it should probably
be distributed for free! The
designers don’t seem to have
put much thought into
designing the user interface.
All the configuration options
are listed under the ‘Options’
menu. And almost all the options begin with the letter ‘S’;
you’ll have to strain your eyes to find the option you’re look-
ing for. A separate playlist window is provided to list and also
play back captured videos.

In WinDVR, a floating vertical snapshot
bar lists all the images taken using the
snapshot feature

All the configuiration options for
WinVDR are available under the
‘Options’ menu

JANUARY 2006
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Features And Performance
The first impression that WinVDR makes
with respect to features is the list of video
capture formats it supports: AVI, DIVX,
MPEG, VCD,DVD, WMV, MP4, MOV… the list is
never-ending!

WinVDR does include necessary features
such as the time-limiter to control unattended
video recording, and live TV pausing. Now,
despite supporting so many video formats,
there is no Snapshot feature. This is one of the
many reasons that WinVDR lost out in this
comparison test.

The other is the poor capture quality, with
lots of pixel-grains, especially in the brighter
sections of the captured clip. The preview is
much better, though.
Link: artech365.com/winvdr/index.htm

Summing It Up
NeoTV and WinVDR lacked some features, and
the video capture of the latter product was just
about satisfactory. iuVCR had good features but
lacked slightly on the quality front.

We decided that the winner had to be either
PowerVCR or WinDVR. Since the highlight of the
comparison was the features of the software,
WinDVR leads the comparison table, along with
ChrisTV. But ChrisTV did not offer the clarity we
were looking for. The performance department—
that is, the quality of image and video capture—
belonged to PowerVCR and WinDVR.

It wasn’t easy to choose between PowerVCR
and WinDVR, but after much deliberation, we
decided that WinDVR was the winner by a very
small margin. 

anup_nair@thinkdigit.com

Scoreboard PVR Software
NeoTV
MPEG 1/2, VCD, DVD

4/6
6

6

6

4

6

6

Configurable hotkey

2.75
3
0
3
2.25
44
$30.00 (Rs 1,360)

WinDVR
MPEG 1/2, VCD, DVD, 
DV-to-MPEG

4/4
4

4

4

6

4

4

Parental control,
burn to disc

3.5
3.5
3.5
3
3.75
69
$79.95 (Rs 3,620)

PVCR II ver 3.0
MPEG 1/2, DV-to-
MPEG

4/6
4

4

6

4

6

4

Direct burn to DVD

3.75
3.5
3.5
3
3
67
$49.95 (Rs 2,260)

WinVDR
MPEG 1/2, AVI, MP4,
VCD, DVD, WMV, MOV

6/6
4

6

6

4

6

6

NA

2.75
2.75
2.25
0
2.5
41
$39.00 (Rs 1,770)

iuVCR
AVI, DivX, XviD

4/4
6

6

6

4

6

4

NA

2.75
2.75
2.5
2.25
2.5
51
$26.95 (Rs 1,220)

Video Recording

TV Image Snapshot
BMP/JPEG
Live Pause/Replay
Multi-Channel Preview
Zoom Live TV
Timer Control
For Recording
To Turn Off PVR
Scheduled Recording
Miscellaneous

Rating (Out Of 5)
Ease Of Use
Live TV Preview
Video Capture
Snapshots
Features
Overall
Cost

ChrisTV
MPEG 1/2, AVI, DivX,
XviD

4/4
4

4

4

4

6

4

Scheduler can be set
according to the days
of the week

2.75
2.75
2.5
3
3.5
58
$49.95 (Rs 2,260)
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For two releases now, EA banished us from
respectable society and sent us to the dark,
dingy world of illegal street racing. While

we did enjoy the night-time races in our mean
machines, one thing still rankled. You see, the
Dark Side isn’t much fun without a good old-

fashioned war with the goody-
goodies, and this left an
unnamed emptiness
inside. We yearned for the
days of yore when cops
from all over would stum-
ble over themselves trying

to capture us.  
With Need for Speed: Most

Wanted, EA brings some more
sweetness and light into our
lives. The racing is still
deadly fast—and just as ille-
gal, but now we have our
friendly Boys in Blue to
remind us, should that slip

our minds.

The Script
The Career Mode reveals the
plot (if you can really call it
that) of NFSMW’s story—you
are a nameless street racer
with a fine steed, looking for

a race in the small town of
Rockport. You bump into an

degenerate named Razor, who is
at the bottom of the
Blacklist—a ranking of the
best and most wanted racers
in town. He gives you the
race you seek, but sabotages
your car, steals it, and hands

you over to the cops on a silver
platter. You get out of jail and

find Razor has been using your car to get to the
top of the Blacklist. You need revenge. To reach
Razor, you must work your way up the Blacklist
by defeating each racer on it.  

The story is told in stylised full-motion video
cutscenes, and the acting is awful. So awful, in
fact, it’s actually hilarious—one wonders if EA
did this on purpose. Helping you on your jour-
ney is Mia Townsend, played by Josie Maran,
though you don’t really know why she’s helping
you. Apart from the cutscenes she keeps sending
you tips and news via text and voice messages.
You are also helped by a mysterious guy named
Rog, who also keeps sending you text and voice-
mail messages telling you what’s going on in
the racing world.

Making your way up the Blacklist isn’t as
easy as it sounds. These are elite racers, and you
need to make yourself worthy before you take
them on. You must win races and build a repu-
tation among racers and the police as a wild
menace to society. Naturally, as you move along,
this is to become tougher, but not gradually like
one would expect—your opponents seem to get a
sudden revelation somewhere around the mid-
dle, and now the slightest error can leave you
coughing up dust.

The story itself is quite cheesy, but grips you
enough to make you want to see it through to
the end. Do you get your car back? Do you get
the girl? What will Razor resort to? Find out in
the next chilling episode!

Enter The Cops…
… who are the real stars of the show this time.
Every race carries with it the possibility of their
suddenly turning up and adding some fun to
the party. Looking for a chase? The Career Mode
even lets you jump right into pursuits to get
yourself better known in lawful circles. As
usual, you can listen in on the police radio

The streets are a free-for-all now. The recipe
for the day is tune, race, irritate the police, RUN!

One with the road

Ha! Those cops won’t find me in this stadium!

Sometimes you just need faith...

Ah... beautiful, unsuspecting Rockport



band, and this is when you let yourself be
blown away by the AI—they sound like real cops
having real conversations! They discuss how
they’re going to try to take you down, and are
always chattering about your position. You start
off at heat level 1, when you are just a naughty
child to the cops. At this point, they’re quite
dumb and are as easily evaded as a short-sighted
aunt. Bug them even more and you reach heat
level 2. Then things finally start to get interest-
ing—more cars will be on your tail now, and
you will have to thunder through roadblocks
to avoid getting busted. By heat level 5 you
are being chased around by what seems to
be every car on the planet, a helicopter,
police Corvettes, and you’ve got to deal with
spike-strips.

Sights And Sounds
NFS: Most Wanted is a brilliantly orchestrated
assault on your senses. The environment and
lighting is wonderful. Road reflections are
incredible—you have the dry, diffused reflection
of sunlight or a slicker, more glossy reflection
when it’s raining. Lighting is more realistic
now, thanks to the new Overlighting effect—
now, if you get out of a long tunnel, the sun
actually blinds you for a split second while it
simulates the effect of your eyes getting used to
the light. If you reach a high enough speed, you
can watch the environment start to blur around
you, and pump some nitro into the engine to
watch the world fleet by in an incoherent haze. 

Of course, we mustn’t forget the most impor-
tant part of the game—the cars. The car models
in NFSMW are sleek, shiny, and quite close to the
real thing. There is a prolific selection of cars
ranging from the humble (read: hopelessly
weak) Chevrolet Cobalt to the awesome
Lamborghini Murcielago. The engines sound
awesome, and with a good set of speakers,
you can almost feel the machine throbbing
around you.

In keeping with the whole ‘underground’
theme, the soundtrack (delivered through EA’s
‘Trax’ system) is a hip-hop/rock combination
which we didn’t like at all, but which suits the
bling-filled attitude EA is trying to incorporate.
Thankfully, this Trax pestilence can be traded in
for regular music.

The Heart And Soul
At the core of it, after all, NFSMW is about rac-
ing, and you get plenty of it. To challenge each
Blacklist racer, you need to win a number of
races, and the challenge itself is usually two
races. On top of that, there is the Free Roam
mode, which has you zooming all over town
avoiding cops. To start a new race, you have to

be out of the ever-watching
eye of the fuzz, and as your
heat level rises, this gets
more difficult and hence
frustrating.

The racing experience
itself is unadulterated fun.
The cars feel rock solid and
are a joy for the compulsive
powerslider. Little details
like the shudder of a colli-
sion and the jump of
gearshifts have been given
due attention and do not
disappoint. Freaks for realism
will need to look elsewhere—
this game is all about the
adrenaline rush of full-
throttle racing. Even car
damage is practically non-
existent—the most you’ll
ever see is a shattered wind-
shield. This is not so for the
police cars though, and you
can have your fun watching
turn into scrap metal.

Like so many other
game developers, EA too
has discovered the attrac-
tiveness of Bullet Time.
Called the SpeedBreaker,
this lets you stop time and
try out new and dangerous
manoeuvres like dodging the police by
moving underneath trucks.
If you are being excessively
harassed by the Law, the
game offers you Pursuit
Breakers—structures across
the city which you can
destroy to keep them busy;
the game camera switches to
‘game moment cam’ to show you
just how much destruction
you are leaving behind.
This makes the game just
that much more fun. 

Even if the repetitive-
ness of racing about town
and the eons it takes to final-
ly complete the game are a
pain, NFS: Most Wanted is a
neatly packaged, well-styled
bundle of fun. From hysteri-
cally bad acting to the pure
thrill of racing, it is sure to be
another winner. 

nimish_chandiramani@
thinkdigit.com

Sometimes cops fight over you

Busted! We... uh... do this on purpose. To show you.

...and sometimes you need a ramp

We are brave

The gorgeous Gallardo

We try a “2Fast2Furious”

Better in Red



To be honest, I wasn’t very excited about being
assigned this game to review. I’m not the type who
likes WW II shooters! I opened the impressive-look-

ing packaging and pulled out the game box, only to
scream in dismay when I saw there were six CDs!
“That’s 14 times I need to open/close my optical drive!”,
I moaned—after installing the sixth CD it asks for CD 1
again. Seriously, a DVD would have been nice. (Note to
self: please inform all game companies to only send
DVDs for review!) I used an AMD Athlon64 3200+, 1 GB
DDR 400 MHz RAM, a GeForce 6600 256 MB card and an
80 GB SATA hard drive, and it still took ages to install.
“This better be a good game,” I muttered.

To my surprise, I started off as a Russian in the game
—now that was new to me. The AI is so good that even
at the normal difficulty level, the game requires a very
different approach from most of the other first person
shooters. If you run around trying to blow people away,
be prepared to start from the last save point a few hun-
dred times! The enemy AI is good, and depicts the
actions of humans well: most FPS games have monsters
that charge at you like there’s no tomorrow; in Call Of
Duty 2 (COD2), enemy (German) snipers will try and
blow you to kingdom come from within hiding, and
most foot soldiers prefer to hurl grenades rather than
try and move up to attack you! Basically, the AI knows
how to protect itself, and killing your enemies is not as
easy as point and shoot.

Despite not having played the original game, it took
me just five minutes to get used to the nuances of this
series: every now and then I’d just fall flat on my face,
deader than a doornail, wondering what hit me—then I
saw the grenade alert indicator! Overall, the learning
curve is pretty flat.

I’d turned up the visual detail to maximum in order
to enjoy the game to its fullest, but found that it can
get a little sluggish and start framing on my configura-
tion. A resolution of 1024 x 768, with 4x AA, trilinear
filtering, and with everything else left to the default
seemed to work—so that’s what I used.

The Missions
Like I mentioned earlier, I started off with team mates
who said “Come on comrade, kill the Nazis,” then came
team mates who said “A’ight mate, let’s send these Nazi
blokes back to Berlin,” to becoming a US corporal… well,
you get the drift. Whether as a Russian, British or US sol-
dier, I sure did kill a lot of Nazis. Which made me
scratch my head and think, “Does anyone in Germany
actually buy this game?”  

The missions take you through the streets of
Stalingrad, fighting off hordes of attacking Germans, on
to the African Sahara, grinding the Desert Fox’s (Field
Marshall Rommel’s) armoured forces into the dust, and
finally on to the American attack of Europe. During the
10 missions, you crawl through pipes to get behind enemy
lines, drive a tank and destroy some Panzers, and finally
hold out on European soil till your reinforcements arrive.

War is Hell!
You’re in the Army now: Playing World War II shooters was never this much fun!

Friends or foes, they’re all dead—war
really is hell!

Here comes the cavalry: the USAF
saves my miserable behind again!

Apart from shooting, you have simple
tasks to complete...

...like blowing up this building with the
explosives you planted earlier

At some points, AI is stupid: they just
kept coming down in a line and dying!

Each new campaign starts with some
authentic WW II TV footage

Then at dawn you have Germans
attacking like Japanese Kamikazes

Then you defend a British base from
marauding Germans in the desert

My first landing on a beach and I’m
promptly knocked out by a shell!

Now that’s a bug: a dead Jerry doing a
balancing act on a cliff!
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The Game
The game has a very realistic WW II feel to it, and look-
ing up at the sky you’ll often see fighters engaged in
the classic dogfights of WW II fame. There’s always
smoke on the horizon and shelling in the distance. The
reality extends to even gun models and the shape of
vehicles and grenades. The houses and streets are
authentic looking, and your gun isn’t a spanking new
factory-issued rifle—it has the notches and scratches
that come with the rigours of regular use.

Each mission starts with an actual WW II video clip,
informing you of news of the war. Then there’s a view
of your diary, which should tell you where you’re going
and why. All this combines to make an amazingly
authentic setting.

The graphics are pretty good, but after having
played Quake 4, DOOM 3 and Half-Life 2, look a little ama-
teurish. The game also has a few bugs and limitations
that can be annoying—it refused to go to the next level
a couple of times, even though I had completed all my
tasks; people were sometimes standing or lying dead in
mid-air; and the closed map design style meant you
could be standing on a boundary, blocked by something
you should easily be able to jump over or crawl under.

Speaking of crawling, increasing the difficulty level
should see you doing a lot of that! The game is hard
enough in normal mode to keep you occupied for days;
any harder and you’ll be playing for months!

As I said before, the AI is very good, not just for the
enemy, but for your allies as well. If you’re going to be
playing COD 2, try and remember that you’re a soldier in
WW II, and part of a squad, so going off solo to scalp as
many German kills as possible will see you stuck at one
level forever. You have your orders, and you have to ful-
fil them before you advance!

Overall, playing this game changed my opinion
about war shooters, thanks to its realistic feel, great
sound and good AI—8 on 10 from this reviewer! 

robert_smith@thinkdigit.com

Then it’s attacking another beach—
beautiful scenery again

I blow up a few tanks and the Allies
beat the Axis to win WW II—yippie!

The US tank-busters come to my
rescue very often in the game

Some great scenery when I wandered
off, but it didn’t get me to the next level

You find out what’s happening by
reading your diary before a mission

You aso blow up tanks—under heavy
German fire, of course

The British campaign starts off in the
desert, at night—beautiful setting

You invade ‘Jerry’ bunkers to find some
secret documents

My ‘mateys’, seen here, help me
through a series of sticky situations

I get to shoot German fighters out of
the sky—fun, but too short-lived

Publisher: Activision
Minimum System Configuration: Pentium IV 1.4 GHz or AMD
Athlon 1700+, 256 MB RAM, 64 MB DirectX 9.0c compatible card
Price: Rs 1,299
Distributed in India by World Wide CD ROMs
Tel: 022 - 56973894
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PC World Magazine, December 2005

What’s New For 2006
FROM A MAJOR Windows upgrade to powerful Web
services to high-definition DVD, there’s a lot to look
forward to in the coming year. Here’s a partial list—just
two items—from the link mentioned below. Be sure to
check out the page!

The approaching new year looks to be full of change for the way
you work and play with technology. Among the exciting
developments heralded for 2006: Advanced Web apps and tools
will further blur the line between the desktop and the Internet.
The next generation of DVD will arrive at long last, ushering in
high-definition recording. Wide-screen LCD monitors will
continue to become less expensive and more attractive, while

new technologies will begin to boost
display quality dramatically. And Microsoft
will finally ship its long-awaited Windows
Vista operating system.

But the road to these anticipated
developments won’t be without its share
of jolting bumps and potholes. A
standards battle is raging between next-
generation DVD camps. Vista will require
a pretty beefed-up system to run properly.
And most of the new monitor models will

be priced (at least initially) beyond the means of all but the most
well-heeled users. Treat this article as your one-stop guide to
some of the hottest new technologies, so you can decide whether
they’ll be right for your tech needs in 2006.

Vista View: Microsoft’s next major operating system looks a
lot different from the Windows you’re used to seeing. But the
parts of it you can’t see might be even more important. It has
been just over ten years since Microsoft launched Windows 95 to
great fanfare and hype (and the Rolling Stones’ song “Start Me
Up”). Now, as Microsoft prepares its next major operating system
launch, scheduled roughly for the end of 2006, an appropriate
theme song might be “Security” by blues siren Etta James. …

Security isn’t the only focal point of Windows Vista. Also
included are additional gaming features, a stronger desktop
search function, a reworking of the graphical user interface,
compatibility with high-definition TV, and other multimedia tie-
ins. What’s more, Vista is the first mainstream operating system
from Microsoft built to handle 64-bit applications. The new OS
should combine with the latest CPUs to improve gaming, system
performance, and security.

The Web’s New Generation: Soon you’ll enjoy amazing,
lightweight Web sites that respond like desktop apps.

For most people, “going online” involves launching a browser
and surfing to different Web sites. But recent advances in how
Internet data interacts with the desktop have already begun to
change our idea of “going online” radically, and the
metamorphosis will continue in 2006.

As with any revolutionary technology, the advance has
garnered a slew of names. Some call it Web 2.0. Others call it
“Open API,” alluding to the sharing of key programming code
known as the application program interface. And many are
calling it Ajax (for Asynchronous JavaScript and XML), after the
coding technology that is changing the way browsers interact
with Web data. But regardless of the name used, 2006 will see
an outpouring of new Web applications that take advantage of it.

For the complete column, visit

www.pcworld.com/reviews/article/0,aid,122928,pg,4,00.asp

CNET Reviews, December 12, 2005

The Gift Of A Domain
MATT LAKE FINDS the perfect gift for a friend in the form of a
nice, juicy presence on the Web…    

When that huge box of chocolates arrived by courier, I knew I was in
trouble. The large gold box told me right away it was Godiva. And
the sender’s address on the mailing label told me it was a gift from
somebody I’d forgotten…  

Just as the suitable reciprocal gift anxiety began setting in, an
answer came to me: How about a domain? A nice, juicy presence on
the Web for showcasing close-up photography of chocolates, cocoa-

related prose, and
poetry—or anything else
she felt like. And so I
was off to the virtual
market to make the
purchase.

A day earlier, I read
an opt-in e-mail
newsletter from Dotster,
one of the stable of
registrars I rely on to

hold my collection of domains. The newsletter suggested giving a
domain for the holidays, which I considered a dumb idea designed
to squeeze one more domain registration from a desperate gift-
giver. But that was before the chocolate. Now, I realized it was a
brilliant idea designed to squeeze one more domain registration
from a desperate gift-giver. 

But what could I buy? The obvious back-slapping saucy joke
domain, .xxx had already been deep-sixed from the agenda at a
recent ICANN meeting. A nice .eu domain, also recently in the news,
had a sophisticated, Continental sound to it, but not exactly a good
match for this particular friend.

It would have to be a good old-fashioned dot-com domain. So I
turned to the usual suspects. The company that had started me
down this road, Dotster, had just announced a seasonal price drop
of .com, .net, .org, .info, .us, and .biz domains from $15 to $6.99,
good until the end of December. That’s enough to bring out the
bargain hunter in anybody.

Seven bucks in exchange for a box of Godiva seemed like a deal
good enough to eat. But by the time I priced up the bargain hosting
that plan Dotster offers (a good deal with free scripts for blogs,
galleries and forums, 500MB of storage and 25GB transfer), I was
way over the budget at $71.40 for the year.

So I hopped over to one of the mainstays of all-in-one hosting:
DirectNIC that offered a $15 package with registration, ad-
supported hosting, and e-mail forwarding. Was this gift worth
giving? It had domain registration, a Web site and e-mail addresses.
Still, I didn’t have the time or the inspiration to slap a Web site or
page on the site. 

Then I remembered an opt-in mailing that GoDaddy had sent
out last week. Recently, GoDaddy added a little sweetener to its
ridiculously cheap domain registration package. For nine bucks, you
get a domain, a solid POP and Web e-mailbox with a capacity of
25MB. The real kicker was the five-page starter Web site that came
with its standard domain registrations. ... 

Next followed twenty minutes on PayPal and the deed was
done. I set up everything in my friend’s name, except for keeping
the primary e-mail address as my own to prevent a stray message
from the company from spoiling her surprise. 

For the complete column, visit

http://reviews.cnet.com/4520-6028_7-6401346.html

MediaWise



CNN Money, December 19, 2005

Why Google Will Falter In 2006
GOOGLE-BASHING IS IN. So are predictions for 2006. Here’s a
piece that says we won’t think of Google as an “invincible
behemoth.” There are other tech predictions for the new year.
Don’t miss the full article—there are several hyperlinks you
might want to explore.

Google will stumble in 2006.
I knew that would get your attention. Anything and everything

Google is at the height of fashion right now. Every move that the
company makes—like the advertising deal an obsessed press says it
will announce with Time Warner’s (Research) AOL unit tomorrow—
gets a lot of attention in the press.

But what goes up must come down—especially in technology,
the most volatile industry the world has ever seen. Yes, I love
Google, but my first prediction is that a year from now we won’t
think that the search company is the invincible behemoth that we
do now.

One reason for this a new concept known as “community-
powered search.” Yahoo is forging an early lead over Google in this

fast-evolving technology with its
acquisition last week of del.icio.us for
a rumoured $35 million (the actual
amount was undisclosed). Del.icio.us
operates on principles similar to the
popular MySpace. …

Soon we will see a new form of
results, like “What Others Liked,” on
all search engines. It’s how Amazon
tells its customers what others have
bought, except that these search
results involve information. In many
cases, community-powered searches
will let members find what they’re

looking for more quickly than they would on a purely computerized
type of web search, which Google does so superbly. Yahoo was
already introducing community-based searches with My Web 2.0. Of
course, Google is surely working on its own alternatives.

My second prediction is that Amazon will re-emerge as one of
the web’s most powerful properties, and provide increased
competition for Google in 2006. Amazon has done a nice job
grabbing more and more commerce dollars, but it has bigger
ambitions, and a savvy tech strategy. …

My third prediction is that telcos will become more powerful
Internet service providers. …

My fourth prediction is that Apple is likely to introduce a cell
phone next year. …

Here are the rest of my tech predictions for 2006:
TV viewing on cell phones will become routine.
AMD keeps kicking Intel’s butt. AMD CEO Hector Ruiz told me

this week that the company will announce its next big fabrication
plant by next summer, earlier than most had expected. Another
giant state-of-the art factory (it only has one now) could help AMD
better compete with Intel.

Microsoft’s big software launches next year-the Vista OS and
the next version of Office—won’t generate much excitement. 

Cisco may be the big-company investment of the year. This
company’s stock has flat-lined for 18 months, but every single trend
that matters involves more bits flowing through more Internet-
protocol pipes. As video online—the most data-intensive web
application of all—becomes more pervasive, bit traffic will grow.

For the complete column, visit
http://money.cnn.com/2005/12/19/technology/google_fortune/

Eric Goldman’s Blog, December 5, 2005

Wikipedia Will Fail Within
Five Years
WIKIPEDIA IS A hot topic of discussion right now, as
we’ve indicated in our story in the Enter section of this issue.
Here’s Eric Goldman’s take on the debate. (Goldman’s
research focuses on Internet law, technology and marketing
practices. Recent articles of his
have addressed warez trading,
spam, search engine keywords and
virtual worlds.)

This isn’t just one article—the
page mentions a wager Goldman
had with one Mike Godwin, and
includes Godwin’s response. There
are also pertinent comments by
readers of Goldman’s blog. Join the
discussion!

Over the weekend I had dinner with Mike Godwin, one of the most
significant influencers of the development of Cyberlaw and a
longtime friend. Mike and I were discussing Wikipedia, the
community-edited and -maintained encyclopedia. I like Wikipedia a
lot and use it pretty frequently. However, as recent events have
indicated, Wikipedia is far from perfect. 

In particular, I remarked to Mike that Wikipedia inevitably will
be overtaken by the gamers and the marketers to the point where
it will lose all credibility. There are so many examples of
community-driven communication tools that ultimately were taken
over—USENET and the Open Directory Project are two that come
top-of mind—that I didn’t imagine that my statement would be
controversial or debatable. Instead, I was surprised when Mike
disagreed with my assertion. Mike’s view is that Wikipedia has
shown remarkable resilience to attacks to date, and this is evidence
that the system is more stable than I think it is.

Here’s my thinking. As Wikipedia grows in traffic, outlinks from
Wikipedia become more valuable—because of direct referrals and,
perhaps more importantly, the PageRank that will flow from the
link. Therefore, marketers will inevitably try to stuff links into
Wikipedia. Because there are no barriers to editing Wikipedia, this
is trivially easy for marketers to do. Eventually, marketers will build
scripts to edit Wikipedia pages to insert links and conduct
automated attacks on Wikipedia.

So long as the marketers’ scripted/repeated activity is trivial in
quantity, the self-policing community of Wikipedia will patiently
delete those attacks—just like we delete spam from our in-boxes
today. But over time, as the attacks become more determined and
more automated, the Wikipedia community will become less
enthusiastic about undoing the marketers’ changes. At this point,
one of two things will happen:

Wikipedia will have to change its open access nature.
Instead, Wikipedia will have to lock down lots of pages from being
edited at all. Or Wikipedia will have to install some reputational
management system to limit who has the right to post or edit
content.

Alternatively, Wikipedia community members progressively
will do less spam clean-up. This will lead to a gradual but
ultimately irreversible downward spiral as more pages are taken
over by marketers, decreasing the database’s credibility. ... 

Mike and I made a (wagerless) bet that on December 2, 2010,
we will see where Wikipedia stands and decide the winner. If
you have your own prediction on the fate of Wikipedia, please leave
a comment.

To join the discussion, go to
http://blog.ericgoldman.org/archives/2005/12/wikipedia_will.htm
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FirstEscape

Imagine if your PC could
analyse a movie and tell
you it was great, and a

must-watch. Or how about a
book? Yes, software
developers sure do work on
weird things. In this case,
the software isn’t really
meant for you, but rather,
movie producers and 
book publishers. 

With box offices
raking in less than
before, this software
could be a godsend for
big-budget producers
and directors. 

Professor Ramesh
Sharda of Oklahoma State
University, the developer of
the software, told Reuters,
“We are trying to forecast
the success of a movie
based on things that are
decided before a movie has
been made.”

So basically, the idea is
to input some details of the
movie, such as its rating by
censors, the other films

releasing at the same time,
strength of the cast, genre,
special effects, whether it is
a sequel, and the number of
theatres it plans to open in.
The software then computes
the success or failure rate.

The rating ranges from a
“flop,” for a movie that will

gross less than $1 million,
to a “blockbuster,” for
movies that should earn in
excess of $200 million.

Sharda uses a neural
network to analyse the
possible outcomes of the
input data. And the results
aren’t very far off the mark!
Since the inception of the

idea, Sharda has
analysed 800 films
that released, and his
results were spot on—
37 times out of a 100.
The remainder of the
results were just one
category higher or

lower in terms of
expected grosses at the

box office. 
However, the point

to ponder is whether
film makers really need
to start looking at
software to decide

whether to make a film
or not! If this trend
catches on, we’ll never

see any movies that break

the mould, or never see any
newcomers as actors! Can
we really afford to leave the
creativity to a few PCs?

Very soon, India could
start seeing movies that
only star known names, and
newcomers will be left out.
Perhaps the majority would
love that, but what about
encouraging new talent,
taking those risks, and
making movies that are
good, rather than movies
that will sell?

If that’s not enough,
www.lulu.com, a publishing
Web site, claims to have
developed a way for
software to analyse the New
York Times bestseller list over
the last 50 years and then
decide whether an
upcoming book has a 
good title!

Drop us a line and voice
your opinions—tell us
whether you feel it’s a good
idea to let such software
decide the movies we see or
the books we read.

SMILING SOFTWARE

What Was
Mona Lisa
Smiling
About?

Scientists at the
University of
Amsterdam in The

Netherlands and the
University of Illinois at
Urbana-Champaign claim to
have developed an emotion
recognition software that

Think you have the most beautiful, most
innovative desktop around? E-mail us

with subject ‘My Desktop’ and your postal
address to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most eye-catching of
them each month.

The winner of this month is Aditya Bharadwaj 
Aurangabad - 431003, Maharashtra

My Desktop

P2P-ing Pilot Predicament
Security codes to restricted areas for 16 Japanese
airports were leaked on to the Internet because a 29-
year-old Boeing 767 JAL co-pilot’s home computer had
the P2P software Winny installed! The co-pilot’s
computer had been infected by a virus.

Sex For An Xbox 360? 
Two Boston women allegedly offered sex in exchange
for an Xbox 360 in an ad on www.craigslist.org. The
posting has since been removed. But, all people
seemed to want to know was, “There are women who
want an Xbox?”

Next month’s winner will receive a
copy of  
Security in Computing
By Charles P. Pfleeger and 
Shari Lawrence Pfleeger
Published by JPearson
Education, Delhi

THE PC CRITICS

My PC Loves This Movie!

Illustration: Harsho Mohan Chattoraj



131DIGIT JANUARY 2006

has analysed the Mona Lisa
and found that she was “83
percent happy, 9 percent
disgusted, 6 percent fearful,
and 2 percent angry.”

This result was obtained
by Dr Nicu Sebe, a professor
at the University of
Amsterdam. Sebe used an
emotion recognition
software that was developed
under professor Thomas
Huang of the Image
Formation and Processing
Faculty at the University of
Illonois at Urbana-
Champaign.

The software was
originally developed to
recognise expressions of a

human user
interacting with
a computer—
better known as
Human

Computer
Interaction (HCI).

Sebe used a
computer to
create a 3D

digital image of
the Mona Lisa,
and then
compared it to
his database of
pictures of
women in

different
emotional states.

The software looks at
the eyes and lips, the
curvature of the smile, and
many other aspects of an
image to arrive at a
percentage for six
emotions—anger, disgust,
fear, happiness, sadness 
and surprise.

According to the
computer’s findings, Mona
Lisa has no surprise or
sadness registered on her
face—which seems logical;
since she was posing for a
portrait, surprise is not an
option, and since she was
smiling, we could rule out
sadness as well!

What’s more
interesting than using the

software to figure what
people were thinking in
old portraits is to use it on
digital images of today. 

Since men are often
confused about what
women are “really”
thinking, and vice versa,
reading someone’s mind
could be as easy as
snapping away with your
digital camera.

There’s also talk of using
the software to run real-
time scans at airports and
other high security areas to
analyse what people are
really thinking. 

This way, even if you
were nervous or scared, but
smiling (as terrorists might
do at check-in), you could
fool the human staff, but
the computer wouldn’t let
you off the hook that easily!

Of course, this
technology can be
extended to read other
signs such as body
language. So the next time
you walk into a corporate
office for an interview,
look around for cameras—
they could be informing
your would-be employers
about what you’re thinking
and even your current
emotional state. All this
without meeting you face
to face!

This month’s winner is 
Chayan Vinayak Goswami
Bikaner
Rajasthan

Nolan Bushnell is widely
considered the father of
electronic gaming. Bushnell
had an eventful childhood—
he nearly burnt down his
family’s garage with a

homemade
liquid-fuel
rocket
mounted on a
roller skate! 
At age 15,
when his
father died,
he took over

their concrete business.
Bushnell attended the

University of Utah where he
studied computer graphics,
managed an amusement
park and also played
tournament chess on the
side. Bushnell believed that
computer games were a
means of education as they
fostered curiosity and
creativity in individuals. He
went on to invent his first
computerised video game,
Computer Space, in 1970. 

In 1972, Bushnell along
with his business partner Ted
Dabney founded Atari
Corporation. The same year,
Bushnell invented Pong, a
video version of ping-pong.
Pong was the first
commercially successful
video game and is believed to
have started the video game
era. In 1975, Bushnell made
an agreement with Sears to
sell a home video game
version of Pong. 

In 1976, he sold Atari to
Time Warner for $28 million
(Rs 26 crore back then). In
1977, he also started another
company, Chuck E. Cheese
pizza restaurants, where kids
could eat and also play
electronic games.

Bushnell has founded 20
companies till date. He now
envisions Internet-based
games that can
accommodate thousands of
persons per team. He also
lectures in the US,
motivating others with his
views on entrepreneurship
and innovation.

People Who
Changed

Computing

He wins 
Professional
Java
Programming 
by Brett Spell  
Published by
Shroff Publishers and
Distributors Pvt Ltd., Bandra
(W), Mumbai

CYBER DHABA

WIN!
Send in your entry and you could win an exciting gift just by sharing an amusing picture with a tech
angle to it. The picture should be shot by you, and should not have been published anywhere earlier. 
E-mail your picture with the subject ‘DigiPick’ and your postal address oonn  oorr  bbeeffoorree  1155tthh  ooff  tthhiiss  mmoonntthh
to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Nolan Bushnell 

Gaming Pioneer



PARENT COMPANIES?

My Dad’s
Surname Is
.com!

AWeb hosting company
by the name of
Weblinkhosting.com

has applied for the right to
legally adopt a child. This
means that the child will be
parented by the company,
and not by an individual.

Weblinkhosting wants
to adopt a child and raise it
in its data centre, where the
child will be cared for by
various employees and
provided with food, clothes
and shelter. 

Since every employee
will be like a parent, the
child will receive more love
than in any normal house! 

The company hopes that
the child will grow in a
conducive environment and
learn all there is to know
about Web hosting and
become a Linux guru.

Though viewed as a
publicity stunt by the
media, the fact is that, thus
far, there have been no
impediments in the
application procedure,
which has taken almost 
six months.

Though Weblinkhosting
hasn’t decided on the
nationality or the age of the
child yet, it plans to do so
soon. As for the sex of the
child, that will be decided

by the flip of a coin!
We hope this

doesn’t become a
trend, because of all
the social
repercussions:
imagine companies
building recruits by
hiring toddlers,
training them and
then absorbing
them into the
workforce! 

Though this sounds like
a good idea, it might not be
really fair to a child, who
deserves the freedom of
choice, once of age. 

Children adopted by
companies will differ from
us, simply because we have
the freedom of choice when
it comes to deciding our
own careers. 

Whereas, the child who
may be adopted by
Weblinkhosting might not
have that choice because of
the “brainwashing” he or
she will be subjected to
while growing up. 

What if the child really
wanted to become a
hairdresser or a doctor? Is it
fair to manipulate a child
in such a way?

STEALTHTEXT

Self
Destructing
SMSes?

With all the leaks
and scandals
regarding mobile

content that we have seen
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Digital Video
You’ve suddenly found yourself
in a café in the Art District and
have no clue how you got
there—it happens to the best of
us. You are bored for company
and are wondering how to
break into the group of digital
video (DV) geeks in the corner. 

“CMOS or CCD?” one of
them asks after you exchange
names. CCDs are Charge
Coupled Devices, used for
image sensing. The best digital
cameras use 3-CCD
arrangements to get top-quality
video, and cost you half a
kingdom. And CMOS
(Complimentary Metal Oxide
Semiconductor) is a cheaper
but slightly lower-quality
approach to image sensing, but
it’s getting better. 

Just say, “Oh CCD, no doubt.
No compromises on quality”,
this will have them swooning at
your discerning eye and
bottomless wallet (Ahem!).

Regular video is interlaced
—the image is divided into two
sets of lines that are displayed
alternately to fool the human
eye into believing it’s seeing a
high-quality image. Progressive
Scanned video displays all these
lines in sequence, storing five
times as much information in
the frame. The result is High
Definition Video (HDV), where
faster movements appear much
crisper than in interlaced video. 

Video usually runs at 24
frames per second (fps). Saying
“I’m shooting my next with a
24P camera” means that your
video will run at 24 fps and is
progressively scanned, and
roughly translates to “I’m a
George Lucas in the making!’” 

DV25 is the standard
compression format for DV; an
hour of DV25 video takes up
about 13 GB of space and is the
best possible quality outside of
raw, uncompressed video.
MPEG-2 is another compression
format that started out as a
format for distribution, but is
now used in recording as well. 

“Real Men don’t compress,”
you scoff, leaving them burbling
something about more video on
the same tape while you beckon
a cab to take you home.

Passion and fun, spunk and luck,
laughter and sorrow, excitement and

disappointment—our team’s melting pot
of emotions has this and more! 

The month started in the worst way
possible: in the first week itself we were
shocked to find out that a dear ex-
colleague of ours, Marshall Mascharenas,
formerly the Art Director of Digit,
succumbed to cancer. He was a dedicated
and talented soul, and our entire team’s
hearts and wishes go out to his wife and
daughter. He will be sorely missed!

There were also changes in the team—
Mithun left to pursue his calling in creative
copywriting, while, our self-confessed book-
addict Renuka is off to study literature. Of
the new joinees, we have Jyotsna on the
copy desk. Articulate and a pro at English,
Jyotsna surely must have been the winner
of the spelling bee! Another newcomer,
tech-whiz Nimish has fit in so perfectly
with our team, that we all insisted he
should bring along a clone of his—the more
the merrier! And yes, Prakash from
Bangalore has joined us on the
CD/DVD front. 

As for the goings-
on in the team, the

test centre seems to have come to where
we sit: there’s non-stop gaming here these
days, mostly courtesy Raaabo. A true-blue
gamer, anytime you hear jets whizzing
past or firearms going off non-stop
accompanied by loud screams, it’s only
Raaabo at his FPS on a cataclysmic
mission with a mad glint in his eyes. 

And talking about gaming, the layout
and design artists at Digit cannot help but
pay daily obeisance to Zuma Devi—the
stone frog idol in the insanely addictive
Zuma Deluxe game. 

And yes, it’s the time for New Year
resolutions. A few guys here—Ram and
Vijay included—are trying to kick the
nicotine addiction (as they do every year).
Shivlal says he will not shout for “high-
resolution images” anymore. We in turn
are trying not to call Brother Zivalal
“Zony Ericsson”. Needless to say, these
resolutions will barely last for a day! 

And editor Deepak plans to increase
his tech quotient. Honestly, we all do.
For technology can be overwhelming for

the best of us. And as we continue
to navigate through its

waters—2006 will be
the year!

Happy New Year! 
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thus far, both
internationally and here in
India as well, it’s a relief to
hear that such scandals
might soon not occur. Not
that people will stop being
amorous or stupid, but
simply by providing the
sender of information with
the controls!

Staellium UK has
developed StealthText, an
SMS delivery system that
allows the sender to send
messages that will be
deleted from the receiver’s
phone 40 seconds after it
has been read. 

The catch here is that
both the sender and the
receiver need to have WAP
access and WAP-enabled
phones. However, only the
sender of such messages
needs to download a
StealthText applet.

When a StealthText
SMS is sent, the receiver
gets a notification type of
message that displays the
sender’s name and a link
to the actual message. 

Now, if the receiver goes
to that link, via WAP, the
message is flagged as read
and it simply cannot be

accessed from the server 40
seconds later. For people who
are concerned about the
legal and security aspects of
this sort of system, the good
news is that the e-paper trail
will still exist, and can be
made available to the
authorities on demand. 

Although the SMS is no
longer viewable by the
receiver after 40 seconds, it
is archived on the server.

Staellium claims that
this service will be a boon
for celebrities who are
afraid of being blackmailed
later, or businessmen who
urgently need to send
confidential information 
to colleagues.

The company also plans
to introduce the same
technology for e-mail,
voice, picture and MMS
messages. Perhaps now we
will be able to go for more
than a few months without
a new MMS scandal taking
place—provided we get to
see this technology, and
people consciously use it! 

Compiled by Jyotsna Rege,
Nimish Chandiramani, Ram

Mohan Rao, Renuka Rane and
Robert-Sovereign Smith

Ever wondered during your net wanderings as to where it all
stopped? Pixelscapes.com/spatulacity/button.htm could, very

well, be the answer. The site features this humungous red-
coloured button labelled ‘Push’. And trust us, you will not need
anymore. For you will not receive more. 

At first, we tried to “push” the Really Big Button (RBB) and
then tried to resist doing so. This is one button that actually does
not take you anywhere. What the button does, we are destined to
never know. Try clicking, it’s completely futile. We can’t blame the
makers, for they’ve put up this warning: “The Really Big Button

That Doesn’t Do Anything”.  
The Web site is fairly easy to

navigate (it has to be! It’s just one
page after all). What really baked
our noodle was how does a Web
site, created in 1994, still have
people flocking to it and actually
paying homage? 

In fact, several visitors have
attempted to immortalise the RBB
by hailing it as the new age peace
mantra or written off about their

frustrated attempts. Read the postings and you’ll know what we
are talking about. And you can check the RBB guestbook and sign
it if you’d like. Who knows, even you might be converted! Still,
reviews we can comprehend. Poetry, we cannot. 

“On a page far away
Stood the Really Big Button
An emblem of suffering and shame.”
And all this for naught. 

whatweretheythinking.com

Leon Kilat-The Cybercafe Experiments 
http://max.limpag.com/

Lee tries out blogging
(Via del.icio.us) The man who wove the World Wide
Web, as Time puts it in a 1999 article, has started
blogging to try publishing content using blog tools. Tim
Berners-Lee said he never felt the “urge to blog with
blogging tools” because he has largely been updating
websites using Amaya and Nvu (an excellent open
source WYSIWYG editor).

Lee said in his blog: “we have blogs and wikis, and
the fact that they are so popular makes me feel I
wasn’t crazy to think people needed a creative space.”

Ramanand 
http://quatrainman.blogspot.com/

The JaDe Project - 7, Category: Awards
There are awards and there are self-thumping awards,
but none like the Star Parivaar Awards. I mean, what
the heck? Take a look at last year’s award winners
here, but more importantly, at the categories: A Best
collection of Pati, Patni, Naya Sadasya, Khalnayak,
Devar/ani, Jethani, Yogya Bahu, Saas/Sasur. All these
are merrily laughable, but I draw the line at Best Saut.

These awards are supposed to be for the entire
Star Plus channels, but by having Saut-ern categories,
aren’t they constraining the competition? A giant K-ego
massage at best. We haven’t even hit “Best JoDi”—I
would have voted for Amitabh and Computer-ji.

Dave Roberts 
http://www.findinglisp.com/blog/

More Interesting Keyboards 
The other day I posted about Das Keyboard being an
interesting twist on keyboards, being unlabeled. At
Interop this week, I happened to run into a company
called Zeomi, who makes a keyboard with an added tab
key. Basically, they put a duplicate tab key under the
arrow keys, over by the keypad. They say that if you do
lots of data entry into either spreadsheets or forms
where tab is used to move among fields, this can really
speed things up, presumably because you can be
flipping through papers with your left hand while your
right hand does everything on the numeric keypad. I
did find it humorous that they’re trying to patent this.

Jon Choo 
http://jonchoo.blogspot.com/

Christmas Shopping
I always hate it when shops lie—advertise something on
offer to court you in, then trying to persuade you to
get something else because there are none in stock!
HMV has been doing it lately and yesterday I forced
myself through Oxford Street (I hate that part of
Central London) visiting two of their larger stores—and
none had the package I wanted! 

Eventually I had to get it at GAME. The situation is
similar to UK’s XBox 360 pre-order debacle, create a
hype but be unable to fulfil it. 

Berners-Lee, the man
behind the Web has
start to blog. Poke
fun at the Star
Parivaar awards.
Read about some
interesting
keyboards, and how
Christmas shopping is
an unavoidable part
of this jolly season. 
Blogwatch as varied
as it can be

www.pixelscapes.com/spatulacity/
button.htm

The Really Big Button that does nothing



Digit Helped Me Buy
When I bought my first PC two years
ago, I had no one to guide me. I was
confused between branded and
assembled PCs. I also didn’t know what
configuration to buy. I couldn’t pinpoint
what my needs were, I didn’t know
about support by the dealer and
manufacturers, driver availability, and
last but not least, the warranty.

And then arrived the December 2005
issue with your Buyers Guide. It provided
me with all the useful information,
especially important for those who will
buy PCs or hardware for the first time.
Such articles train us to tackle dealers
and makes us aware of the market
scenario. Your effort is indeed
praiseworthy.

Parag Kalra
Nagpur

Dear Parag,
Thanks so much for your appreciation. It has
always been our goal to give our readers the
complete picture and scale up their knowledge
on not just the latest technology but also
contemporary market trends.

—Associate Editor

Our Youngest-Ever Reader?
In last month’s issue, you said
Amritanshu was possibly the youngest
reader of Digit. I’d like to tell you that
I’ve been reading Digit since I was in the
5th standard! And for the last five years,
there isn’t an issue that has bored me. I
anxiously wait for your every copy—but
I receive my copy late!

Anay Somvanshi
via e-mail 

Dear Anay,
I am indeed surprised to know that you picked
your first copy of Digit at that young age—
you’re a prime example of India’s great IT
potential! It is kids like you who build their IT
quotient early enough to gear up for bigger
challenges later.

— Associate Editor

All Thanks To Digit
I thank the Digit team for helping me
win the Microsoft Innovative Teacher
Leadership Award (ITLA) 2005. I am a
government teacher, and with your help
I’ve remained updated and
experimented with my computer, which
led me to win the MS ITLA 2005 award
and a chance to visit Seoul (South Korea).
10 teachers from all over India were
selected to attend the Asia Pacific

Regional Innovative Teachers Summit in
Seoul. They all use IT in their profession
for better teaching and learning Process.
I have created a Web forum for
teachers—http://itla2005.bravehost.com.

Gopal Veernala
Andhra Pradesh

Excellent DVD Offer!
Thank you very much for the December
special issue. Your additional DVDs offer
for Rs 50 is fantastic. I am sure even if
you had charged more, lots of people
would have taken you up on your offer. I
am not into computers, but I use them
in my everyday work and I subscribe
to Digit to keep myself updated on
products and happenings in the
industry. It provides me with all the
necessary details while not being overly
technical, so as a layman I can
understand the content.

Kiran Bhat
via e-mail 

Dear Kiran,
Thanks for acknowledging our efforts in
reaching out the Terminator 2 + Discovery
documentary DVD and Microsoft game CD at a
nominal price to our subscribers. If you
calculate the original market price of these
two, it turns out to be more than 15 times of
what we’ve asked for. And as our CEO stated in
his letter to all subscribers, the Rs 50 was only
sought to cover the additional cost of
procurement and shipping.

—Associate Editor

Digitised At 11!
I’ve been a regular reader of Digit since
I was 11. I eagerly wait for each
month’s copy. Your e-books, movie
trailers and wallpapers are my
favourite. I have built up my own
library using your material.

The December issue was great.
Collecting so much information in just
one month should be very difficult—hats
off to your team!

I am also looking for the full version
of Doom 3 and Virtual DJ. Please see if you
can provide it. And tell me how I can get
to know the results of the Digit Contest
Carnival.

Tanul Saxena
Kota

Dear Tanul,
This month we seem to be getting more and
more letters from our young readers. It seems
last month’s letter has inspired a lot of you to
write back to us. As always, it’s a pleasure to
hear from all of you!
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Digit Forum

To post your comments on the Digit Forum, 
visit http://www.thinkdigit.com/forum

Finally GOOGLE got a competitor.....!!!

gagan007
Analogue Novice
Hi, 

chk out this link 
http://beta.previewseek.com/ 

Superb Search Engine!Perhaps going
forward we will be using this more than
Google ?? 

Also preview seek is more intelligent than
google! You type 'Mercury' in 
google and it will also show you results of
Planet mercury even if you are 
looking for info on the element called
Mercury. Where as in PreviewSeek 
first you get different categories of
mercury (Planet, Element and what 
not!) and from there you can proceed only
into that category. Even a 
search for DSC 80, a sony digi cam gave
astonishing result sets with also 
categories on left side to preview its
reviews or to buy it. 

Good luck PreviewSeek, check it out at
beta.previewseek.com . Note that it 
is still in beta! 

No source, just got a mail.

****************************************

Iinfi
Digitized!
Location: Navi Mumbai

not a bad one. gud luck to PreviewSeek
and thanks gagan for the info.

****************************************

Febians
Analogue Novice
Location: Bombalore:)

"Categoric" / "Clustered" search
engines are not new.... 

www.lycos.com 
www.Vivismo.com 
www.ask.com 
www.teoma.com 

will all give u the categories for
"Mercury"

****************************************

~Phenom~
Warmed-Up Nerd
Location: CYBERYARD
wow, 
its great. 
I m really impressed by the search results.

****************************************
Vrnoormd
Analogue Novice
Location: Vellore
Good one, Little Slow than Google
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Regarding full versions of games, well, we
cannot pass on illegal copies of games! The
results of the Digit Contest Carnival are regularly
updated at zdnetindia.com/dcnew.

—Associate Editor

Digit Patron—Double The Value!
First up, you deserve my thanks - in fact,
a thousand thanks! I am a computer
teacher, and I'm a regular bus-stand
reader of Digit. When I first saw a
mention of “Digit Patron” in the
magazine, I thought it was only for
subscribers—but, of course, I was
mistaken. I got my gift a few days ago—
the “Photoshop 100%” edition. It was
amazing! Digit Patron is an amazing and
useful  program—it doubles Digit’s value!

I have a few suggestions for
forthcoming issues:

It is time to introduce another issue
of “Photoshop 100%”. We now have
Photoshop 9, with lots of new features,
meaning new possibilities for graphics.

I suggest you include some free
demo filters in the CD/DVD, and also
some useful Photoshop  templates and
other resources.

Everyone likes Mini CDs—they are
easy to handle. I know the capacity is
low, but I'd suggest you try a Mini CD at
least in the Anniversary Edition. You can
Include PDF files on that CD. 

Since you include a lot of PDF files,
I’d request you to include some general-
knowledge related papers. It will be of
great help to children and students.

Manoj A P
Malappuram

Dear Manoj,
Thanks for your kind words about the Digit

Patron programme. And keep the suggestions
coming—we may or may not be able to
implement all the suggestions we receive from
our readers, but we’re always listening!

— Associate Editor

No Extreme Pack?!
I received the December issue, but not
the full “extreme” pack. You’ve sent us
subscribers a letter explaining why, but
I don’t agree with you.

Your magazine has ads from so
many companies—including
international gaints such as Samsung,
Seiko, HP, and more—and I’m sure you
get a lot of money from them. It should
be very easy for you to pass on the
benefits at least to regular subscribers
like me.

I was shocked to find that even the

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages.
Letters may be edited for clarity. YYoouu  mmuusstt  iinncclluuddee
yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the Help Desk at 
022-27629191/9200, Fax 022-27629224, or 
send an e-mail to help@jasubhai.com

calendar wasn’t there—which even
small local firms give away for free!

I request you to kindly consider
my veiwpoint again, and see to it that
subscribers are sent the items free,
as should have been done. However,
if that is not possible, the least you
can do is send the calendar with the
next issue.

M Yasin Ganaie
via e-mail

Why The Rs 50?
We subscribers were waiting for your
special CDs, and received your letter
asking for more money, in the second
half of the month. It is not good
practice or fair business to ask for
money after you have agreed upon
certain conditions.

In your special issue, you have
added a lot of ads and ad-oriented
articles—at the expense of  regular
tech features. You added free CDs to
boost your sales. Also, you want to beat
your competitor, who comes up with
three CDs and three DVDs, on their
ground. Why are you doing this at our
expense? Your competitor delivered
additional CDs at no extra cost. And
you are asking for Rs 50 to meet your
additional expenses.

Anyway, it was very disappointing
to read your letter. I am declining
your offer. I will go to the bookstall
and get a copy.

Vincent Abraham
via e-mail

Dear Yasin and Vincent,
We simply could not afford to send
subscribers the extras that came with the
December issue. Subscribers received all the
regular content, including the special issue
magazine at the reduced price they paid
when they subscribed.

You get the magazine at a significantly
lower cost—especially after the price hike.
We have subscribers like you who subscribed
when it was one magazine and two CDs.
Today, for the same price, despite inflation
and rising costs, we provide them with one
magazine, one DVD, one CD, and a useful
200-page Fast Track book.

In addition, we must stress that we made
no money at all from the extra Rs 50—it only
covered royalties and courier charges.

While we can look at the situation from
your viewpoint, I request you to look at it
from ours.

— Associate Editor

The Gimp Rules!
This is my first letter to you, though
I should have thanked you a long
time ago! I have learnt a lot about
technology, computing, gadgets
and more from Digit, and it’s due
to Digit that I’m interested in
learning more. 

Two months ago, the Fast
track series on essential
Windows tools covered
Photobie, Paintbox, and
Picasa, which was great.
But I was disappointed
to not find the most
powerful open source
image editing software—
The Gimp. This is the only free
software that can pose a challenge to
and compete with Adobe Photoshop.
Its interface is cluttered for
beginners, but once you play around
you’re comfortable. 

Gimp 2.2.8 is very stable. I have
used it for image editing,
colorization, etc. and it has never
disappointed me. The Gimp Web site
has numerous colourful, illustrated
tutorials and user manuals—all you
need is a little time and attention to
master it. Please include a review of
and a tutorial on The Gimp in a
forthcoming issues—because Digit can
bring credibility and interest to the
least-known program! Might I also
request you to include the installer
(along with GTK+) on the CD/DVD?

Photobie is a nice program, but
the icons are sluggish, and there are
no tool tips for many icons. I’d
suggest the author make it open
source so it gets developed in no
time! By doing so, its creator will
soon get famous—the way people
remember Ton Roosendal of Blender
3D (a very feature rich 3D animation
tool), Peter Mattis and Spencer
Kimball of Gimp, Irfan Skiljan of
Irfan View, and many others.

Jagadish Bhargava
Bangalore

Dear Jagadish, 
You must have missed it—we did carry a
tutorial on The Gimp in our Q&A section of
the last issue (December 2005), taking
into consideration the usefulness of
the software. And as for giving out the
installer, well, we can certainly consider
your request.

—Associate Editor

Letter 
of the
Month
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No, this isn’t about a
church full of perverts.
The Dutch Full Gospel

Church that bid on “sex.eu”
wanted to put up a Web site
that would “explain how
wonderful sex is when
practised in the manner God
intended,” according to Chris
Vermeulen of the church.

The church, Volle
Evangelie Gemeente Rehoboth
in Eersel, was seconds too late.
Divine intervention? It offered
several hundred euros for
the domain name. And if it
had won the bid, it could have
meant less people accessing
European smut.

The registration period for
domain names with the new
European Internet extension
“.eu” began on December 7.
“Sex.eu” was, of course, the
most sought-after. There were
only 232 applications for the
name, which is surprising
considering the humongous
number of searches that are
conducted on the word “sex.”
The first bidder was Sweden’s
Yellow Register On Line AB.

So now we’re going to
get just another Swedish
porn site. And no way of
knowing how wonderful sex
is when practised in the
manner God intended.

Church Bids On “Sex.eu”

Technically, he’s a burglar.
But his intentions were
so benign, you’ve got to

love him! A man in Beijing
repeatedly burgled a
neighbour’s house to repair
her computer. The report on
the Web site of China’s official
news agency, Xinhua, said the
man also flicked her MP3
player so he could try and
repair it.

Police caught him walking
out of the neighbour’s house

with a key to her door, a bra,
two photographs and her MP3
player, which he said he was
taking to fix.

It was apparently a
combination of a crush and a
tech-oriented mind. When
hauled to court, the man said
he was too shy to tell the
neighbour about his crush. Of
course, he could have simply
sent over a technician to her
place, but that wouldn’t have
been as romantic, would it?

All For Love

Check out
http://gadgets.
fosfor.se/the-

top-10-weirdest-usb-
drives-ever/ for pics of
the “Top 10 weirdest
USB drives ever.”
We’re tending to get
jaded these days, with
all the news about
weird eBay auctions
and so forth, but these
pics are certain to bring
a smile and a snigger to
your face!

The page ranks the
USB drives in order of
weirdness. Several of them
look like pieces of various
kinds of food, with a USB

connector sticking out.
There’s one shaped like a
sake bottle. What the site
found weirdest was the

Barbie drive—you
yank the doll’s head
off to expose the USB
connector. (Has an
element of sadism to
it, come to think of
it.) But what we
found the most
hilarious was what
we call the Actual
Thumb Drive—it’s
a thumb with the
connector
sticking out!
Check out the

pics!

Now, A Real
“Thumb” Drive!

For any queries regarding the Digit Patron programme, e-mail us at digitpatron@jasubhai.com

More Britney! We might
seem to be overdoing it,
but hey, we’re just

reporting here—and if the
world is overdoing Britney,
we can’t do much about it!

Despite having had a
baby—in fact, because she had
one—Britney Spears is once
again the most-searched-
for item on the
Internet. She didn’t
release an album of
new material in 2005,
but the new mother was
#1 on Yahoo’s annual
list of the most searched
for. She’s topped the list
for three of the
past four years, having
lost out to “American
Idol” in 2004.

If you’re
wondering why
Britney keeps popping
up, don’t ask us—we’re
as clueless as you are.
If you can tell us,
though, do write in!

Britney
Rulez!
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